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Profit Center Accounting (EC-PCA)
Purpose
Profit Center Accounting (EC-PCA) lets you determine profits and losses by profit center using
either period accounting or the cost-of-sales approach. It also lets you analyze fixed capital and
so-called “statistical key figures” (number of employees, square meters, and so on) by profit
center. Consequently, you can calculate all the key figures commonly used in cost accounting
(return on investment, cash flow, sales per employee, and so on).

A profit center is a management-oriented organizational unit used for internal controlling
purposes. Dividing your company up into profit centers allows you to analyze areas of
responsibility and to delegate responsibility to decentralized units, thus treating them as
“companies within the company”.

The essential difference between a profit center and a business area is that profit
centers are used for internal control, while business areas are more geared toward
an external viewpoint.

The profit center differs from a cost center in that cost centers merely represent the
units in which capacity costs arise, whereas the person in charge of the profit center
is responsible for its balance of costs and revenues.

Integration
EC-PCA is a part of the Enterprise Controlling (EC) module.

Features
The main aim of Profit Center Accounting is to determine profit for internal areas of responsibility.
It lets you determine profits and losses using either period accounting or the cost-of-sales
approach.

By assigning balance sheet items (asset portfolio, payables and receivables, material stocks,
work in process) to profit centers, you can analyze your company’s fixed assets by profit center,
thus using them as investment centers. .. This also makes it possible for you to analyze a
number of key figures by profit center, including return on investment, working capital and cash
flow.

EC-PCA lets you set up your profit centers according to product (product lines, divisions),
geographical factors (regions, offices or production sites) or function (production, sales). You
need to make the settings in Basic Functions [Page 20] in order to divide the company into
internal areas of responsibility. You divide your business into profit centers by assigning the profit
centers to the various master data which is relevant for profits (materials, cost centers, orders,
projects, sales orders, assets, cost objects and profitability segments). This lets you set up Profit
Center Accounting in a way that meets your company’s requirements regardless of what sector
of industry your company is in (machinery, chemicals, services, and so on) or what form of
manufacturing you employ (repetitive manufacturing, make-to-order production, continuous flow
production).

Every profit center is assigned to the organizational unit Controlling area. This assignment is
necessary because Profit Center Accounting displays values in G/L accounts. The profit centers
in a controlling area are all contained in a standard hierarchy for that controlling area.
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All profit-relevant business transactions are updated in the profit center hierarchy according to
G/L account at the same time they are processed in the original module of the R/3 System. All
the flows of goods and services within the company are represented as deliveries and transfers
between profit centers. This is true both with actual postings [Page 226] and in planning [Page
165].

You can also transfer the balances and balance changes of certain balance sheet accounts to
profit centers in realtime or periodically.

Goods movements between profit centers can be valuated either at external prices,
group-internal prices or specially defined transfer prices. For more information, see Parallel
Valuation Approaches/Transfer Prices [Page 100] .

The Information System [Page 327] provides a user-friendly tool for evaluating your plan and
actual data. Because results are stored by G/L account, you can reconcile the data with the data
in Financial Accounting at the cost element level. The reports contained in the standard R/3
System represent a simple information system for analyzing areas of responsibility. In addition,
different tools are available which let you create your own reports to further meet the needs of
your company.

To reach the application menu for Profit Center Accounting, choose Accounting →
Enterprise controlling → Profit Center Accounting from the main R/3 menu.

Profit Center Accounting also features the usual tools [Page 361] (Validation, Substitution,
Archiving, ALE).
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The Concept of Profit Center Accounting
Prior to a description of the actual components in Profit Center Accounting, the following sections
are intended to provide some background information. This information is intended to help you
understand how the business concept is implemented in the R/3 system.

The section Role of EC-PCA in the R/3 System [Page 12] provides an explanation of how Profit
Center Accounting (EC-PCA) differs to other related components. This section lays special
emphasis on the role of EC-PCA as an interface between Enterprise Controlling (EC) and
Controlling (CO).

It is followed by a section dealing with the basic Methods of Calculating Profits in EC-PCA [Page
15].

The final section, Data in Profit Center Accounting [Page 17], provides an overview of the
integration of EC-PCA data in the R/3 data flow.



Profit Center Accounting (EC-PCA)  SAP AG

Role of EC-PCA in the R/3 System

12 April 2001

Role of EC-PCA in the R/3 System
Role in Enterprise Controlling (EC)
The module Enterprise Controlling (EC) is a powerful, integrated system which provides efficient,
up-to-date information for controlling your group or company.

EC consists of the applications Executive Information System (EC-EIS), Consolidation
(EC-CS) and Profit Center Accounting (EC-PCA).

EC Enterprise Controlling

Executive Information
System (EIS)

Consolidation

Profit Center
Accounting

Component

Group-wide monitoring
of critical success

factors

Flexible consolidation/
group reporting

Calculation of profits for
„companies within the 

company“

Use

EC-EIS

EC-CS

EC-PCA

Executive Information System (EC-EIS)
The Executive Information System presents up-to-date aggregated data and provides
user-friendly tools for analyzing the critical success factors for your company or entire group. The
data basis can be supplied either internally (from R/3, R/2 or other applications) or from external
sources. EC-EIS is integrated with other information systems in R/3 through the architecture of
the SAP Open Information Warehouse.

Consolidation (EC-CS)
Consolidation (currently in development) gives you a reconciled view of your group’s financial
data and lets you create the reports required by corporate law (by group, company or business
area) as well as reports which reflect your company’s internal management structure (by profit
center or region). This is possible due to powerful consolidation functions built on top of flexible
structures. The raw data can be transferred via interfaces with FI-GL (General Ledger), FI-AA
(Asset Accounting), MM (Materials Management), SD (Sales and Distribution) and EC-PCA. You
can also analyze the results of the consolidation immediately in EC-EIS.

Profit Center Accounting (EC-PCA)
Profit Center Accounting forms an interface between the operative controlling (CO) applications
and the Enterprise Controlling (EC) module. It reflects the actual and plan postings from
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operative controlling and settlement components, with which it is integrated in real-time. It then
summarizes this data according to profit centers, which reflect the internal structure of areas of
responsibility within your company.

EC-PCA primarily serves to calculate internal (plan and actual) results for profit centers according
to the period accounting approach. If the function area is specified for the data in the controlling
components, you can also analyze results using the cost-of-sales approach.

In addition, EC-PCA lets you analyze certain balance sheet items by profit center. This also
makes it possible to control the necessary key figures for an area of responsibility.

If you store values flows in multiple fields using different valuation methods, you have the option
of valuating goods movements with transfer prices in Profit Center Accounting.

Profit Center Accounting is account-based. That means, the values are updated in EC-PCA
according to account. Consequently, you can reconcile the data here with that in Financial
Accounting.

You can modify or supplement both actual and plan data taken from the operative components to
meet your company’s requirements for Profit Center Accounting (assessment, distribution,
revaluation). You can then use this data as a basis for a more strategic analysis using EC-EIS.

Multiple profit center hierarchies (profit-oriented, functional, regional, and so on) make it possible
to analyze data in different ways in multidimensional organizations. Through the elimination of
internal business you can also represent data at higher hierarchical levels.

EC-PCA provides you with a comprehensive and flexible information system for analyzing your
data by period. You can access the original postings from FI, CO, SD, MM, and so on directly to
identify potential weaknesses. Using the report/report interface, you can drill down to the
information systems of other components.

Difference Between EC-PCA and Profitability Analysis (CO-PA)
Profitability Analysis (CO-PA), like Profit Center Accounting, is another form of profitability
accounting. However, it is incorporated in operative cost accounting. That means that the
profitability segments in CO-PA are accounting assignment objects and are thus directly
integrated in the flow of data in cost accounting.

In contrast to EC-PCA, where profits are found for areas of responsibility within the company,
CO-PA lets you analyze the profitability of different segments of your operative business --
defined according to products, customers, orders, or any combinations or groups of these -- or
organizational units, such as company codes or business areas. The aim of CO-PA is to provide
the accounting department and decision-makers in sales, marketing, product management and
corporate planning with information about the market.

You can define the master data and basic structures in CO-PA flexibly to meet your company’s
specific requirements. By choosing just the objects for evaluation (characteristics) and key
figures you require, you can create a company-specific multidimensional structure for analysis.

Unlike EC-PCA, CO-PA lets you use an account-based or a costing-based approach. In the
costing-based approach, you can define your own value fields for analysis. In account-based
CO-PA, the values are represented in accounts.

EC-PCA and CO-PA should not be regarded as alternative components. On the contrary, they
complement one another and jointly provide you with a flexible and comprehensive profitability
accounting tool, allowing you both a market-oriented viewpoint as well as a responsibility- and
person-oriented one.
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For more details about CO-PA and how it differs from EC-PCA, see the R/3 Library, under CO-
PA Profitability Analysis [Ext.].

Difference Between EC-PCA and Special Purpose Ledgers
(FI-SL)
The component Special Purpose Ledgers (FI-SL) is primarily used to perform company-specific
accounting-tasks which cannot be performed using the SAP standard functionality. This
component contains no predefined business functionality. Rather, it makes available a number of
abstract tools, which are already used in various standard applications.

For example, Profit Center Accounting is based to a large extent on the techniques available in
FI-SL. You may wish to use the special purpose ledgers to supplement Profit Center Accounting
if your requirements cannot be entirely met there. However, this would require a significant
amount of programming and additional maintenance.
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Methods of Calculating Profits in EC-PCA
The methods of calculating profits in Profit Center Accounting differ with regard to their

•  time reference (periodic or transaction-oriented)

•  content (period costs or cost of sales)

•  valuation base or form of representation (account-based or costing-based)

(For more information, see the detailed description in the online manual CO-PA Profitability
Analysis [Ext.].)

In Profit Center Accounting, the data is stored and displayed by period and account (see Data in
Profit Center Accounting [Page 17]). This corresponds to the organizational principle in Financial
Accounting. As a result, the uniform report structure in these two components makes it possible
for you to reconcile the data in cost accounting and financial accounting based on cost elements.

You can calculate profits using the period accounting method as well as the cost-of-sales
method.

Comparison of Period Accounting and Cost-of-Sales
Accounting
Whereas in many countries companies prefer to use the period accounting approach, most
English-speaking countries perform profitability accounting using the cost-of-sales method. To
meet the needs of as many customer as possible, Financial Accounting in the SAP R/3 System
supports both of these methods. EC-PCA consequently also supports both methods, in order to
allow you to reconcile the data between the two components.

In period accounting, business results are represented according to cost and revenue
elements. This makes it possible to recognize which factors of production cause the costs which
are incurred. The total costs for the period can then be compared to the total revenues earned
during the same period. These costs include the costs of all the goods and services produced in
the period, regardless of whether or not they were sold, plus the goods and services produced in
previous periods and sold in this period. This sum, together with the capitalized internal activities
and the changes to work in process, yields the total result for the period.
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Cost-of-sales method Period accounting method

Revenues�

Sales deductions

Cost of sales
(incl. Variances for period)

�

�

Revenues

Sales deductions

Changes in stock

Capitalized internal activities

Work in process

Gross result Total activities

Sales and distribution costs�

Administrative costs

Research & Development

�

�

Result Result

Total costs
Material costs
Personnel costs

Other costs

The more market-oriented cost-of-sales approach compares the costs to the corresponding
quantity structure of the revenues. Revenues are only compared to the costs incurred for the
quantity of goods or services sold. When products are sold from stock, it may be that the costs
were incurred during a previous period. In this approach, no distinction is made between different
cost elements. Instead, resource usage is divided according to the functions R & D, production,
sales and administration.

The predefined standard reports in Profit Center Accounting (see Information System [Page 327])
are based on a division according to the period accounting approach. To analyze results using
the cost-of-sales approach, however, it is necessary to find the functional area specified in FI or
CO. Since you can define these functional areas and the rules by which they are used, you need
to define your own reports if you want to use the cost-of-sales approach. You can find information
about how to do this in the section Calculating Profits Using the Cost of Sales Approach [Page
359].
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Data in Profit Center Accounting
Profit Center Accounting (EC-PCA) is a statistical accounting component. This means that it
takes transaction data posted in other components and represents it from a
profit-center-oriented point of view. The postings in EC-PCA are statistical postings, since the
profit center is not itself an account assignment object in Controlling.

The integration of the R/3 system makes it possible to post profit-relevant data to Profit Center
Accounting automatically as soon as the transaction is originally posted. The system either
transfers the relevant items from the original postings or creates additional postings (for example,
see Goods Movements Between Profit Centers [Page 252]).

A special posting program is also available to let you select and post plan data subsequently to
Profit Center Accounting.

If you want to activate Profit Center Accounting in the middle of a year, programs are
available that let you post actual data that already exists to Profit Center Accounting.

It is also possible to create profit center data manually in Profit Center Accounting. This function
also allows you to supply EC-PCA with data from external systems.

You can transfer selected balance sheet items to Profit Center Accounting in realtime of
periodically.

To learn which plan and actual data is transferred to EC-PCA, see Actual Postings [Page 226]
and Profit Center Planning [Page 165].

The transaction data in Profit Center Accounting is stored by account. The data is stored in the
summary record table GLPCT. If you wish, you can also store it in tables GLPCA (actual line
items) and GLPCP (plan line items). You can do this in Customizing.

The summary records contain the data stored according to profit center, account and period. This
data forms the basis for the EC-PCA Information System [Page 327].
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Storing line items can lead to very large data volumes and subsequent performance problems.
However, it makes it possible for you to access the original postings from the other applications
(FI, CO, SD, MM).

Most of the master data in EC-PCA originates from Profit Center Accounting (see Basic
Functions [Page 20]). This data is typically created and maintained separately in Profit Center
Accounting.

The master data includes the master records for the individual profit centers, as well as the
corresponding standard hierarchy and alternative profit center groups.

Your company’s standard profit center hierarchy may somewhat resemble the cost
center hierarchy. Consequently, EC-PCA provides a function which lets you copy the
entire cost center hierarchy to the profit center hierarchy (see Customizing). You can
then change the profit center hierarchy with the normal maintenance transactions to
meet your requirements in EC-PCA.

It is also possible to create account groups which are valid only for Profit Center Accounting.
These account groups help you structure your information system to better meet your
requirements.
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It is possible to copy the cost and revenue element groups used in Cost Center
Accounting (CO-CCA) or the balance sheet account groups used in Financial
Accounting (FI) to Profit Center Accounting, and then change them in EC-PCA to
meet your requirements.

You can also maintain FI accounts and CO cost/revenue elements from the Profit Center
Accounting application menu. However, these are not originally master data for Profit Center
Accounting. On the contrary, the integration of the R/3 System makes it possible for you to
access the FI and CO master data directly.

The assignments of all profit-relevant objects to profit centers play an important role. These
determine how your business is divided up into areas of responsibility. You make these
assignments in the master data of the original objects (materials, cost centers, orders, projects,
sales orders, assets, cost objects, profitability segments).
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Basic Functions
Purpose
Here you create the master data for your profit centers, account groups and statistical key
figures. You also assign the profit centers to the relevant objects in your system. These
assignments make it possible to post actual and plan data automatically to profit centers without
having to make extra postings manually.

Implementation Considerations
You need to need to create your profit center master data and, if desired, your account groups
and statistical key figures, before you can post data to Profit Center Accounting. You also need to
link the profit centers to those objects in your system that receive profit-relevant data.

Integration
This component must be implemented if you want to use account-based Profit Center
Accounting.

Features
Master Data [Page 21]

Revenue and Cost Elements and Account Groups [Page 69]

Statistical Key Figures and Statistical Key Figure Groups [Page 73]

Profit Center Assignments [Page 76]



 SAP AG Profit Center Accounting (EC-PCA)

Master Data

April 2001 21

Master Data
Definition
The master data in Profit Center Accounting is the structural concepts according to which data
can be posted and analyzed in Profit Center Accounting.

Structure
This master data includes any number of profit centers, a standard profit center hierarchy, a
dummy profit center for non-assigned postings, and, if desired, a number of alternative profit
center hierarchies.
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Profit Center
Definition
A profit center is an organizational unit in accounting that reflects a management-oriented
structure of the organization for the purpose of internal control.

You can analyze operating results for profit centers using either the cost-of-sales or the period
accounting approach.

By calculating the fixed capital as well, you can use your profit centers as investment centers.

Use
Profit Center Accounting at the profit center level is based on costs and revenues.  These are
assigned statistically by multiple parallel updating to all logistical activities and other allocations of
relevance for a profit center.

The exchange of goods and services between profit centers can be valuated using the same
valuation approach as in financial accounting or another approach (see Multiple Valuation
Approaches/Transfer Prices [Page 100]).

Structure
The master data of a profit center includes the name of the profit center, the controlling area it is
assigned to, and the profit center’s period of validity, as well as information about the person
responsible for the profit center, the profit center’s assignment to a node of the standard
hierarchy, and data required for communication (address, telephone number and so on).

Every profit center is assigned to the organizational unit Controlling area. This assignment is
necessary because Profit Center Accounting displays values in G/L accounts.

The system transfers all the data to Profit Center Accounting together with the G/L account to
which the data was originally posted. You can only aggregate data of this structure by using the
same

•  chart of accounts

•  fiscal year variant

•  currency

Time-Based Master Data
Like cost centers, profit centers are valid for a specific time period. This has advantages in that:

•  No complications arise when a new fiscal year begins.

•  You can enter future changes to the master data in advance.

Profit centers are time-dependent in two ways:

•  First, you can enter a period during which actual or plan data can be posted to the profit
center.

•  Second, you can define time-based fields when you customize Profit Center Accounting.
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Time-based fields let you change information in the profit center master record, such as the
person responsible for the profit center, at a specific point in time without having to create a new
profit center and without losing any information about the previous person responsible.

Integration
Enterprise Organization
If you are using the enterprise organization, both profit centers and cost centers form part of it.
For further information, see Enterprise Organization [Page 34].

The Standard Hierarchy
In order to ensure that your data in Profit Center Accounting is consistent with that in other areas,
you must assign each profit center to the Standard Hierarchy [Page 64] in your controlling area.

The standard hierarchy is used in the information system, allocations and various planning
functions. You can also assign your profit centers to alternative hierarchical structures which are
completely independent of the standard hierarchy. These structures are called Profit Center
Groups [Page 67].

Copying Cost Centers
If the profit centers in your organization are closely linked to your cost centers, you can simply
copy your cost center master data to create your profit centers. For more information on this
function, see the Implementation Guide (IMG) for Profit Center Accounting, under Master data.
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Creating Profit Centers (Individual Processing)
There are two places where you can create a profit center:

•  In the application menu, under Master Data → Profit Center → Individual Processing →
Create

•  in Customizing for Profit Center Accounting, under Master Data → Profit Center → Maintain
Profit Centers.

Note that you can only create a dummy profit center [Page 66] in Customizing (see
Maintaining dummy profit centers [Ext.]).

Process Flow
1. Enter a name for the profit center you want to create.

If you want to copy the new profit center from an existing one, enter the name of the
existing profit center in the Copy from box. You can copy the profit center from a different
controlling area. If you do so, fields which are not controlling area-dependent will be
copied to the new profit center as empty fields.

When you enter a name for a profit center, the system interprets purely numerical
entries as numbers and automatically inserts leading zeros. For example, if you
create a profit center 333, the system saves this as 0000000333. This has the
consequence that you cannot search for this profit center using the Possible entries
function by entering 3*. You can prevent this by entering at least one letter
somewhere in the profit center name.

2. On the Basic data tab page, enter the basic data for the profit center.

a. As long as you do not activate the profit center using  (see step 7), the status of the
profit center remains inactive: Create displayed No postings can be made to the profit
center while it has this status. You should not activate a profit center until all required
entries have been made. In the meantime, you can save the profit center inactively using

.

b. Enter the entire validity period of the profit center as the analysis period.

When you have created the profit center, you can divide it into several analysis
periods - see Changing Profit Centers (Individual Processing) [Page 26]. These can
differ in the master data.

c. Define the profit center manager and the department to which the profit center belongs.

d. If you are not using the enterprise organization, assign the profit center to an end noce
of the standard hierarchy [Page 64] in the hierarchy area.

The hierarchy area is always valid for the entire period of validity. It cannot
therefore be used to distinguish various analysis periods.
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If the enterprise organization is active in the controlling area, you must enter a
hierarchy area. However, this is overwritten as soon as the profit center is assigned
to another node in the enterprise organization.

Enterprise organization assignment and the standard hierarchy derived from this
always have priority over manual assignments.

e. If you are using distributed Profit Center Accounting with a decentralized scenario, the
system displays a Logical system field. Here you enter the master system of the profit
center. For more information, see Decentralized Profit Center Accounting [Ext.].

3. On the Indicators tab page, you can lock the profit center against all postings. This lock is
only valid for the specified time period. If a posting is made to an object that is assigned to a
locked profit center, the system displays an error message. The data is not posted in any
application.

On this tab page you can also see whether the profit center is defined as a dummy profit
center. However, you cannot change this setting.

If you use Formula Planning, assign a template to the profit center on this tab page. The
system uses this to calculate plan values for the profit center when you run Formula
Planning.

4. On the company codes tab page, the system assigns a default profit center to all the
company codes within the controlling area. You can exclude certain company codes for the
profit center. This setting is checked when postings are made to the profit center.

With Consolidation (EC-CS), it might be necessary to enter certain company codes. If the
profit center is not assigned to a company code, the system displays an error message
whenever a posting is made to that profit center in EC-CS.

Note that joint venture data can only be assigned to the profit center for the company
code to which it has been assigned.

5. The history tab page contains information on previous changes to the profit centers. It is
therefore of no importance to you when creating a profit center.

6. On the other tab pages, you can enter additional information such as an address,
communication data, and so on. You should only enter joint venture information if joint
venture accounting (such as in the Industry-Specific Solution "IS Oil") is active in your
system. The Information tab page contains information as to who created the profit center,
who last changed it, and so on.

7. When you have made all required entries, activae the profit center using . On the Basic
data tab page, the status of the profit center changes from inactive to active. Data can now
be posted to the profit center.
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Changing Profit Centers (Individual Processing)
There are two places where you can change a profit center:

•  In the application menu, under Master Data → Profit Center → Individual Processing →
Change

•  in Customizing for Profit Center Accounting, under Master Data → Profit Center → Maintain
Profit Centers.

It is also possible to change profit center master data using collective processing. For further
information, see:

Creating/Changing Profit Centers (Collective Processing) [Page 29]

Maintaining Company Code Assignments (Collective Processing) [Page 31]

Maintaining the Profit Center Status (Collective Processing) [Page 33]

Procedure
Make the required changes on the corresponding tab pages. For further information the meaning
of the various fields, see Creating Profit Centers (Individual Processing) [Page 24]. When
changing profit center master data, you should take the following points into consideration:

Validity Period and Analysis Periods
1. By choosing  Validity Period you can lengthen or shorten the validity period of a profit

center.

When shortening the validity period of a profit center, you should be aware that this
can lead to loss of data. Although the system carries out various checks, it cannot
provide an absolute guarantee that no assignments exist to the profit center for the
period to be removed. If you shorten a profit center from a given date in the future,
choose Goto → Assignment Monitor [Page 98] to check whether all assignments to
the profit center have been removed from this date.

2. If you want to set up analysis periods with differing master data within the validity period,
enter the required time interval under  Analysis Period and choose Confirm. The changes
you make on the various tab pages here only affect the chosen time period.

If a field within the validity period or an analysis period contains several values, the
system displays a “+” in that field. You can drill down to the values for the different
intervals by choosing  or by double-clicking on the corresponding field.

The hierarchy area is always time-independent. It applies for the entire validity
period and cannot therefore be changed for individual analysis periods.



 SAP AG Profit Center Accounting (EC-PCA)

Changing Profit Centers (Individual Processing)

April 2001 27

Maintenance status
If you choose  to save the changes you have made, the changes are saved as inactive:
change. If an active version of the profit center exists, the system still posts data to it. You can
switch between the active and inactive versions of a profit center by choosing .

The system does not post data to the changed version of the profit center until you have
activated by choosing , thereby replacing the previous active version. When you activate the
changed version, the system carries out the necessary checks. However, you can also have the
system carry out these checks before activation, by choosing .

If an inactive version of a profit center exists, which you no longer require, remove it by choosing
Edit → Remove Inactive Version. Thereafter, the profit center exists in active status only.

The hierarchy area is not version-specific. If it is changed in the inactive version,
the change is also made automatically in the active version.

History
By choosing the History tab page and then Changed documents, you can generate a list of the
changed fields in the master data record and a separate list of changed company code
assignments. You can then display details of changes made to an individual field, or all fields.
You can also call up this function from the application menu, by choosing Master Data → Profit
Center → Individual Processing → Display Changes.
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Deleting Profit Centers (Individual Processing)
You can delete a profit center in the Profit Center Accounting application menu, under Master
Data → Profit Center → Individual Processing → Delete.

Prerequisites
Before deleting the profit center, the system carries out a number of checks.

The profit center cannot be deleted if transaction data has already been posted to it and/or the
profit center is assigned to the following objects:

•  Cost centers

•  Materials

•  Business processes

Assignments to other object types, however, do not prevent you from deleting the profit center.

Only delete profit centers which you have never used productively, or have not used
for a number of business periods. Should you decide to remove a profit center from
the system which has already been used operatively, as you no longer need it, use
the transaction Change profit center and restrict the future validity period of the profit
center.

Procedure
1. Choose  to mark the profit center for deletion.

The system gives the profit center the status deletion inactive. parbleu The active status
of the profit center, which can receive postings, is not yet deleted however. You can
switch between the active and inactive status of the profit center by choosing .

2. Should you decide to reverse the previous step, choose Edit → Remove Inactive Version.

3. The system does not delete the profit center entirely until you active the deletion by choosing
. The system now carries out the checks mentioned above. However, you can also carry

out these checks before activation, by choosing .
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Maintaining Master Data (Collective Processing)
Use
Collective processing allows you to change a large quantity of profit center master data without
having to access master data maintenance for each single profit center.

Profit centers can only be created in Individual Processing [Page 24].

For specific information about collective processing of company code assignments, see
Displaying/Changing Company Code Assignment (Collective Processing) [Page 31].

Procedure
1. In the application menu, choose Master Data → Profit Center → Collective Processing →

Master Data.

The system displays a selection screen, where you can determine which profit centers
you wish to maintain the master data for.

By clicking on  you can expand or reduce the selection criteria. For example, you
might only want to change the profit centers for a certain department.

2. You can save a variant for yourself, containing your particular selection criteria and your field
selection.

To save a variant, click  on the selection screen.

When making repeated changes of the same type, you can then retrieve this variant by
clicking on Get variant.

3. Choose .

The system displays a list of all the profit centers you selected. In the list header, you can
see the master data fields which you want to change.

You can expand or reduce these by clicking on .

4. In the header of the list, enter the values which you want to assign to the field in question.
Mark the profit centers for which this particular change is to take effect.

There are two additional functions available for editing the values:

− You can enter a value directly in a row.

− You can only change a field if it has a certain current value.

To do so, choose  Restrictions and enter the new value in the first row and the
value you want to replace in the second row.

− You can display previously entered values

Provided that you have not left the translation after changing the values, you can
choose previously entered values by choosing  Choose Old Values. To display
database changes (for example, changes made to the database by other users since
you last changed it yourself), choose .
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5. Now choose .

Repeat step 4 until all required changes have been entered in the list.

6. Finally, save your entries by clicking on .

The changes are now made in the master record for all selected profit centers.
Before saving, make sure that you have selected all the profit centers that you wish
to process.

The system now creates a log. This allows you to determine whether or not the system has
carried out the required changes. If this is not the case, an error message is displayed.

By clicking Object or Object in the log, you can go to individual processing.

With regard to collective processing of profit center master data, note the following:

The hierarchy area can only be changed for more than one profit center in collective
processing if all of these profit centers have the same period of validity.

If you change the Valid from field, a new period of validity is generated. For more
information about the rules for time-dependency, see Customizing for Profit Center
Accounting, under Master Data → Profit Center → Specify Time-Based Fields for
Profit Centers.

Example:

Original period of validity: 01.01.1998 - 31.12.2002

Valid from changed to 01.01.1999

New periods of validity: 01.01.1998 - 31.05.1999

01.06.1999 - 31.12.2002

Changes to the period of validity are not displayed until you call up the transaction
again.

For further information, see the SAP library, under CA-Cross-Application Mass Maintenance.



 SAP AG Profit Center Accounting (EC-PCA)

Maintaining Company Code Assignments (Collective Processing)

April 2001 31

Maintaining Company Code Assignments (Collective
Processing)
Use
Collective processing allows you to change the company code assignments for a large quantity
of profit centers, without having to access master data maintenance for each single profit center.

If you do not change the company code assignments in either individual processing
or collective processing, a profit center is assigned to all company codes in the
controlling area.

With Consolidation (EC-CS), it might be necessary to enter certain company codes.
If the profit center is not assigned to a company code, the system displays an error
message whenever a posting is made to that profit center.

Note that joint venture data can only be assigned to the profit center for the company
code to which it has been assigned.

For specific information about collective processing of other master data, see
Displaying/Changing Master Data [Page 29].

Procedure
1. In the application menu, choose Master data → Profit center → Collective processing →

Company code assignment.

The system displays the profit center standard hierarchy. A column is inserted for each
company code selected, indicating for each profit center whether or not it is assigned to
the company code in question. Note than you can select no more than 20 company
codes at a time. To process any further company codes, repeat the transaction.

Rather than displaying the standard hierarchy, you can display selected profit center
groups instead. You can also restrict the display to selected company codes.

2. If there are certain company codes which you do not want to be affected by the changes you
make, click the corresponding company code ID in the column header. To reverse this step,
just click on the company code ID again.

If you would not like any company codes to be affected by the changes you make,
choose Edit → Deselect all. If you would like all company codes to be affected by the
changes you make, choose Edit → Select all.

 means that the company code cannot be edited.

 means that the company code can be edited.

3. Make the required changes.

To assign individual company codes to individual profit centers, select the corresponding
field by clicking on it. To reverse this step, just click on the field again.

To select a profit center row, click on the  icon in front of the corresponding profit
center ID.
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To select more than one profit center, keep the Ctrl key pressed down on your
keyboard.

To select an interval of profit centers, keep the Ctrl key and ���� pressed down on
your keyboard.

To select or deselect the assignment of a profit center to all company codes being edited
( ), select the row to which the profit center belongs and choose  or .

To display the master data for the individual profit centers, double-click  or choose .

If you want to reverse the changes you have made, choose . All company code
assignments will then return to how they were the last time they were saved.

4. Check the company code assignments you have made. To do this, choose .

A company code assignment cannot be undone if:

the profit center has cost centers assigned to it which are contained in the company
code in question

the profit center has materials assigned to it which are contained in the company
code in question

5. Save your changes.

If you have not already checked your company code changes, the system will do this for
you automatically when you save.
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Enterprise Organization (CO)
Purpose
The enterprise organization [Ext.] is a uniform, integrated user interface [Ext.] for the different
organizational units in the SAP system.

The structure of your enterprise is represented in the SAP system by means of different
organizational units (controlling area, company code, cost center and so on). In the Human
Resources (HR) organizational structure [Ext.] for example, a company is broken down into
departments, each of which is responsible for performing particular tasks. By way of contrast, in
the standard hierarchy [Ext.] for cost center accounting, companies are broken down with regard
to responsibilities for costs.

The enterprise organization helps you process your organizational structures so that:

•  These structures can be changed to reflect organizational changes within the enterprise.

•  A company's organizational structure is more transparent since the links between the
organizational units are visible and can be evaluated.

•  The different business processes can be integrated optimally, and thus are more economical
with resources.

•  The data is for internal and external reporting

Implementation Considerations
You need to activate the enterprise organization to be able to use it. You do this in Customizing
for the application component in question by choosing Enterprise Organization → Enter Settings
for the Enterprise Organization [Ext.].

Integration
Enterprise organization is based on the organizational plan in HR, and contains additional
functions and organizational units specific to accounting.

The following areas are currently integrated in enterprise organization:

•  HR organizational plan

•  Cost center standard hierarchy

•  Profit center standard hierarchy

If the enterprise organization is active for a controlling area, you can no longer assign
the organizational units (controlling area, company code, and cost center) in the HR
organizational structure. Instead, use the functions in the enterprise organization.

Enterprise organization therefore provides an overview of the enterprise in terms of
responsibilities for:

•  Personnel

•  Costs
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•  Revenues

Features
Representing the structure of an enterprise

•  The structure of an enterprise is displayed in a simple tree structure.

•  You can change the enterprise organization per specific date.

This facility enables you to create past, present, and future organizational structures for
your enterprise (see also Time-Dependency of Enterprise Organizations [Page 37]).

•  The single maintenance screen for several organizational units or structures enables you to
display and evaluate the links between the organizational units.

•  Using the search function, you select the organizational units and then assign these to the
organizational structure using drag-and-drop (see Searching for Organizational Units [Page
51]).

Processing organizational structures

•  In the enterprise organization, you can create new organizational units (see Creating
Organizational Units [Page 53]).

In so doing, the system transfers the data in accordance with the inheritance principle
(see the Inheritance Principle [Page 41]).

•  Using drag-and-drop, you can copy organizational units from the selection area into the tree
structure (see Assigning, Reassigning, or Moving Organizational Units [Page 57]).

•  Using drag-and-drop, you can copy organizational units from the selection area into the tree
structure (see Assigning, Reassigning, or Moving Organizational Units [Page 57]).

•  You can maintain the master data for the individual objects directly from the tree structure
(see Displaying or Changing Organizational Units [Page 56]).

•  You can activate or delete inactive master record versions from cost centers and profit
centers (see: Activating Inactive Master Data [Page 61] or Deleting Inactive Master Data
[Page 63]).

•  Enterprise organization is a logical development of the HR organizational plan.

An enterprise structure is more detailed in HR than in CO. Therefore all CO objects (such
as controlling area, cost center) are assigned to the HR-Organizational Unit [Ext.].

Note, however, that you can only assign one object type to a single HR
organizational unit each time you are processing.

•  When processing the enterprise organization, the system carries out a number of checks on
consistency.

For example, you can enter a cost center in the enterprise organization only if you have
already assigned a controlling area to this enterprise organization.
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You can make checks on a particular key date. To do so, choose Enterprise
organization → Check. You can make the following checks online or in a background
job.

•  Check that the enterprise organization is complete (see Time-Dependency of
Enterprise Organizations [Page 37]).

•  Consistency checks

•  From the enterprise organization you go to the web form to request a cost center change by
choosing Extras -> Change request for cost centers (see Requesting a Change to Master
Data in the Intranet/Internet [Ext.]).

Data from the detail area is also transferred to the form.

Constraints
From the enterprise organization you can only currently display master data for controlling areas
and company codes.

Making mass changes to master data simultaneously as under Change Management [Ext.] is
currently not possible.

For more information, see the SAP Library under Human Resources → PA - Personnel
Management → Organizational Management [Ext.].
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Time-Dependency of Enterprise Organizations
Use
You can change the enterprise organization [Ext.] per specific date.  This enables you to display
past, present, and future organizational structures of an enterprise.

Note however that this time-based facility is not used in all SAP application components that are
connected to the enterprise organization. In accounting for example, organizational units such as
the company code [Ext.] or controlling area [Ext.] are not time-dependent. In the case of cost
centers [Ext.], the period is the only time factor of relevance. For each application, you can enter
the time at which the changes to the organizational structure in question are to take effect.

Features
Validity of Organizational Units and Assignments

•  A key date and preview period [Ext.] is set for processing the enterprise organization.

When you call this up for the first time, the following are standard settings:

− Today's date is set as the key date which you can change as required.

− A preview period of one year is set, which you can change as required.

The next time that you call this function up, the entries you selected for the key date and
the preview period are set.

•  If you create a new organizational unit in the overview area then:

− The validity of the organizational unit starts with the set key date.

You can bring this forward in the detail area.

− The assignment in the organizational unit starts with the set key date.

You can end [Ext.] the assignment if it should only have a limited validity.

•  If you are looking for organizational units in the search area, the system selects all those that
are possible, for which the set key date and preview period apply, and displays them in the
selection area.

•  In the structure tree in the overview area objects are indicated with  if their validity or
assignment does not begin until the preview period. Objects are indicated with  if their
validity or assignment ends in the preview period.

Assignments usually become valid on the selected key date. Alternatively you can
use a dialog box to enter any validity dates required when you assign organizational
units (see Activating/Deactivating Timeframe Query [Ext.]).

Transferring Changes in The Enterprise Organization in Organizational Structures

•  The changes you make to the enterprise organization are immediately transferred to the
organizational plan in Human Resources (HR).
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•  For the cost centers or profit center standard hierarchy, you can specify when and how
changes in the enterprise organization are to be transferred to the appropriate standard
hierarchy. You can also generate additional alternative hierarchies (for planning purposes for
example).

For more information, see Customizing for the corresponding application and choose
Enterprise Organization → Generate Standard Hierarchy or Alternative Hierarchy [Ext.].

•  In Customizing for Cost Center Accounting or Profit Center Accounting, you can specify a
range of fiscal years within which the system ensures that the standard hierarchy is
complete. Complete means here that all cost centers or profit centers that are valid for all or
part of this period (according to the start or end date) are contained in the standard hierarchy.

For more information, see Customizing for the corresponding application by choosing
Enterprise Organization → Enter Settings for Enterprise Organization [Ext.].

You can also generate the standard or alternative hierarchy from the application, by
choosing Enterprise organization → Generate.
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Scenario 2

You make changes to your enterprise organization on 12/20/1998.

In the first instance you generated your standard hierarchy on 09/14/1998. It follows
that the standard hierarchy contains the previous status of the enterprise
organization. To enable these changes to be incorporated in planning, you can
generate an alternative hierarchy that contains the latest version of the enterprise
organization as of 12/20/1998. At the start of the new fiscal year, you can then
replace the standard hierarchy with the more up-to-date alternative hierarchy.

In the second instance you generated your standard hierarchy on 01/01/1999. It
follows that the standard hierarchy contains the new status of the enterprise
organization. If you need to be able to access the previous version of the standard
hierarchy, you can generate an alternative hierarchy containing the old status of the
enterprise organization prior to 12/20/1998.

See also:
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Linking Enterprise Organizations and Standard Hierarchies [Page 42]
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The Inheritance Principle
The organizational units in the enterprise organization [Ext.] are subject to the principle of
inheritance.

Controlling
area
0001

Company code BCompany code B

Cost center 4210Cost center 4210 Cost center 4220Cost center 4220

Company code [Ext.] B is assigned to the higher level node. It follows that you must have
assigned all those objects that lie below this node (in this case cost centers [Ext.] 4210 and 4220)
to company code B.

If cost center 4220 is new, the master data for this cost center is displayed for processing in the
detail area. In so doing, the system fixes the assignment to company code B (and therefore also
to controlling area [Ext.] 0001). It is not possible for you to change this assignment.

The system checks if cost centers have been assigned to a profit center. The
corresponding profit center is transferred to the master data.

For profit centers, the system transfers the assigned company code to the master
data.
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Enterprise Organizations and Standard Hierarchies
Use
For the cost centers or profit centers standard hierarchy, you can specify on what date changes
in the enterprise organization [Ext.]  the system is to transfer to the appropriate standard
hierarchy [Ext.]. You can also generate additional alternative hierarchies (for planning purposes
for example).

Before you generate a hierarchy, first run the consistency checks on the enterprise
organization. To do so, choose Enterprise organization → Check.

Features
Generating a standard hierarchy from the enterprise organization
You can generate your standard hierarchy for a controlling area at any given key date.

The system determines the current fiscal year from this key date. In Customizing you define the
number of fiscal years (starting from the current fiscal year) to be taken into consideration in the
past and in the future (for more information on this, see Customizing for the application
component in question under Enterprise Organization → Enter Settings For Enterprise
Organization [Ext.]).

The entries you make here are used by the system to determine a validity period that in turn
controls which objects the standard hierarchy contains.

The system then determines all the organizational units and links from the enterprise
organization that apply to the standard hierarchy and which lie within this validity period.

If the master records for the objects are different from the corresponding data in the
enterprise organization, the system changes them to match the enterprise
organization. This adaptation is a standard setting for when you generate the
standard hierarchy from the enterprise organization (see The Inheritance Principle
[Page 41]).

Generating an alternative hierarchy from the enterprise organization
In addition to the standard hierarchy, you can also generate alternative hierarchies to represent
past or future organizational structures.

You can then for example make changes now for the coming fiscal year, but not incorporate
these changes in the standard hierarchy until the start of the new fiscal year. Likewise, for
reporting purposes you can compare the current organizational structure with that of the previous
year.

Generating a standard hierarchy from an alternative hierarchy
During a fiscal year, you made changes to the enterprise organization that have not yet been
incorporated into the standard hierarchy. However, for planning purposes, you generated an
alternative hierarchy, which corresponds to the current status of the enterprise organization.
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For the new fiscal year, you now want to incorporate these changes into the standard hierarchy.
You can do so by generating the new standard hierarchy from the current alternative hierarchy.

Generating an enterprise organization from a standard hierarchy
To generation the enterprise organization for the first time, you can generate it for a controlling
area from an existing standard hierarchy.

Using the functions in the enterprise organization, you can then edit this standard hierarchy.

Activities
•  To generate a standard or alternative hierarchy from the enterprise organization, in

Customizing for Cost Center Accounting or Profit Center Accounting choose Enterprise
Organization → Generate Standard or Alternative Hierarchy From The Enterprise
Organization [Ext.].

•  To generate the enterprise organization from an existing standard hierarchy, in Customizing
for Cost Center Accounting or Profit Center Accounting choose Enterprise Organization →
Generate the Enterprise Organization from the Standard Hierarchy [Ext.].

•  To generate the standard hierarchy from an alternative hierarchy, go to Customizing for Cost
Center Accounting or Profit Center Accounting and choose Enterprise Organization →
Generate Standard or Alternative Hierarchy From The Enterprise Organization [Ext.].

You can also generate the standard or alternative hierarchy from the application, by
choosing Enterprise organization → Generate.
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Generating an Alternative Profit Center Structure
Use
It is necessary to generate an alternative profit center structure view if the organizational
structure of your Profit Center Accounting is not identical to that of the organizational structure. If
you generate this alternative profit center structure view, profit center and profit center groups
can appear more than once in the organizational structure.

A controlling area contains a number of company codes. Each company code
contains a "sales" cost center.

You have structured your Profit Center Accounting according to functions and want
to assign all "sales" cost centers to the cross-company code "sales" profit center.

This means that the "sales" profit center must be inserted at various points in the
organizational structure.

In the standard hierarchy, each profit center can be assigned to one node only. If a profit center
is not explicitly assigned to just one other organizational unit of the same type in the
organizational structure, an additional step is required in order to generate the standard hierarchy
from the enterprise organization.

This additional step is the generation of an alternative profit center structure. In each structure
view, you can assign all profit centers and profit center groups explicitly and generate the
standard hierarchy from them.

Activities
•  If you want to organize your Profit Center Accounting in such a way that profit centers / profit

center groups appear more than once in the organizational structure, define this in
Customizing for Profit Center Accounting, under Enterprise Organization → Enter Settings for
Enterprise Organization [Ext.].

To generate the alternative profit center structure view, choose .

Once you have generated the alternative profit center structure view, you cannot
reverse it. Once you have activated the alternative profit center structure
view, the system always calls it up when generating the profit center
standard hierarchy.

The system automatically carries over changes in the enterprise organization to
the alternative profit center structure view. If these changes affect the
standard hierarchy, it must be regenerated.

•  You display and maintain the alternative profit center structure view from the enterprise
organization, by choosing Goto → Change View...

When you generate the alternative profit center structure view from the enterprise
organization, the only profit centers to be hierarchically structured are those which
belong explicitly to just one other organizational unit of the same type in the assignment
monitor. Profit centers and profit center groups which do not meet this criterion are
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offered in a list in the detail area (Multiply assigned objects). Enter these in the
alternative profit center structure view using drag-and-drop. Once all profit centers are
explicitly assigned, choose  to generate the profit center standard hierarchy,
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The Enterprise Organization: Processing Options
Use
The functions provided under enterprise organization [Ext.] enable you to display and maintain
different objects (cost centers, profit centers) and different organizational structure belonging to
an enterprise (cost center standard hierarchy [Ext.], HR organizational plan [Ext.]).

Features
Using the functions under enterprise organization, you can

•  Generate an organizational structure by creating organizational units and assigning them to
one another (see Creating Organizational Units [Page 53])

•  Display the organizational structure or individual organizational units (see Displaying or
Changing Organizational Units [Page 56])

•  Change the organizational structure by assigning organizational units to it for the first time, or
by moving or deleting these units (see Displaying or Changing Organizational Units [Page
56], Assigning or Moving Organizational Units [Page 57])
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The Screen Areas
Use
You use the enterprise organization [Ext.] maintenance screen to create, display or change
organizational structures.

The maintenance screen is divided into different areas, each of which covers particular functions:

Search Area

Detail AreaSelection Area

Overview Area

The combination of search area and selection area is called the Object Manager.

To display individual areas more clearly, you can hide other areas of the screen.

•  To make the remaining areas of the screen larger, you can display/hide the Object Manager.

•  If you display large lists in the selection area, you can hide the search area. To do so,
choose Result list large/small.

•  If you are processing large structures in the overview area, you can hide the detail area. To
do so, click the pushbutton above the detail area.

Each time you start the functions belonging to enterprise organization, the system
automatically calls up the data that you last processed and uses the size settings
from your last session for the screen areas.
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Features
Search area
In the search area you select one or more organizational units that you want to display or
change, for example:

•  HR organizational units [Ext.]

•  Cost centers [Ext.]

•  Inactive cost centers

•  Cost center groups [Ext.]

•  Profit centers [Ext.]

•  Inactive profit centers

•  Profit center groups

•  Company codes [Ext.]

•  Controlling areas [Ext.]

See also:
Searching for Organizational Units [Page 51]

Selection area
In the selection area, the organizational units you selected are displayed in a list.

•  You can add extra columns by choosing Column configuration. These additional columns can
be for any of the data available as master data.

•  You can restrict the list using certain criteria by setting the filter. You can, for example, select
all objects of an owner.

•  You can display or change an organizational unit in its assignment to the organizational
structure, and the corresponding detailed information, by using the following options:

− Choose the organizational units by double-clicking on them.

The system transfers the organizational unit to the central overview area and
displays the master data in the detail area.

− Use drag-and-drop to move the organizational unit to the overview area.

•  You can activate and delete inactive master data versions of cost centers or profit centers.
You have the following options:

− Select the objects in the selection list.

You can also select the objects in the structure tree of the overview area by
selecting all of the corresponding rows.

− Choose Activate.

A dialog box appears that contains a list of all inactive objects. The objects that you
selected in the selection list or structure tree are already marked in this list.
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If you have not yet selected any objects, you can select in this dialog box all the
inactive objects that you want to activate.

− Choose Activate in the dialog box.

•  You can call up the assignment overview for a cost center or profit center. Do this by
selecting the right mouse button on the corresponding object.

In the overview area the system displays the time frame in which each object is and to
which HR organizational unit it is/was assigned to.

Overview area
The overview area displays the selected organizational unit (with all the objects assigned to it)
as a tree structure, in the time frame set [Ext.] The processing functions are provided in a clear
manner in a function box.

You can also access the most important functions using the right mouse button.

You can:

•  Display/hide additional columns using the Column configuration

•  Print the structure

•  Set the time interval in which the structure (including the CO objects it contains) is to be
processed.

•  Create new objects and assign them to existing objects.

•  Move the objects within the tree structure using drag-and-drop.

•  Select a new object.

•  Copy an HR organizational unit more than once

•  Reduce the length of time that a link between an object and the HR organizational unit exists.

•  Delete a link between an object and the HR organizational unit.

•  Go up a level in the overall hierarchy by using One level up.

You do not have to select the corresponding higher-level node to do so. The system
automatically supplements it in the tree structure.

See also:
Creating Organizational Units [Page 53]

Assigning, Reassigning, or Moving Organizational Units [Page 57]

Terminating or Deleting HR Organizational Units or Assignments [Ext.]

Selecting Key Date and Preview Period [Ext.]

Detail area
In the detail area, you can display or process the master data for each object.
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To display or process the master data for a particular object, choose the object by double-clicking
on it in the tree structure.

In the detail area, you can do the following for the selected object:

• Change the validity period

• Change the processing period, which corresponds to the preview period
[Ext.]

See also:
Displaying or Changing Organizational Units [Page 56]
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Searching for Organizational Units
Use
In the search area you select one or more organizational units that you want to include in your
organizational structure.

You can search for the following organizational units:

•  HR organizational units [Ext.]

•  Cost centers [Ext.]

•  Inactive cost centers

•  Cost center groups [Ext.]

•  Profit centers [Ext.]

•  Inactive profit centers

•  Profit center groups

•  Company codes [Ext.]

•  Controlling areas [Ext.]

Prerequisites
•  The HR organizational units that you are looking for must exist in the current plan version.

See Customizing for the relevant application component, under Enterprise Organization
→ Setting Active Plan Variant [Ext.].

•  You have activated the enterprise organization for your application component.

See Customizing for the relevant application component, under Enterprise Organization
→ Enter Settings for Enterprise Organization [Ext.].

Procedure
Searching for Objects
1. Select the required organizational units.

The Search for <Organizational Unit> dialog box appears.

2. Enter a numeric key or a name.

To restrict the search further, choose an additional field.

You can also search by entering a *.

3. To transfer the hit list into the selection area, choose Search.

4. To supplement the list, choose the required organizational unit again, and then choose Add.

The organizational units that are found, are added to the list in the selection area.
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You can display more information in the hit list. You can do this to show the following
columns for example:

• Assignment to enterprise organization

The system displays whether the object in question is already assigned to the
enterprise organization.

• Link period

The system displays the period for which the object is assigned to the enterprise
organization.

• Activation status

The system displays whether the object is active (green) or inactive (red).

If there is an active and an inactive version [Page 59] of the object, the system
always displays the inactive version here. You can switch between versions in
the detailed information for the object.

To display the additional columns, choose Column configuration and select the
appropriate column. Choose Continue.

Creating/Displaying/Deleting Search Variants
1. Select the required organizational units.

The Search for <Organizational Unit> dialog box appears.

2. Enter the desired selection criteria for the search.

3. Choose Create search variant and enter a suitable name.

4. Choose Enter.

The system saves the selection criteria you enter as a search variant and assigns these
to the appropriate organizational unit in the search area.

5. To check your entries, select the search variant and choose Display search variant.

6. To delete a search variant, select the variant and choose Delete search variant.

You can display the result of a search for a search variant directly in the selection
area. To do so, choose the appropriate search variant by double-clicking on it.

You can scroll down/up the results of the search. Choose Previous search result, or
Next search result.
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Creating Organizational Units
Use
You create organizational units to create or change the organizational structure of your
enterprise.

Prerequisites
You need to activate enterprise organization [Ext.] for your application component.

For more information, see Customizing for the relevant application component by choosing
Enterprise Organization → Enter Settings for Enterprise Organization [Ext.].

Check the key date and the preview period [Ext.] and change the information if required. This
time interval specifies the processing time frame for the enterprise organization, and is also set
as the processing period for the contained CO objects.

Procedure
Creating a Root Organizational Unit
1. If you did not generate the enterprise organization from the standard hierarchy, you need to

recreate the enterprise organization.

You do this in Customizing for the relevant application component by choosing
Enterprise Organization → Create Enterprise Organization [Ext.]

The standard system contains a new HR organizational unit [Ext.] with the provisional
title New Organizational Unit, which you can use as a root organizational unit.

2. In the detail area, overwrite the provisional entries.

3. Save your entries.

Creating Additional HR Organizational Units
1. To create further HR organizational units within an organizational structure, in the overview

area select the organizational unit under which the new object is to be assigned.

2. Choose Create → Organizational unit

You can also copy organizational units  [Ext.] that already exist. All of the
characteristics of this organizational unit are copied also. You can adjust the data in
the detail area.

3. To maintain the data for an HR organizational unit, double-click on the unit in the
organizational structure.

Creating Cost Centers/Profit Centers
1. You can create more cost centers/profit centers:

a. In Customizing for the relevant application component by choosing Enterprise
Organization → Create Enterprise Organization [Ext.]
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b. In the relevant application component by choosing Master data → Enterprise
organization → Change.

2. To create cost centers/profit centers within an organizational structure, go to the overview
area and select the HR organizational unit to which the cost center/profit center is to be
assigned.

3. Choose Create  → Cost center/Profit center.

The system displays the relevant master data in the detail area. Thus the system
transfers the data using the inheritance principle (see the Inheritance Principle [Page
41]).

If a CO object is already assigned to an HR organizational unit, you cannot assign
any additional CO objects.

4. Maintain the master data for the cost center or profit center.

5. Choose Enter.

The system saves the master data as inactive [Page 59].

The system displays the assignment of the cost center/profit center to the HR
organizational unit of the structure in the overview area.

You can currently maintain only cost center and profit center master data in the
enterprise organization. You can display the master data for controlling area and
company code only from the organizational structure.

For more information about cost center master data, see Cost Center Master Data
[Ext.].

For more information about profit center master data, see Profit Centers [Page 22].

Creating Cost Center Groups/Profit Center Groups
To generate a standard or alternative hierarchy from the enterprise organization, you must create
the cost center groups or profit center groups first.

For more information, see Customizing for the relevant application under Enterprise
Organization → Generate Standard Hierarchy or Alternative Hierarchy [Ext.].

1. You can create groups:

a. In Customizing for the relevant application component by choosing Enterprise
Organization → Create Enterprise Organization [Ext.]

b. In the relevant application component by choosing Master data → Enterprise
organization → Change.

2. To create groups within an organizational structure, in the overview area, select the HR
organizational unit to which the group is to be assigned.

The detail area contains the data on the HR organizational unit for processing.

3. In the detail area on the tab strip CO assignment, choose either Cost center group →
Create, or Profit center group → Create.
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4. Enter the name of the group and a description.

The system transfers the group to HR organizational unit assignment to the structure in
the overview area.

If you have not yet generated a group in the standard hierarchy from the enterprise
organization, you can subsequently change the group name and the description.

If a  group or an object is already assigned to an HR organizational unit, you cannot
assign an additional group.
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Displaying or Changing Organizational Units
Use
You can display or change the master data on the individual organizational units.

You can currently change only cost center and profit center master data in the
enterprise organization. You can display the master data for controlling area and
company code only from the organizational structure.

Procedure
1. In the selection area or the overview area choose an organizational unit by double-clicking

on it.

The detail area contains the master data on this object which you can display or edit.

a. To select an organizational unit from the selection area you must already have
searched for one or more organizational units (see Searching for Organizational Units
[Page 51]).

b. To select an organizational unit in the overview area, you must already have transferred
objects to this area or have created them there (see Creating Organizational Units [Page
53], Assigning or Moving Objects [Page 57]).

2. To display of change the master data, select the required tab strip in the detail area.

3. Enter data as required.

In the detail area, you can do the following for the selected object:

• Change the validity period

• Change the processing period, which corresponds to the preview period
[Ext.]

4. Save your entries.

The system saves the master data as inactive [Page 59].
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Assigning, Reassigning, or Moving Organizational Units
Use
To reflect changes to your organizational structure you can:

•  Assign organizational units to the organizational structure.

•  Reassign organizational units, by transferring them to a new position in the organizational
structure.

This enables a time differentiation from the old assignment.

•  Move organizational units, meaning they are moved to a new position on the same branch of
the hierarchy.

Assignments normally become valid on the selected key date. Alternatively you can
use a dialog box to enter any validity dates required when you assign organizational
units (see Activating/Deactivating Timeframe Query [Ext.]).

Prerequisites
You have created an organizational structure; other organizational units may exist that have not
yet been assigned to this structure.

From the structure, choose an organizational unit that you want to process. The organizational
structure is displayed in the overview area. For more information, see Searching for
Organizational Units [Page 51], and Creating Organizational Units [Page 53].

Procedure
Assigning organizational units
1. Search for an organizational unit (see Searching for Organizational Units [Page 51]).

The organizational unit is displayed in the selection area.

2. In the selection area, select the organizational unit.

3. In the overview area, assign the organizational unit to the superordinate organizational unit
using drag-and-drop.

When you assign a cost center or profit center to an HR organizational unit using drag-
and-drop the system makes the following comparisons:

− The profit center entered in the cost center master data with the one derived from the
enterprise organization, and if required, changes the entry in the cost center master data.

− The controlling area entered in the profit center master data with the one derived from
the enterprise organization, and if required, changes the entry in the profit center master
data.
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If the organizational unit was already assigned to the structure, the system
differentiates the old assignment chronologically. This means that the organizational
unit is assigned to the new item from the set key date.

4. Choose Save.

Reassigning or moving organizational units
1. In the overview area, select the organizational unit from the structure that you want to

reassign or move.

2. To move the organizational unit within a hierarchy branch, choose Move up or Move down.

3. To reassign the organizational unit within the organizational structure, use drag-and-drop to
assign it to the desired superordinate organizational unit.

This enables a time differentiation from the old assignment.

To navigate between activities, choose Scroll forward or Scroll back.
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Active and Inactive Master Data
Use
A master record can be in an active and/or an inactive version. There are active/inactive master
record versions for cost centers [Ext.], business processes [Ext.] and profit centers [Ext.].

Prerequisites
You are in the maintenance screen for the Enterprise Organization [Page 34].

Features
Active Master Data
The system works only with the active version of the master record. Therefore, only active
master data is used for postings for example.

Inactive Master Data
If you change one or more of the values in a master record, the system initially saves these
changes in a new inactive version without making the required consistency checks. This version
is not used productively, for example, for postings.

When you create a new master record, the system initially creates an inactive version of the
master record. To be able to use the master data productively, you need to activate the master
record.

When you activate the master data, the system checks the data and if no
inconsistencies, transfers it to the active version of the master record. The inactive
version is deleted.

If there is an older active version of the corresponding master record, the system
overwrites it.

Inactive master data is not transported, nor is it distributed via ALE. You cannot
maintain inactive master data with either  single processing [Ext.] or collective
processing [Ext.]).

Activities
You can activate or delete the corresponding inactive master data:

•  In the Enterprise Organization [Page 34]

•  In standard hierarchy processing for cost centers [Ext.]

•  In the standard hierarchy for profit centers [Page 64]

•  In standard hierarchy processing for business processes [Ext.]

•  In Customizing for the relevant application, choose Master Data → <Object> →
Delete/activate inactive <objects>.
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See also
Activating Inactive Master Data [Page 61]

Deleting Inactive Master Data [Page 63]
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Activating Inactive Master Data
Prerequisites
You are on the maintenance screen for the enterprise organization, and have already selected
cost centers, business processes, or profit centers.

In the search area you can look for inactive cost centers, business processes, or
profit centers.

Procedure
1. Select the inactive object that you want to activate,

a. In the list in the selection area, or

b. In the structure tree in the overview area.

You can select more than one object in the selection area and/or the overview
area.

2. Choose Activate.

A dialog box appears that contains a list of all inactive objects. The objects that you
selected in the selection list or structure tree are already marked in this list.

If you have not yet selected any objects, you can mark in this dialog box all the
inactive objects that you want to activate.

3. In the dialog box choose Activate.

The system saves the objects as active [Page 59].

You can activate inactive master data in Customizing also. In Customizing for the
relevant application component, choose Master Data → <Object> → Activate
inactive <object>.

Result
The system changes the activation status in the selection area and in the overview area from
inactive (red) to active (green).

In the detail area you see whether a master data was created, changed or deleted by looking at
the status text.
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If there is an active and an inactive master record version, you can switch between
versions in the detail area. You can also trigger the checks for the inactive master
record version.

You trigger activation and checking only after you have made all your changes. You
can also select more than one object in the selection area and/or the overview area
for this.
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Deleting Inactive Master Data
Prerequisites
You are on the maintenance screen for the enterprise organization, and have already selected
cost centers, business processes, or profit centers.

In the search area you can look for inactive cost centers, business processes, or
profit centers.

Procedure
1. Select the inactive object that you want to delete,

a. In the list in the selection area, or

b. In the tree structure in the overview area.

You can select more than one object in the selection area and/or the overview area.

2. Choose Delete inactive version.

A dialog box appears that contains a list of all inactive objects. The objects that you
selected in the selection list or structure tree are already marked in this list.

If you have not yet selected any objects, you can mark in this dialog box all the
inactive objects that you want to delete.

3. In the dialog box, choose Delete inactive version.

The system deletes the marked inactive objects.

You can delete inactive master data in Customizing also. In Customizing for the
relevant application component, choose Master Data → <Object> → Delete inactive
<objects>.
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Standard Hierarchy
Definition
A special type of profit center group [Page 67]. The standard hierarchy is a tree structure which
contains all profit centers in a controlling area and reflects the organizational organizational
structure used in Profit Center Accounting.

Use

You should only perform the steps below if the enterprise organization is not active
in the controlling area.

1. There are two places where you can create/change the structure of the standard hierarchy:

− in the Profit Center Accounting application menu, under Master Data →
Create/Change/Display Standard Hierarchy.

− in Customizing for Profit Center Accounting, under Master Data → Profit Center →
Maintain Standard Hierarchy.

2. You have now created a basic profit center group. To indicate this as a standard hierarchy,
you have to enter its name in Customizing for Profit Center Accounting, under Basic Settings
→ Controlling Area Settings → Maintain Controlling Area Settings.

3. Create the profit centers and assign each profit center to a node in the standard hierarchy.
You have two options here:

a. Create a profit center in individual maintenance. In the field Hierarchy Area, enter the
name of the node to which you want the profit center should be assigned. For further
information on individual maintenance, see creating [Page 24], changing [Page 26] and
deleting profit centers (individual processing) [Page 28].

b. Create a profit center from the standard hierarchy. To do this, choose Change Standard
Hierarchy. Position the cursor on the node to which you want to assign the profit center,
and choose . Profit center maintenance is carried out in the detail area in much the
same way as individual maintenance (see a).

If you choose b), status maintenance is not performed in the detail area. Instead, you
have to mark the corresponding objects for activation ( ) and/or mark inactive
versions for deletion (  inactive) in the selection area. This procedure allows you to
process profit centers collectively.

Integration
Enterprise Organization
If you have the enterprise organization active in the controlling area, the standard hierarchy is
generated automatically from the enterprise organization (or, where necessary, using an
alternative profit center structure view) For further information, see Linking the Enterprise
Organization and the Standard Hierarchy [Page 42] and Generating an alternative profit center
structure [Page 44].
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Cost center standard hierarchy
You can define the structure of profit centers in your organization to correspond roughly to your
cost center structure. If this is the case, you can copy the entire cost center hierarchy to your
profit center hierarchy. You can then modify the hierarchy as necessary to meet your
requirements in Profit Center Accounting. You can only use this function if the enterprise
organization is not active in the controlling area.
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Dummy Profit Center
Definition
The dummy profit center is the default profit center to which data is posted when the
corresponding object has not been assigned to a profit center.

You can find out which objects are not assigned to profit centers by analyzing the postings
assigned to the profit center. You can also assess or distribute data from the dummy profit center
to the desired profit centers.

Use
It may happen that some objects in your system are inadvertently left without an assignment to a
profit center. In this case, postings to accounts which are defined as revenue or cost elements
are assigned to the dummy profit center of the controlling area to which the object posted to
belongs. This ensures that your internal and financial accounting data are reconciled.

You should not assign data intentionally to your dummy profit center for the purpose
of allocating it later. If desired, define a separate “allocation profit center” for this
purpose.

You create the master record for the dummy profit center in Customizing. To change or display
the dummy profit center, use the normal functions Change profit center and Display profit center
(see Creating, Changing and Displaying a Profit Center [Page 24]).

Structure
The dummy profit center is structured just like a normal profit center. The only difference is a flag
indicating that it is the dummy profit center.
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Profit Center Groups
Definition
A profit center group is a hierachical structure of profit centers.

You can use profit center groups to group profit centers together according to company-specific
criteria.

Use
Profit center groups are used for reporting, allocations or in various planning functions, where it
does not make sense to enter or display data at the lowest level (with a high level of detail).

The standard hierarchy [Page 64] is a special type of profit center group. It has to contain all
profit centers belonging to the controlling area and reflect the organizational structure of Profit
Center Accounting.

You maintain profit center groups

•  in Customizing for Profit Center Accounting, under Master Data → Profit Center → Maintain
Profit Center Groups.

•  in the Profit Center Accounting application menu, under Master Data →
Create/Change/Display Profit Center Group.
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Representative Materials
Definition
A representative material is a material number that stands for a group of materials with similar
characteristics. For example, different materials that have similar manufacturing or cost
structures can be grouped together under one representative material.

Use
If you have a large number of variants of one material and store each of these variants under a
different material, it may be useful to select one of these materials to represent the others. It may
not always make sense to store actual data, create plan data and define transfer prices at the
individual material level. By defining one material as the representative material, you can store
and analyze actual and plan data by product or product group.

Structure
A representative material can be either a material which is already part of the combined group, or
an additional material which you create for this purpose. In both cases, it is necessary to create a
corresponding master record in the system, analogous to all other materials. Normally, finished
and semifinished products, not raw materials, are used as representative materials.

In Customizing, under Representative Materials, Derivation [Ext.], you can define rules according
to which the accompanying representative material is derived from a material. You can assign
representative materials at the controlling area, company code or depreciation area level, or for
any combination of these.

You can find more information on derivation strategy in the documentation for Profitability
Analysis (CO-PA) under Derivation Type [Ext.].

Integration
You can use representative materials in planning, for actual data, and for calculating transfer
prices.
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Revenue and Cost Elements and Account Groups
Definition
The transaction data in Profit Center Accounting is stored in the accounts contained in the chart
of accounts for your controlling area. These accounts include those from Financial Accounting
which are used in Controlling (primary revenue and cost elements) and accounts which occur
only in Controlling (secondary revenue and cost elements) (see Maintaining Revenue and Cost
Elements [Page 71]). In addition, you can also transfer some accounts used only in Financial
Accounting (payables/receivables, material stocks, work in process, and so on) in order to
analyze assets, material inventories, product stocks, and changes in stock by profit center. These
particularly include payables and receivables, material stocks, work in process, and others. See
also Balance Sheet Items in Profit Center Accounting [Page 297].

You can define any number of hierarchical structures of accounts for use in the information
system, allocations and planning. These structures are called account groups (see Maintaining
Account Groups [Page 72]). These account groups are only valid in Profit Center Accounting.
Note that account groups are valid for all clients, and therefore also for all controlling areas.

Structure
The standard R/3 System already contains some predefined account groups. These include:

•  BAB-GKR and/or OAS-INT and/or OAS-Caxx
These account groups reflect the account structure of primary and secondary
revenue/cost elements in each chart of accounts.

•  BSA-GKR and/or BSA-INT and/or BSA-BAxx
These account groups reflect the account structure of fixed capital in each chart of accounts,

GKR German Joint Standard Accounting System

INT International chart of accounts

CAxx/Baxx country-specific chart of accounts, with
xx as the country key

These groups all represent the highest node in a hierarchy which is delivered with the standard
R/3 System. Thus the standard contains a complete account group hierarchy for use in the
information system. However, you will most likely need to modify this standard structure to fit
your company’s needs.

The standard account groups listed above are contained in client 000 in the standard system. To
read about how to copy the account groups needed for your controlling areas to your productive
client, see Maintaining Account Groups [Page 72].
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Maintaining Revenue and Cost Elements
Use
The transaction data in Profit Center Accounting is posted to revenue and cost elements in the
chart of accounts for your controlling area.

Features
You can maintain the primary and secondary revenue and cost elements directly in Profit Center
Accounting under the menu option Master data → Revenue/cost elements.

For more details, see also Editing Cost Elements [Ext.]
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Maintaining Account Groups
Use
You can define any number of hierarchical structures of accounts for use in the information
system, allocations and planning. These structures are called "account groups". You can create
new account groups as well as display or change existing ones. If you want to use the same
account groups in Profit Center Accounting that you have already created in Cost Center
Accounting, you can copy them to Profit Center Accounting. The same goes for balance sheet
account groups that you already created in Financial Accounting.

Each account group is assigned to a chart of accounts. You can only use an account
group in multiple controlling areas if those controlling areas use the same chart of
accounts.

Features
To maintain account groups, choose the menu option Master data → Account groups. The steps
required for maintaining account groups corresponds to the way you create Profit Center Groups
[Page 67]. Note that the account groups you maintain here are valid only in Profit Center
Accounting.

To copy revenue and cost element groups from Overhead Cost Controlling, you can do this using
the function Master data → Account group → Copy → Cost element group. To copy balance
sheet account groups from Financial Accounting to Profit Center Accounting, choose Master data
→ Account group → Copy → Financial statement version.

You copy financial statement version BERL (commercial balance sheet) in chart of
accounts INT to Profit Center Accounting, and enter "98" as the suffix.

The balance sheet item "1000000 Assets" becomes account "100000098 Assets" in
the new account group.

The standard account groups listed in the section Revenue and Cost Elements and
Account Groups [Page 69] are contained in client 000 of the standard system. To
copy the account groups needed for your controlling areas to your productive client,
choose Master data → Account groups → Change. Enter the desired controlling area
(if you have not already set the controlling area) and the account group you want to
copy. Then choose Extras → Copy from client. Enter the source client in the dialog
box, then press ENTER.
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Statistical Key Figures and Statistical Key Figure
Groups
Definition
Statistical key figures provide information on non-monetary data for profit centers, such as the
number of employees, number of machines, capacity usage, market information, and so on. You
can group statistical key figures together into statistical key figure groups.

Use
Statistical key figures let you display characterizing information about profit centers in addition to
the usual monetary data from accounting.

Some examples of statistical key figures area:

•  number of employees

•  square meters or feet (for administration, production, storage, and so on)

•  number of telephones, PCs, and so on

•  calling units for telephones

•  market share of a product group

You can use statistical key figures in the information system to analyze such typical controlling
information as:

•  sales per employee

•  personnel costs per employee

on top of the usual monetary key figures such as the profit-sales ratio (profit/sales) or capital
turnover (sales/invested capital). These relative key figures make it easier to compare the
success of the individual profit centers.

As in Cost Center Accounting, you can use statistical key figures in Profit Center Accounting as
tracing factors for periodic assessment and distribution.

You can distribute the fixed capital in the form of real estate and buildings to the
individual profit centers according to the number of square meters required.

Statistical key figure groups are used primarily to select report data in the Information System
[Page 327].

Structure
A statistical key figure consists of an assignment to a controlling area, a unit of measure and a
key figure category. The unit is a unit of quantity or time in which the entered values are posted.
The key figure category determines whether the values of the key figure should be the same for
all months (type 1, fixed values), or whether they should only apply for one month (type 2, totals
values).

See also:
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Maintaining Statistical Key Figures and Key Figure Groups [Page 75]

Transferring Statistical Key Figures [Page 275]

Entering Actual Data and Statistical Key Figures using a Layout [Page 279]
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Maintaining Statistical Key Figures and Key Figure
Groups
Use
This function lets you maintain statistical key figures and statistical key figure groups [Ext.].

Features
Profit Center Accounting does not store separate master data for statistical key figures. Instead,
when you maintain them, the system takes you directly to the function in Cost Center Accounting.
To do this, choose Master Data → Statistical Key Figures → Individual Processing →
Create/Change/Display.

You can maintain groups of statistical key figures under the menu option Master data →
Statistical key figure group → Create/Change/Display. These are primarily used for selection
report data in the Information System [Page 327].

For more information about maintaining statistical key figures, see the SAP Library for Cost
Center Accounting, under Editing Statistical Key Figures [Ext.].

For information about how statistical key figures are transferred from other applications to Profit
Center Accounting, see Transferring/Creating Statistical Key Figures [Page 275].
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Profit Center Assignments
Use
You divide your company into profit centers by assigning all the objects which contain profit-
related data to your profit centers. By making these assignments, you can also display selected
balance sheet items in Profit Center Accounting [Page 297].

Note that you can only assign objects from one controlling area to a profit center.

Profitabiity segmentProfitabiity segment

Profit CenterProfit Center

Asset/
maintenance order

Asset/
maintenance order

Sales order/
projectt

Sales order/
projectt

MaterialMaterial

Production order
CO production order

process order

Production order
CO production order

process order

Internal order
project/network
Internal order

project/network

Cost objectCost object

Cost centerCost center

These assignments make it no longer necessary for you to post your data explicitly to profit
centers. The system automatically transfers the data to Profit Center Accounting when it is
posted to the original object. You can reflect both actual and plan data from the assigned objects
in Profit Center Accounting in this manner.

Integration
The following data is transferred to Profit Center Accounting:

•  Revenues and sales input - through assignment of sales document items

•  Direct costs - through assignment of production orders and cost objects

•  Overhead costs - through assignment of account assignment objects from Overhead Cost
Controlling (cost centers, orders etc.)

The objects listed below provide further details on this topic (see subheading: Features) For more
information about the transfer of data to Profit Center Accounting, see the section Actual
Postings [Page 226].
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To obtain an overview of current assignments, see the Assignment Overview [Page 98] . It is also
possible to display those objects which have not yet been assigned to a profit center. By going
directly to the maintenance transactions for an account assignment object, you can retrieve or
correct existing assignments.

Features
An object’s assignment to a profit center is stored in that object’s master record. By choosing
Master data → Current settings, you can go directly to master data maintenance for the relevant
objects, or carry out the corresponding activities in Profit Center Accounting Customizing.

Here, you can make the following assignments to profit centers.

Assigning Sales Orders [Page 82]

Assigning Manufacturing Orders [Page 86] (including production orders, CO production orders
and process orders)

Assigning Cost Objects [Page 87]

Assigning Cost Centers [Page 90]

Assigning Internal Orders [Page 92]

Assigning Business Processes [Page 93]

Assigning Maintenance Orders [Page 94]

Assigning Projects [Page 88]

Assigning Materials [Page 78]

Assigning Assets [Page 95]

Assigning Real Estate Objects [Page 96]

Assigning Profitability Segments [Page 97]

For materials, a Fast Material Assignment [Ext.] is available.

In addition, you can activate substitutions for the assignment of sales orders (see Substitutions
for Sales Orders [Page 84]).
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Assigning Materials
Use
Assignments of materials to profit centers provide the default values for assignment of sales
orders and manufacturing orders.

With internal goods movements also (such as stock transfers or material withdrawals) the profit
center is derived from the material master, if no other account assignment has been made. See
Transfer from Materials Management [Page 245].

The assignment of materials also forms the basis for the transfer of material stocks to Profit
Center Accounting.

The assignment material → plant is only valid for a single plant. You can assign materials by
changing the material master record directly or using the fast assignment function [Ext.], which
lets you assign a larger number of materials to one profit center at the same time.

Profit
center III

Profit
center II

Profit
center IMaterial A

Material B

Material C

Plant I Plant II Plant III

Activities
To assign material masters, choose Master data -> Current settings from the application menu,
then choose Assignment: Materials/Master.

To perform a fast assignment, choose Master data -> Current settings from the application menu,
then choose Assignment: Materials/Fast Assignment. Alternatively, you can choose Master Data
-> Assignment Monitor -> Materials -> Fast Assignment.

You can find a detailed description of how to assign materials in the Implementation Guide (IMG)
for Profit Center Accounting, under Assignments to Profit Centers.
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Making Mass Changes
Prerequisites
In mass maintenance, many objects can be changed at the same time. For this reason, the mass
maintenance tool must be used only by experienced persons.

Procedure
1. Access mass maintenance [Ext.] and choose Mass Maintenance →→→→ Dialog processing and

specify the relevant application, that is, object type. The application appears automatically if
you have accessed the mass maintenance tool from the area menu for the application. If you
have defined a variant, you can enter it on this screen. Choose Execute.

2. If you have not entered a variant, select the tables in which you want to change data, for
example, if the application is the material master, you may want to select table MAKT
containing the material descriptions. Choose Execute.

3. Specify selection criteria as required to restrict the number of objects to be changed. By
choosing Choose selection fields, you can include other fields for which you can enter
selection criteria, for example, you can include the field Material description and then select
all materials containing the character string bolt. Choose Execute.

The system selects the data records. Depending on the number of records selected, you
are offered the option of continuing in dialog mode or of making the changes in the
background, in which case a workflow can inform you when they have been made. If you
remain in online mode, the system displays the selected data records.

4. Choose Select fields. In the dialog box that appears, include the fields you want to change,
and choose Enter.

5. Enter the new value in the header of the respective column, select the column label (for
example, Description), select the data records to be changed, and choose Change field
values.

You also have the following options:

− Changing a field only if it has a given current value

You do this by choosing Restrictions and entering the new value in the first line and
the value to be replaced in the second line.

− Displaying the previous values

If you have changed values, but not yet left the transaction, you can display the
previous values below the new values by choosing Old values. To display any
changes in the database (for example, changes made meanwhile to data records by
other persons), choose Refresh.

− Testing your changes

Before saving your changes, you can test whether they are possible. You do this by
choosing Test changes. This is not necessarily faster than saving your changes, as
the same checks are made.

6. Save your data.
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The system checks the changed data for consistency. Inconsistent changes are rejected
and an entry made in the log accordingly.

The system displays a log indicating whether the changes were made and any errors
that occurred. Depending on the application, you can choose Change object to access
the respective object in change mode to resolve the errors concerned.

Additional Information
Variants [Ext.]
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Assigning Sales Orders
Use
It is necessary to assign SD sales orders [Ext.] to profit centers in order to reflect sales revenues
and sales deductions. The profit center assignment is also passed on from the sales order
through the logical chain sales order → delivery note → goods issue → billing document. This
means that the when  the goods issue is posted, the goods usage which corresponds to the
revenues is also passed on to the profit center of the sales order (see Transfer from Sales and
Distribution [Page 242]).

Sales orders are divided into header data and item data. Each order item is assigned separately
to a profit center, since this is the finer level of detail.

The system proposes the profit center of the product in the sender plant as the default profit
center. Consequently, you usually do not need to enter a profit center manually. This default
supports a product-oriented and geographical division of your organization into profit centers.

If you want to divide your company into profit centers according to a sales-oriented
structure, you can define substitution rules in Customizing to determine the profit
center in another way. The system lets you use any of the following fields from the
sales order to determine the profit center for sales orders. You also need to activate
these substitutions for each individual controlling area.

Activities
To assign sales orders, choose Master data → Current settings from the application menu, then
choose Assignment: Sales Orders.

You can find a detailed description of how to assign sales orders in the Implementation Guide
(IMG) for Profit Center Accounting, under Assignments to Profit Centers.
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Substitutions for Sales Orders

Use
When you assign a sales order to a profit center, the system proposes the profit center of the
material in delivering plant as a default. This assignment allows you to structure your profit
centers according to a product-oriented or location-oriented point of view, or a combination of
these.

If you wish to structure your company from a sales-oriented point of view, you can define
substitution rules to assign sales orders to profit centers in a different way.

Note that it is generally difficult to analyze balance sheet items in profit centers if you
choose a sales-oriented division of your company into profit centers, since the
balances are difficult to assign clearly to individual profit centers.

Features
You can use the following fields from the sales order to determine the profit center:

•  business area

•  customer

•  customer group

•  customer group 1-5

•  distribution channel

•  division

•  material

•  material group

•  material group 1-5

•  material price group

•  order reason

•  plant

•  product hierarchy

•  sales district

•  sales group

•  sales office

•  sales organization

•  storage location

In cross-company business, goods are delivered and sold by two different company codes. In
such cases, you usually will not want to post the sales revenue to the profit center of the material
in the delivering plant. Consequently, it is possible to activate substitution rules for posting the
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billing document revenue to a profit center only in case of cross-company business. In this case
the substitution is based on the billing document. Note that here the field Order reason is not
available, because it does not exist in the billing document.

Activities
Define an appropriate substitution rule in Customizing for Profit Center Accounting. You can find
a complete description of this activity in the Implementation Guide (IMG) for Profit Center
Accounting, under Assignments to Profit Centers.

For a detailed description of how to create and change substitutions, see the component FI
Special Ledgers in the R/3 library, under Validierung, Substitution und Regeln [Ext.] .

Then activate the desired substitution rules for each controlling area. You can do this in the
application menu under Environment → Current settings.

You can find a complete description of this activity in the Implementation Guide (IMG) for Profit
Center Accounting, under Assignments to Profit Centers.

After you have performed the activities described above, the system replaces the default profit
center in the sales orders for which it finds a valid substitution.
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Assigning Manufacturing Orders
Use
A manufacturing order [Ext.] can be either a PP production order, a CO production order or a
process order.

When you create a production order, the system proposes the profit center from the master
record (plant segment) of the material being produced. Consequently, you usually do not have to
enter it manually. For process orders, the profit center proposed is that of the main product in the
order.

All the costs and internal cost allocations posted to the production order are passed on to the
assigned profit center, along with the credit posted when the production order is delivered or
settled.

The assignment of production orders also lets you transfer work in process for open orders to
Profit Center Accounting.

Each production order is assigned to a plant. Each plant, in turn, is assigned to a company code,
which is assigned to a controlling area. This controlling area must be the same as that to which
the profit center is assigned.

Activities
To assign manufacturing orders, choose Master data -> Current settings from the application
menu, then choose Assignment: PP Production Orders, Assignment: CO Production Orders or
Assignment: Process Orders.

You can find a detailed description of how to assign manufacturing orders in the Implementation
Guide (IMG) for Profit Center Accounting, under Assignments to Profit Centers.
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Assigning Cost Objects
Use
Cost objects are used in Product Cost Accounting (Process Costing) to collect and store costs
which cannot be assigned to objects on a lower level (orders, projects or cost centers). However,
in certain circumstances, a cost object can be assigned to a profit center.

Features
All the costs and allocations posted to the cost object are reflected on the assigned profit center.

The work in process determined can also be transferred to the relevant profit center.

Activities
To assign cost objects, choose Master data → Current settings from the application menu, then
choose Assignment: Cost Objects.

You can find a detailed description of how to assign cost objects in the Implementation Guide
(IMG) for Profit Center Accounting, under Assignments to Profit Centers.
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Assigning Projects
Use
Projects [Ext.], such as the construction of a crane, usually involve several profit centers (for the
design of the motor, for the construction of the frame, and so on). The assignment can therefore
be performed in various assignable operational structures:

•  project definition

•  WBS elements

•  network header

•  network activities

For more information about the structure of a project, see PS Project Management, in the R/3
Library.

By assigning project structures to a profit center, you can observe all costs and revenues posted
to the structures in the corresponding profit centers. These assignments also make it possible for
you to transfer work in process from projects to Profit Center Accounting.

Features
•  You can assign a profit center to the project globally in the project definition.

If no profit center has been entered here, project data is posted to the dummy profit
center.

•  You can assign each WBS element to a profit center.

If no profit center has been entered here, project data is posted to the profit center in the
project definition.

•  With header-assigned networks, the profit center to which the network header is assigned
is used.

If an activity-assigned network activity is not assigned to a profit center, the system uses
the profit center of the WBS element assigned to it.

•  With activity-assigned networks, the profit center to which the network activity is assigned
is used.

If an activity-assigned network activity is not assigned to a profit center, the system uses
the profit center of the WBS element assigned to it.

If no profit center has been entered here, project data is posted to the profit center in the
network header.

Activities
To assign projects, choose Master data → Current settings from the application menu, then
choose Assignment: Projects.

You can find a detailed description of how to assign projects in the Implementation Guide (IMG)
for Profit Center Accounting, under Assignments to Profit Centers.
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Assigning Cost Centers
Use
You need to assign cost centers [Ext.] to profit centers so that you can reflect all the primary
costs from Financial Accounting and all secondary allocations from Cost Center Accounting in
Profit Center Accounting.

The assignment of a cost center also implicitly assigns all the assets which belong to that cost
center to the profit center (see Assigning Assets [Page 95]).

If an asset is assigned to a profit center via an internal order, and this profit center is
not the same as the one to which the cost center is assigned, the profit center to
which the internal order is assigned is transferred to Profit Center Accounting.

Activities
To assign cost centers, choose Master data → Current settings from the application menu, then
choose Assignment: Cost Center.

You can find a detailed description of how to assign cost centers in the Implementation Guideline
(IMG) for Profit Center Accounting, under Assignments to Profit Centers.

Examples
The following examples demonstrate how you can assign cost centers to profit centers:

•  If you want to divide your company into profit centers geographically, you can generally
assign the cost centers of one business site to the same profit center.

•  If you want to divide your company into profit centers according to product groups, it may
occur that a single production cost center performs activities for a number of product groups.
You might want to assign these cost centers to one profit center (for example, “Production
A”). If the cost center then performs activities for a production order, the system credits the
profit center “Production A” as well as the cost center. Consequently, only the over-
/underabsorption of the assigned cost centers remains in the profit center as a balance at the
end of the period. You can then either settle this over-/underabsorption from the cost center
(for example, to a profitability segment) or allocate it directly to the corresponding product
groups in Profit Center Accounting.

•  It is often not possible to assign administration cost centers directly to a profit center. You
might, for example, assign them to a service profit center or an allocation profit center.
This profit center would then contain all the administrative costs which occur. At the end of
the period, you can then either settle this over-/underabsorption from the cost center (for
example, to a profitability segment), with assignment to a service profit center, or assess or
distribute it directly in Profit Center Accounting, with assignment to an allocation profit center.
In either case, the corresponding profit center is credited at the end of the period.

•  It might be conceivable that you would not assign auxiliary cost centers which are credited at
the end of the period to profit centers. However, in this case these costs are updated under a
dummy profit center [Page 66], which makes it more difficult to reconcile Cost Center
Accounting and Financial Accounting. It is therefore recommended that you assign each
assignment object.
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Assigning Internal Orders
Use
You need to assign internal orders [Ext.] to profit centers in order to be able to observe the flow
of overhead costs from Financial Accounting and their allocation through internal accounting from
a profit center point of view.

Internal activities capitalized during order settlement are also assigned to the profit center of the
internal order.

Furthermore, all assets which are assigned to an internal order are also implicitly posted to the
profit center of the internal order.

Activities
To assign internal orders, choose Master data → Current settings from the application menu,
then choose Assignment: Internal Orders.

You can find a detailed description of how to assign internal orders in the Implementation Guide
(IMG) for Profit Center Accounting, under Assignments to Profit Centers.
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Assigning Business Processes
Use
You need to assign your business processes [Ext.] to profit centers in order to be able to observe
the primary costs and revenues that come from Financial Accounting and see how they are
allocated within Overhead Cost Controlling.

Activities
To assign business processes, choose Master data → Current settings from the application
menu, then choose Assignment: Business Processes.

You can find a detailed description of how to assign business processes in the Implementation
Guide (IMG) for Profit Center Accounting, under Assignments to Profit Centers.
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Assigning Maintenance Orders
Use
By assigning maintenance orders [Ext.] to profit centers, you can assign the costs collected in
orders from the R/3 Maintenance component to Profit Center Accounting.

 Activities
To assign maintenance orders, choose Environment → Current settings from the application
menu, then choose Assignment: Maintenance Order.

You can find a detailed description of how to assign maintenance orders in the Implementation
Guide (IMG) for Profit Center Accounting, under Assignments to Profit Centers.
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Assigning Assets
Use
By assigning assets [Ext.] to profit centers, you can represent profits and losses due to the sale
of assets as well as accrued depreciation and interest in Profit Center Accounting.

This assignment also makes it possible to transfer asset portfolios to Profit Center Accounting.

An asset is always transferred implicitly to Profit Center Accounting via an assigned internal order
or cost center. Where the asset is assigned to both objects, it is transferred to the profit center
contained in the master data for the internal order.

Activities
To assign assets, choose Master data -> Current settings from the application menu, then
choose Assignment: Fixed Assets.

You can find a detailed description of how to assign assets in the Implementation Guide (IMG) for
Profit Center Accounting, under Assignments to Profit Centers.
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Assigning Real Estate Objects
Use
You need to assign real estate objects [Ext.] in order to be able to observe the primary costs and
revenues that come from Financial Accounting and see how they are allocated within Controlling
from a profit center viewpoint.

Features
You can assign the following real estate objects to profit centers:

•  Settlement Units

•  Buildings

•  Management contracts

•  Property

•  Rental units

•  Rental agreements

•  Business entities

Activities
To assign real estate objects, choose Master data -> Current settings from the application menu,
then choose Assignment: Real Estate Objects. You can find a detailed description of how to
assign real estate objects in the Implementation Guide (IMG) for Profit Center Accounting, under
Assignments to Profit Centers.
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Assigning Profitability Segments

Use
In contrast to other assignment objects, Profitability Segments [Ext.] do not have master records.
A profitability segment is a combination of characteristics, such as a customer, product, plant,
distribution channel, and so on. One of these characteristics is always the profit center. Like all
the other characteristics, the system supplies the profit center with a value when data is posted to
a profitability segment. The profit center can be derived automatically from the material/plant or
other characteristics. Alternatively, you can enter it manually. For more information on profitability
segments, see the section CO Profitability Analysis [Ext.] in the R/3 Library.

The data which is posted to a profitability segment is also updated in the profit center which is
specified in the profitability segment's characteristic.
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Assignment Monitor
Use
The assignment monitor provides you with an overview of all the assignments you have made for
various objects, and supports you when you make or change assignments.

You can call up an overview list of:

•  Non-assigned objects of a given object type,

•  Objects of a given type which have been assigned to a particular profit center.

Incorrect assignments lead to incorrect transaction data in Profit Center Accounting,
which usually can only be corrected with great difficulty. You should therefore check
your assignments very carefully.

Features
The menu Material also contains the option Fast assignment [Ext.], which lets you assign a large
number of materials to a profit center quickly.

For cost centers, in addition to the overviews mentioned above, you can also display profit
centers to which no cost centers have been assigned.

The menu Orders lets you analyze assignments to the following types of order: internal orders
(CO), accrual orders (CO), CO production orders, PP production orders, process orders, network
headers and maintenance orders.

The menu Cost objects contains the general cost objects as well as the cost objects for process
manufacturing.



 SAP AG Profit Center Accounting (EC-PCA)

Assignment Monitor

April 2001 99

When you display the list online, you can jump from there directly to the transaction for changing
the object. In this way you can make any missing assignments or correct any incorrect ones.

Activities
To view the assignment monitor, choose Master Data -> Assignment Monitor from the application
menu. It can also be maintained in Customizing, under Assignments to Profit Centers.
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Multiple Valuation Approaches/Transfer Prices
Use
Transfer prices let organizations that divide tasks among different organizational units to valuate
the goods and services exchanged between these units.

Particularly large corporations are often divided into a number of independently operating
divisions or companies that exchange large quantities of goods and services with one another.
Transfer prices are becoming an increasingly critical method for controlling corporate units as the
division of labor between internationally operating units increases, value-added chains become
more complex and responsibilities become more decentralized.

By valuating the exchange of goods and services using transfer prices, you can significantly
influence the actual success of your corporate divisions or profit centers. Especially in this
context, today’s accounting systems need to be able to provide decision support that represents
operational results from different points of views and using different currencies.

The following example shows how this looks in reality.

Company A sells a product to Company B, thereby realizing a profit that must be
shown in its balance sheet (corporate and tax balance sheets). Because Company A
and Company B both belong to the same group, this sale is merely as an internal
stock transfer when looked at from the point of view of the group. Thus no group
(internal) profits can be realized as a result of this transfer. Such internal profits can
also arise when the exchange is between two profit centers instead of two
independent companies of the group.

The view of the individual company and the valuation according to legal reporting requirements
only represents one of several possible perspectives on the economic reality. Balance sheet and
tax considerations play an important role in the financial statements of the individual companies.
In addition to this legal view, though, a successful corporate and group management needs other
information that shows business activities from the point of view of the whole group or of
individual profit centers.

Corporate controlling for the entire group requires you to valuate these business transactions
using a cost of goods manufactured that is valid on a group-wide basis. Moreover, in many
groups the management structures do not always correspond to the legally independent
accounting units. Internal prices guide the individual profit centers according to market principles.
Consequently, the value flows need to be represented from the point of view of profit centers for
the purpose of internal profitability management.

In short, controlling and information systems are required that let you valuate and analyze these
business activities from all three different perspectives.

Integration
For transfer prices to be consistent, you need to use them throughout your entire system. For
more information, see Multiple Value Flows in Financials [Page 107].
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Features
For more detailed information on the use of multiple valuation approaches, see the following
sections:

Managerial Aims of Transfer Pricing [Page 102]

Multiple Value Flows in Financials [Page 107]

Multiple Valuation Approaches in Individual Applications [Page 114]

Implementing Transfer Pricing in a Live System [Page 158]
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Managerial Aims of Transfer Pricing
Transfer prices may be used to achieve entirely independent aims depending on the various
views needed for your organization. For example, the central controlling department of the group
might have aims and information requirements that differ completely from those of the controlling
departments for the individual divisions or companies.

These aims may sometimes even conflict with one another:

•  Transfer prices are often used to represent profits optimally in annual reports for tax or other
external reporting reasons.

•  The managers of individual divisions (or profit centers) are interested in determining profits
and profit margins of their own areas of responsibility and coordinating their activities
accordingly.

•  Strategic decisions for the whole group are often made based on the assumption that the
group acts as a single company. Since the transfers between member companies include
internal profits, these need to be eliminated in order to provide a sound basis for decisions for
the group as a whole and valuate business transactions using corporate-wide costs of goods
manufactured.
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Need for Parallel Valuation Methods
The different views discussed in the section Managerial Aims of Transfer Pricing [Page 102]
often require the use of different methods of valuation that reflect that various goals. Business
results as well as material inventories need to be shown using these different methods in order to
meet the various information requirements. The various views required must:

•  represent transfers of goods and services between independent companies according to the
legal reporting requirements (legal view)

•  valuate the exchanged goods and services within the group using corporate-wide costs of
goods manufactured with internal profits between member companies being eliminated
(corporate view)

•  valuate exchanges of goods and services between profit centers using internal prices in
order to determine the profitability of those profit centers and manage them accordingly
(profit center view)

Many corporations that require all these different valuation methods are therefore faced with the
dilemma of storing these in parallel or creating them at period-end by means of value
adjustments.

When a member company manufactures a product, it typically has to purchase raw materials
from “third parties”, or companies outside the group, during different stages of the manufacturing
process, and processed or resold in different responsibility areas (legal units or profit centers).
During this process different values may arise in the different views.

This example makes it clear that the only way to be ensured of reliable controlling information is
to represent the quantity flows involved in the logistic process using multiple value flows. One of
the most basic features of transfer pricing in the R/3 System lets you valuate your quantities
using different methods in parallel and thus analyze multiple value flows in the accounting
components.

If you were to only valuate the quantities in this example with one value, you would need to apply
blanket valuation methods to your quantities at period end to achieve the information necessary
for controlling at the corporate level. This procedure, however, would be linked with a great
potential for inaccuracy and considerable effort.
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Transfer Pricing Concepts
A transfer price is a price used to valuate the transfer of a good or service between
independently operating units of a corporate group. In Release 4.0A, you can use transfer prices
to valuate goods movements. Activities cannot be valuated with transfer prices at this point.

The R/3 System supports three types of transfer prices to represent the three primary views of
goods movements within a corporate group.

In the legal view, transfer prices represent the value (sales price) of goods or services
transferred between legally independent member companies in the group. These values are
reflected in the individual financial statements of these companies.

In the corporate view, the goods and services are valuated using the corporate cost of goods
manufactured. For these prices, internal profits are eliminated from the prices of the legal view.

In the profit center view, transfer prices are the prices negotiated for goods and services
exchanged between areas of responsibility (profit centers) and used to determine their internal
profitability.
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The above graphic shows the three different views:

1. Group view, in which business transactions within the group are represented using
group-wide cost rates

2. Profit center view, in which business transactions between profit centers are valuated using
managerial or controlling rates

3. Legal view, in which business transactions between affiliated companies are valuated using
external sales prices

The following concepts are also of importance for an understanding of transfer pricing in the R/3
System:

The three different views of business transactions - those of the individual company, the group as
a whole and the profit center - are referred to as valuation views.
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The R/3 System, each valuation view always uses its own currency type. the combination of
currency type and valuation view is referred to as the valuation approach (see also Consistency
of the Valuation Settings in Different Applications: Currency and Valuation Profile [Page 108]).

In a currency and valuation profile, you can specify up to three valuation approaches that you
want to store in parallel in your system. This ensures that these approaches are updated
consistently throughout all the affected application components (see also Consistency of the
Valuation Settings in Different Applications: Currency and Valuation Profile [Page 108]).

Except in Profit Center Accounting, transfer prices from the legal view must be stored in all
application components. Storing up to two additional valuation approaches for material
inventories and goods movements in parallel is referred to as parallel valuation.
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Organizational Units Affected by Transfer Pricing
In order to use transfer prices in the R/3 System, you need to store multiple valuation approaches
in parallel throughout the accounting application components. Consequently, the following
organizational units play an important role:

In Release 4.0, the controlling area represents a corporation or corporate group in which transfer
prices can be used.

In Profit Center Accounting, this group is divided into areas of responsibility that act as
independent units and have responsibility for their own profits.

If you employ cross-company accounting, the company codes represent the individual
companies, which you need to assign to your controlling area.

In each company code, material inventories are stored according to plant. Parallel valuation
takes place at this plant level.
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Multiple Value Flows in Financials
Use
The use of multiple valuation methods in the SAP R/3 System is based on the same principle by
which multiple currencies were used in Financials in Release 3.0. The meaning of the currency
fields has merely been extended to include the dimension “Valuation method”, so that the content
of these fields can be interpreted as valuation approaches (combination of currency and
valuation method) in Release 4.0 (see also Consistency of the Valuation Settings in Different
Applications: Currency and Valuation Profile [Page 108]). Consequently, the use of multiple
valuation approaches does not significantly influence the account determination or posting logic
in Financials (see also Posting Logic and Account Determination [Page 130]).

Integration
The material ledger forms the basis for storing multiple valuation approaches for material
inventories. The material ledger can be seen as a material subledger that stores material stocks
according to different valuation approaches according to the legal, group and profit center
viewpoints.

These valuation approaches are applied and integrated throughout the system for all business
processes that are relevant for valuation. That means that multiple values are stored in realtime
from material costing to the procurement processes and on to the production processes.

For the Financial Accounting and Controlling application components, using transfer prices
makes it possible to work with multiple valuation approaches in the documents in all areas of
accounting.

For information on how the individual applications store these multiple approaches, see Multiple
Valuations in Individual Applications [Page 114].
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Consistency of the Valuation Settings in Different
Applications: Currency and Valuation Profile
Definition
The currency and valuation profile determines which valuation views can be stored in which
currencies.

The combination of currency and valuation view -- for example, group currency and profit center
view -- is referred to as a valuation approach or valuation method.

See also Transfer Pricing Concepts [Page 104].

Use
You need to assign the currency and valuation profile to a controlling area and then activate the
profile. This ensures that the data is updated consistently in all the affected applications. The
system checks whether the valuation approaches in Controlling, the material ledger, and
Financial Accounting as well as the settings for the company codes, depreciation areas, and
plants are consistent with the profile.

Structure
Release 3.0 already allowed you to store multiple currencies in the financials applications. In
Release 4.0, the “currency type” has been extended to include the dimension “valuation view”.

The currency and valuation profile consists of a combination of currency type and valuation view.
You can store up to three valuation views in up to two currencies throughout your system. (If you
use three views, two of these must use the same currency.) The combination of valuation view 0
(legal) and currency type 10 (company code currency) is automatically contained in each profile
in order to fulfil legal requirements.

Example: Currency and valuation profile
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Release 4.0 supports a limited number of possible combinations. To see which
valuation approaches you can use, see Customizing.

You define your currency and valuation profiles in Customizing under Controlling → Controlling
General → Multiple Valuation Methods/Transfer Prices → Basic settings → Maintain currency
and valuation profile.
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Integration
Once you have created the profile, you need to specify which valuation approaches (which
currencies and valuation methods) you want to store in your system. You do this by assigning the
profile to your controlling area and then activating it.

You can deactivate the currency and valuation profile again, provided that no data has yet been
posted to the affected applications. As soon as there is transaction data in one of the affected
applications, it is no longer possible to take back the settings made for the currency and valuation
profile. For further information on deactivating parallel valuation approaches/transfer prices, see
Customizing, under General Controlling.

You assign the currency and valuation profile in Customizing under Controlling → Controlling
General → Multiple Valuation Methods/Transfer Prices → Basic settings → Assign profile to
controlling area. You activate the profile under Controlling → Controlling General → Multiple
Valuation Methods/Transfer Prices → Activation → Activate multiple valuation approaches. When
you do that, the system checks that all the settings in the controlling area are consistent.

To read about how to activate the valuation settings in the individual applications, see
Representing Multiple Valuation Approaches in Individual Applications [Page 114].

If you try to change a setting later that would affect valuation, the system asks you to first
deactivate the currency and valuation profile. After you have made the change, you need to
activate the profile again, thereby triggering the consistency check.
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Scenarios for Using Transfer Prices
Use
Since different organizations have very different aims in using transfer prices, there are a number
of practical scenarios for how to use them.

Release 4.0 supports a limited number of scenarios that you can use to reach the aims described
here. Typical scenarios include:

•  Scenario 1
Here, group costs of goods manufactured are the main focus. Consequently, the legal and group
valuation methods are the most important, as is shown in the following graphic:
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•  Scenario 2
The structure of the legal accounting units does not correspond to that of the
management structures. Separate areas of responsibility are therefore set up, and goods
movements between these are valuated with independently determined valuation
approaches. You therefore have valuation approaches in the profit center and legal
valuation view, as is shown in the following graphic:
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Integration
If desired, you can store the legal, group, and profit center valuation views in the material ledger.

This decision forms the foundation for how you shape your value flows in Financials. For
example, if you store all three valuation approaches as in the example, the applications that
supply this data (essentially the Controlling component) also need to store these approaches.

In Profit Center Accounting, you can store any one of these valuation approaches, so that you
can analyze the operating results of your profit centers according to the legal, group, or profit
center valuation view.

In Financial Accounting, you must valuate all postings according to the legal approach. In
addition, you have the option of storing either or both of the other two approaches.

In Controlling, you need to decide which approach should represent your main controlling
philosophy. In addition, you have the option of storing either or both of the other two approaches
in separate actual versions.
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Uses and Restrictions
If you intend to use Transfer Pricing, be sure to observe the following conditions and limitations:

Global Limitations

•  Transfer prices are limited to goods movements. It is not currently possible to valuate
activities using multiple valuation approaches.

Limitations in Cost Object Controlling

•  At this point you can only perform group costing within one controlling area.

•  Multiple valuation approaches cannot be used for the purposes of make-to-order production
for unvaluated customer sales order stock.

•  To calculating WIP correctly using target costs, the operative version must use legal
valuation approaches.

Limitations in Purchasing and Material Management

•  Multiple values can only be transferred during invoice verification in Logistics.

•  Multiple values can only be transferred between systems using the ALE or EDI interfaces.
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Multiple Valuations in Individual Applications
Transfer prices affect a number of applications in Materials Management, Financial Accounting,
Controlling and Profit Center Accounting. If you intend to implement transfer pricing, the following
sections provide you with an overview of the applications involved and tell you where you can
find more detailed information on each area.

See also:
Multiple Value Flows in Controlling [Page 115]

Multiple Values for Material Stocks Using the Material Ledger [Page 120]

Transfer Prices in Profit Center Accounting [Page 121]

Multiple Valuation Approaches in Overhead Cost Controlling [Page 141]

Transfer Prices in Cost Object Controlling [Page 143]

Transfer Prices in the Reconciliation Ledger [Page 147]

Multiple Valuations in Product Cost Controlling [Page 148]

Multiple Valuation Approaches/Transfer Prices in Profitability Analysis [Page 149]

Update of Multiple Values in Financial Accounting [Page 151]

Multiple Values in Asset Accounting [Page 153]

Valuations in Procurement and Sales [Page 154]
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Multiple Value Flows in Controlling
Effects of Transfer Prices on Cost Element Accounting in CO
One basic principle of the Controlling applications in the R/3 System is that all the quantity flows
in the Logistics applications are reflected in realtime as value flows in financials. In Release 3.0,
these value flows corresponded to valuation from the legal view of a group company.

If you use transfer prices based on group or profit center valuation, you need to store parallel
sets of data according to multiple valuation approaches in Cost Element Accounting. Cost
Element Accounting provides the infrastructure necessary to represent these multiple value flows
by allowing you to store multiple actual versions in parallel.

This means that, for example, when you use a material for a production order, separate goods
usage postings are stored in parallel according to the different valuations.

Of the actual versions that you define in Controlling, you must specify one of these as the
operational version. This version reflects your organization’s basic managerial accounting
philosophy as the primary valuation method, and must be defined in the system as version 000.
In addition to this version, you can also define other actual versions to reflect the other two
valuation methods. For more information, see Assigning Valuation Approaches to CO Versions
[Page 118].

The legal valuation method must be represented in CO by at least one of the actual versions in
your system. You can then also define up to two other versions by specifying these in the
currency and valuation profile.

For more information about using multiple valuation approaches in Cost Element Accounting,
see:

Transfer Prices in the Reconciliation Ledger [Page 147]

Multiple Value Flows in Overhead Cost Controlling
Overhead Cost Controlling also stores multiple valuation approaches according to the settings
made for Cost Element Accounting.

This means that you can post materials usage to cost centers using different valuation
approaches.

It is currently not possible to use transfer prices and multiple valuations for activities.
Consequently, activities are only valuated using the operational valuation in CO. This means that
you can only calculate planned activity prices and planned overhead in the operational valuation
view. It also means that plan/actual comparisons and variance analyses can only be carried out
in that version.

You can calculate up to three actual prices in parallel. Thus valuation can be carried out in all
three valuation approaches. If you do not use actual price determination, the system uses the
plan price to valuate actual data. Do not see the multiple actual prices as transfer prices for
activities. Actual price determination only takes into account the different primary costs that arise
as a result of transfer pricing for goods movements.

Multiple valuation approaches are supported for all secondary allocations, thus ensuring that the
value flows are complete.

For more information about using multiple valuation approaches in Overhead Cost Controlling,
see:
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Multiple Valuation Approaches in Overhead Cost Controlling [Page 141]

Multiple Valuation Approaches in Cost Object Controlling
Cost Object Controlling has the task of making multiple valuation approaches available for the
settlement production variances to Financial Accounting and the material ledger. This applies to
those cost objects that are settled to material stock -- production orders, process orders and run
schedule headers.

The controlling functions in Cost Object Controlling, such as variance calculation, are still limited
to one valuation approach. This applies to the calculation of overhead, variances, and variance
categories. Only goods movements are posted using multiple valuation approaches.
Consequently, the actual costs for a single valuation approach are always taken from the
material costs in that view plus the activities and overhead costs from the operative version.

Before you can settle your costs for the three valuation views, you need to calculate work in
process for each approach. For this purpose the valuation approach stored in the currency and
valuation profile needs to be copied to the results analysis version. This makes it possible to use
multiple valuation approaches for posting the work in process to FI and for settling the production
variances. The production variances in this case are the difference between the actual costs,
inward stock movements and work in process using each valuation approach.

For more information about using multiple valuation approaches in Cost Object Controlling, see:

Work in Process in Periodic Product Controlling [Ext.]

Work in Process in Order-Related Product Controlling [Ext.]

Results Analysis [Ext.]

Sales Order Controlling [Ext.]

Transfer Prices in Cost Object Controlling [Page 143]

Transfer Prices in Profitability Analysis
The Profitability Analysis (CO-PA) application component represents all external sales with
customers outside the group and other companies within the group. These external sales could
be analyzed from the point of view of internal organizational units in reporting using the
characteristic “profit center”.

By using transfer prices in Profitability Analysis, you can analyze all internal goods movements
within profit centers in addition to the external sales, and valuate these using transfer prices
according to the cost-of-sales method.

For more details on transfer prices in CO-PA, see Multiple Valuation Approaches/Transfer Prices
in CO-PA [Page 149]

Integration
See Consistency of the Valuation Settings in Different Applications: Currency and Valuation
Profile [Page 108].
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Assigning Valuation Approaches to CO Versions
When you activate parallel valuation approaches/transfer pricing, you need to define which
valuation approach (valuation view and currency) you want to use for your operational CO
version (version 000). (See also Multiple Value Flows in Controlling [Page 115].) Some functions
in CO are only available for the operational version or react according to the settings in the
operational version. This means that when you define your operational version, you are
determining which valuation approach reflects your overall controlling approach.

The following restrictions apply for the different CO application components:

Overhead Cost Controlling (CO-OM)
•  Planning

You can only plan in the operational version. The other actual versions cannot be used
for planning. However, you can define and plan in additional plan versions, provided that
these also use the same valuation view as your operational plan version.

•  Assessment/distribution/periodic repostings

Cycles for assessment, distribution, and periodic repostings apply to all valuation
approaches. It is not possible to allocate values in version 000 and in the additional
actual versions using different tracing factors.

•  Repostings

Repostings can only be valuated with the operational valuation approach. Because the
other valuation approaches are stored in "delta versions" which contain only the
differences to the operational valuation, the same value is automatically updated in all
actual versions.

If a material usage posting is made to the wrong cost center, you can update the correct
debit in each valuation approach by making a line item reposting.

•  Settlement

It is not possible to define different settlement rules for the different valuation
approaches.

Profitability Analysis (CO-PA)
•  Assessment to CO-PA

Only data in the operational version is assessed to Profitability Analysis.

•  Settlement of orders and WBS elements

When you settle orders and WBS elements to CO-PA, only the legal and profit center
valuations are settled. Values from the group viewpoint remain as costs for the order.

Product Cost Controlling (CO-PC)
•  Overhead

Overhead calculation is only carried out for the operational version. Because the other
actual versions are "delta versions" which contain only the differences to the operational
valuation, the overhead applied in the operational version is automatically "posted" for
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the other versions as well, even if the tracing factors that would be found for those
versions yield a different amount.

•  Variances

Variances for production orders are automatically created for each valuation approach
and posted to the price difference account when the material is delivered to stock.

Variance calculation, which divides the variances according to category, only works in
the operational version. You should take this into account if you are using Profitability
Analysis (CO-PA) and want to settle variances to profitability segments. It is possible to
transfer the variances to CO-PA in a lump sum in the other actual versions. However,
data in those versions cannot be divided into variance categories.

•  WIP at target costs

WIP at target costs can only be calculated on the basis of the operational version.

•  Results analysis in general

Results analysis is normally carried out based on plan data. However, because you can
only plan in the operational valuation view, results analysis in the other valuation views
may yield nonsense results, since the plan would look different in the other valuation
views.

In addition, note that you cannot set different results analysis methods for different
valuation approaches. This point is particularly important if you are using transfer prices.

Project System (PS)
•  Project interest calculation

Project interest calculation does not support multiple valuation approaches. Interest is
only calculated in the operational version.

Investment Management (IM)
•  Availability check

The availability check in budgeting only checks the operational version.

•  Capitalization values per valuation area

The settings for the capitalization percentage rates can only be carried out by valuation
area, and not using multiple valuation approaches. Consequently, it is not possible to
capitalize the group valuation differently from the legal or profit center valuation.
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Parallel Valuation Approaches for Material Stocks Using
the Material Ledger
Use
As a subsidiary ledger for materials, the material ledger is of fundamental significance for storing
multiple valuation methods for material stocks.

In the material ledger, you define a combination of the dimensions currency and valuation,
which is referred to as the valuation approach. You can store up to three valuation approaches
in the material ledger. These are stored throughout the system according to the settings you
made in the currency and valuation profile. For details on the consistency of the settings for
valuation and currencies, see Consistency of the Valuation Settings in Different Applications:
Currency and Valuation Profile [Page 108].

This means, for example, that you can use material costing to calculate three standard prices for
your material stocks -- one from the legal view, plus additional standard prices from the group
view and the profit center view.

These multiple valuation approaches are then available for all business transactions involving
stock valuation (goods receipt, goods issue, stock transfers) and procurement, which means that
stock values are constantly being updated. As with products that are procured externally, multiple
valuation approaches for products produced internal need to be used in cost object controlling.

Previously, you could only use the various valuation approaches to store warehouse stock. You
can now also use these valuation approaches to store the valuated sales order stock and the
project stock.

For more information about using multiple valuation approaches in the material ledger, see:

Actual Costing/Material Ledger [Ext.]

Collecting Actual Data for the Material Ledger [Ext.]

Parallel Currencies and Valuations for Materials [Ext.]

Integration
The section Parallel Valuation Approaches in Individual Applications [Page 114] contains
information about how transfer prices are realized in the other applications of the R/3 System.
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Transfer Prices in Profit Center Accounting
Use
Profit centers are responsible for their own costs and revenues and are treated as “independent
units” within the legally independent company. They are judged by their profit or loss, just like
independent companies.

Transfer prices have a coordination function on the “internal market” within the corporation. The
transfer prices make employees into entrepreneurs, who enter into supplier-customer
relationships with other units within the organization. Internal allocations using transfer prices lets
you distribute the whole organization’s profits to the proper link in the value-added chain.

It is therefore necessary to detach the management-oriented corporate control from the legal
structure of the organization.

Integration
See Parallel Valuations in Individual Applications [Page 114].

Prerequisites
To store transfer prices in the profit center view, profit center valuation must be active in a
valuation approach of a currency and valuation profile.

Features
For more information about using transfer prices in Profit Center Accounting, see:

Valuation Views in Profit Center Accounting [Page 122]

Determining Transfer Prices [Page 123]

Transfer Pricing Using the Conditions Technique [Page 127]

Posting Logic and Account Determination [Page 130]

For more information on planning using transfer prices, see: Quantity-Based Profit Planning
[Page 217]
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Valuation Views in Profit Center Accounting
Use
Up to and including Release 3.1, the data in Profit Center Accounting was valuated from the point
of view of the legally independent units (company codes). In Release 4.0, you can use transfer
prices to valuate material inventories and goods movements from the group view and from the
point of view of profit centers.

Decision Which Valuation Method to Use
In Profit Center Accounting, you can choose one of these three views for each controlling area.
You do this in Customizing for Profit Center Accounting.

Legal view
As in Release 3.1, you can valuate business transactions in Profit Center Accounting using the
same method as that used for the individual financial statements of the companies in the group.

Group view
Many groups valuate exchanges of goods between affiliated companies using a group cost of
goods manufactured, i.e. without internal profits. The receiver profit center receives a
semifinished product at cost. In this approach, profit centers only earn profits with nonaffiliated
companies and not for internal transactions.

Profit center view
If you use your profit centers to monitor their internal profits, you need to activate transfer pricing
for exchanges between profit centers. These transfer prices are automatically selected for goods
movements (stock transfers, goods usage) between profit centers and shown as “internal
revenue” and “internal costs” in Profit Center Accounting. Thus a goods withdrawal for a
production order is shown as a sale in Profit Center Accounting, whereas the same transaction is
a consumption posting when seen from the point of view of the company code.
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Determining Transfer Prices
Use
If your organize decides to use transfer prices from the profit center viewpoint, you can calculate
special managerial prices for all goods movements between profit centers.

This transfer price is a negotiated price between profit centers. It may be oriented on the market
price, or it may be determined as a markup on the cost of goods manufactured as seen from the
group view or legal view. These markups can depend on a number of factors, such as the profit
centers involved, the product, plant, date, and so on.

But it would most likely be too much work to store a transfer price for each individual material. To
save time, you can group materials under one representative material, and only maintain the transfer
price for this material. This technique makes it possible to maintain transfer prices on the basis of an
ABC analysis, assigning the A parts an explicit market price or markup and allocating all C parts
using across-the-board markups at product group level.

Features
You define transfer prices for Profit Center Accounting using the pricing function from the Sales
and Distribution (SD) application component.

You can use the following pricing strategies:

•  Cost-plus method

Costs plus a markup or markdown (quantity-dependent, percentage or fixed amount)

•  Fixed values

Market price or profit center price in the material ledger

•  Receiver-specific price

Different prices for different partner profit centers

•  Time-related price

Prices with a limited period of validity, such as for seasonal price changes

You can make the price dependent on any of the following factors:

•  material

•  material type

•  valuation type

•  material group

•  plant

•  division

•  representative material

•  ABC indicator

•  controlling area
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•  the sender profit center

•  the receiver profit center

•  the period and the fiscal year

•  WBS element (required with valuated inventory)

•  sales order/sales order item (required with valuated inventory)

Material 1 is produced in two plants. In plant 1, material 1 belongs to profit center 1.
In plant 2 it belongs to profit center 2.
In the material ledger, the profit center inventory value for material 1 is USD 7.00.

Material 2 is produced in plant 2 and belongs to profit center 3.
In the material ledger, the profit center inventory value for material 2 is USD 30.00.

The manufacturer decides to use different transfer prices depending on the material,
profit center and plant.

•  When material 1 is delivered from plant 1, the profit center inventory value
should be taken from the material ledger.

Profit center 1 (in plant 1) supplies material 1 to profit center 4.

– Profit center price in the material ledger = USD 7.00

•  When material 1 is delivered from plant 2, a markup of 10% is to be added to
this price.

Profit center 2 (in plant 2) supplies material 1 to profit center 4.

– Profit center price in the material ledger * 10% = USD 7.70

•  When material 2 is delivered, a fixed price should be used regardless of the
profit center inventory value in the material ledger.

Profit center 3 supplies material 2 to profit center 4.

– Fixed price = USD 35.00

See also:
Transfer Pricing Using the Conditions Technique [Page 127]

Example of How a Transfer Price is Determined [Page 125]
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Example of How a Transfer Price is Determined
The following example shows how the system uses conditions to find the right transfer price and
how the different elements of a pricing procedure interact.

1

2

3

4

5

6

Transfer price variant
00 Actual variant
01 Plan variant
Pricing procedure           Rf.
TP0001       Fixed            1
TP0002       Percentage  2  

Pricing procedure TP0001
                                           from
Step   Cond. type               step
   10    KA01  Fixed
   20    KA02  Basis
   30    KA03  Percentage      20  

Condition type

CType Cond. class   Calc. type
KA01   Prices            Fixed amount
Access sequence ZG01

Access sequence ZG01

No.  Table
• 501    Plant/PrCtr/Mat.
20    502    PrCtr/Material

Condition records for
Condition type KA01

Table 501 No valid records
Table 502 PrCtr1 / Material 1

Fixed price
USD 100

Controlling
area
0001

Material withdrawal
for production order
Material 1 x 10 units
(Profit center 1)

Material 1         = USD 100
10 x Material 1 = USD 1000

Material 1 belongs to profit center 1, is a semifinished product, and is manufactured in plant
0001. The final product is put together in plant 0001 as well. A production order is created for
material 1, which is used for the production of the final product. The production order is assigned
to profit center 2.

1. Based on the movement type in the production order, the system determines that an actual
goods movement should take place. For actual data, variant 000 is always used for transfer
prices.

2. The system reads transfer price variant 000 and finds that it should use pricing procedure
TP0001.
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3. The pricing procedure contains the valid condition types for pricing and the order in which
they are calculated. The system takes the first condition type in the pricing procedure, KA01,
and searches for a valid condition record.

4. Each condition type in the pricing procedure can be assigned an access sequence. In this
case, the condition type uses the access sequence ZG01.

5. The system reads the condition tables specified in the access sequence until it finds a valid
condition record.

The first table, which requires a combination of plant, profit center, and material, does not
yield a valid condition record. So the system reads the next table, which requires a
combination of profit center and material, and finds a valid record.

6. The system determines the transfer price based on the information in the condition record. In
this case, it finds a fixed price of USD 100.00 for material 1 when it is delivered from profit
center 1 to profit center 2. This price is the price used when material 1 is delivered to profit
center 2.
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Transfer Pricing Using the Conditions Technique

The term “transfer pricing” is used to describe the calculation of prices for internal exchanges of
goods between profit centers. Conditions are the individual steps carried out during price
calculation. When a goods movement takes place between two plants, the price can depend on a
number of factors, such as the material involved, the sender plant, the profit center, the partner
profit center, and so on. The information on these variable factors is stored as master data in the
form of condition records. There the transfer price can be defined as a fixed price or a
percentage increase or reduction.

This section describes the steps necessary to define transfer prices. You define these transfer
prices in Customizing. There you will also find a detailed description of how to proceed.

1. Define condition tables, which you use to store condition records for each condition type.

Here you define the price dependencies for transfer prices. You can make the transfer
price found dependent upon a combination of fields. For example, if you want your
transfer prices to be defined for a combination of material and partner profit center, you
need to define a condition table that contains these key fields. The condition records then
contain the individual prices for each combination of material and profit center. You
maintain the condition records when you define the individual condition types.

2. Define access sequences that the system should use to search for valid condition records.

An access sequence is a search strategy that the system uses to find valid data for
certain condition tables. Each access sequence consists of one or more steps, which the
system processes in the order specified. The order determines where the system should
look first for a valid condition record. You can specify an access sequence for any
condition type for which you create condition records.

3. Define condition types for all the pricing elements (fixed amounts, markups and
markdowns) that occur in your daily business operations.

In Profit Center Accounting, a condition type represents a component of a transfer price.
You can define condition types for every type of fixed price, markup or markdown that
occurs in your internal goods movements. If you define a percentage markup or
markdown as a condition type, you also need to define another condition type to serve as
the basis for this percentage. This can be a price stored in the material ledger. The
relationship between these two condition types is then defined in the pricing procedure.

In some condition types you need to specify an access sequence. In this way you
determine which fields the system should use to search for a valid condition record.

4. Define condition records that determine the amount or percentage to be applied for each
set of values in the condition table (such as "fixed price of USD 100.00 for material 01, profit
center ABC, and plant 0001").

You can maintain condition records directly from within the definition of the condition
type. Or you can define them from the application menu by choosing Master data →
Transfer prices → Conditions. It is also possible to copy existing condition records to
create new ones. This is especially useful if you want to change the currency of the
condition record. You can maintain condition records either in Customizing or in the
application menu, under Master data → Transfer prices.
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5. Define a pricing procedure to group together condition types and determine how they relate
to one another.

In addition to the selection and order of condition types, a pricing procedure determines

– which subtotals should be calculated

– what base value the system should use for calculating percentage markups or
markdowns

– what conditions must be met in order for a certain condition type to be calculated

The base value for markups and markdowns can be either a fixed price or a value from
the material ledger. Using a routine supplied in the standard R/3 System, you can have
the system read the legal, group, or profit center price from the material ledger and
calculate the markup or markdown on this basis.

6. Define condition exclusions, which let you determine which condition type should be used
in a given situation.

In transfer pricing for goods movements, it often happens that a number of different
condition records are valid. Using condition exclusions, you can compare conditions with
one another and use, for example, the most favorable price for the partner profit center.

For different condition exclusion methods are available:

• The most favorable condition in an exclusion group

• The most favorable condition record for a condition type

• The most favorable condition among different exclusion groups

• Exclusion of those conditions in an exclusion group when a condition type that belongs to
another exclusion group appears

7. Define transfer price variants, which let you specify which pricing procedures are relevant
for actual data and which for plan data.

To valuate different datasets, such as plan and actual data, using different conditions,
you can define variants with an assignment to a specific pricing procedure. The system
processes the specified procedures in order until it finds a valid transfer price.

In transfer pricing for goods movements, only actual data is valuated (variant 000).
However, you can also create additional variants if you want to calculate plan prices on
the basis of pricing data.

8. Define pricing reports, which determine the structure of lists of conditions.

A pricing report lets you analyze condition records according to certain criteria and define
the structure of these lists. You can define pricing reports either in Customizing for Profit
Center Accounting or in the application menu, under Master data → Transfer prices →
Pricing reports.

You make out all the settings described here in Customizing for Profit Center Accounting, in the
activities under the section 'Transfer Prices'. See the following:

Basic Settings for Pricing [Ext.]

Advanced Settings for Pricing [Ext.]
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Posting Logic and Account Determination
Use
Additional posting lines
When goods movements between profit centers occur, the sale on the part of the sender profit
center and the goods receipt on the part of the receiver profit center both need to be depicted in
order for the profit centers to be treated as independent companies. As with internal goods
movements without transfer prices, this view requires additional posting lines.

you need to define three additional profit and loss accounts in Financial Accounting (FI) to
represent internal revenues and costs:

•  Internal revenues

•  Internal changes in stock

•  Deliveries from other profit centers

If you are using either the group or profit center valuation method in Profit Center Accounting,
you can transfer the additional posting lines and values created by this to FI.

In addition, you may also need to create two further types of profit and loss accounts:

Valuation Clearing Account
If you store profit-center-oriented values in FI, you need to define a so-called “valuation approach
transfer account” to post the valuation differences that arise for business transactions between
affiliated companies. When you use transfer prices, payables and receivables in FI are only
posted using the legal valuation method, since the corresponding payments are made in this
amount. However, if other valuation methods are stored for the offsetting account, you need to
post the difference so that it appears in the group report.

Production Variances in Exchanges Between Profit Centers
The second account type is required if you use more than one plant in the production process
and the actual cost of goods manufactured differs from the planned cost of goods manufactured.
This requires an additional account for the production variances so that you can settle the
difference to the sender profit center. Without this account, the production variances would be
settled to the receiver profit center. since a transfer price is posted for the transfer, this would
cause the receiver profit center to be debited twice.

Profit center 1 produces material A in plant 1. A transfer price of USD 150 has been
negotiated for material A when it is sold to profit center 2 in plant 2. The planned cost
of goods manufactured is USD 100, but the actual cost of goods manufactured turns
out to be USD 110. The difference -- USD 10 -- is posted to the account “Production
variances” and settled to profit center 1.

For detailed information on account determination, see Customizing.
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Example of Posting Logic
The following example shows the posting logic for two goods movements using transfer prices in
Profit Center Accounting:

Example for a Withdrawal of a Semifinished Product [Page 133]

In this example, the business transaction is shown in the lowest bar. The “Value flow” area shows
how the document lines appear in Financial Accounting (FI), Controlling (CO) and in Profit Center
Accounting (EC-PCA).

Use the following key to understand the postings:

L = Legal valuation view

G = Group valuation view

P = Profit center valuation view

EC-EC-
PCAPCA

FIFI CO-CO-
OMOM

CO-CO-
PCPC

Account
L
G
P

100.00
(80.00)

(150.00)

Posting lines in
Profit Center
Accounting

Int. change in stock
P 120.00

Update
in 
CO

Postings in FI
L  = Legal
G = Group
P = Profit center

Business
process +

data
Processes +

data

V
A
L
U
E

F
L
O
W



Profit Center Accounting (EC-PCA)  SAP AG

Posting Logic and Account Determination

132 April 2001

Integration
If you are using valuation from the profit center viewpoint in FI, the additional posting lines are
updated there as well.
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Example of Withdrawal of a Semifinished Product
This section shows the posting logic for a withdrawal of a semifinished product on the basis
of a production order within one company code.

Assumptions
In Financial Accounting (FI), only the legal and group valuation views are used. In Controlling
(CO), all three views are used for the purpose of reconciliation. In Profit Center Accounting,
transfer prices are shown using the profit center valuation view.

The inventory value in the material ledger is:

•  100 USD in the legal valuation view

•  80 USD in the group valuation view

•  120 USD in the profit center valuation view

Semifinished good 1 is assigned to profit center 1. Production order 2 is assigned to profit center
2. The transfer price for the “sale” of the semifinished good between profit centers is 150 USD.
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V
A
L
U
E

F
L
O
W

P

P

L
G
P

P

CO-CO-
OMOM

CO-CO-
PCPC

F IF I

L
G

PrCtr 1 Price => 150.00 USD PrCtr 2

EC-
PCA
EC-
PCA

Int. Change
in stock

Stock

Internal
revenue

(optimal)
Deliv. from
other PrCtr

Int. change
in stock

Change
in stock

P 120.00

120.00

150.00
P 150.00

150.00

P 150.00

Change in stock
L 100.00
G (80.00)

Material stock
100.00
(80.00)

Change in stock
Production orderProduction order

L 100.00
G 80.00
P 150.00

100.00
80.00

120.00

Material stock

PrCtr 1

Business
process +

data

Usage for
production

order
Production

order
Production

order

PrCtr 2

Transfer price = 150.00

Postings in the Material Ledger (Not Shown)
The following lines are posted in the material subledger:

Change in stock (L) 100
(G) 80
(P) 120

to

Stock (L) 100
(G) 80
(P) 120

Postings in Financial Accounting and Controlling
The following lines are posted in Financial Accounting:
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Change in stock (L) 100
(G) (80)

to

Material stock (L) 100
(G) (80)

Of this posting in FI, only the CO-relevant part Change in stock is posted to the production order.

Change in stock (L) 100
(G) 80
(P) 150

Posting in Profit Center Accounting
The semifinished good and the production order are assigned to different profit centers. Thus
from a profit center viewpoint, this transaction is regarded as a “sale” by profit center 1 to profit
center 2. This sale is represented by a series of posting lines, each of which is shown separately.

Posting from the Viewpoint of Profit Center 1
First, the selling profit center 1 receives the transfer price of 150 USD as Internal revenue. No
posting for internal payables is made in Profit Center Accounting, since no payment will be
received. Thus no clearing entry can be made, nor is this necessary, since the profit center is not
an independent legal unit that requires a complete balance sheet.

Internal revenues (P) 150

The delivery of the semifinished good is represented for profit center 1 by the following record:

Internal change in stock (P) 120 to

Stock (P) 120

In total, profit center 1 shows the following results according to the period accounting method:

External sales 0

Internal sales 150

Change in stock -120

Result 30
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The account Internal change in stock is shown in the report together with the account Change in
stock so that the overall change in stock that appears is the correct amount when seen from the
profit center viewpoint.

Posting from the Viewpoint of Profit Center 2
For the receiver profit center 2, the posting line Change in stock is taken and valuated using the
transfer price:

Change in stock (P) 150 Profit center 2

As with payables, no posting for internal receivables is created.

However, because no change in stock has occurred from a profit center viewpoint, a reposting
has to be made to the item Delivery from profit centers so that the change in stock is correct from
the profit center viewpoint.

Delivery from profit centers (P) 150 to

Internal change in stock (P) 150

This additional posting is not necessary if you only represent profits using the
cost-of-sales method, since in that case no report items Change in stock appear. It
is also not necessary when raw materials are used.

The result for profit center 2 looks like this:

External sales 0

Internal sales 0

Change in stock 0
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Delivery from other profit centers -150

Result -150

As stated above, the accounts Change in stock and Internal change in stock appear in the same
report item.
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Profit Planning
Use
By defining a suitable planning layout, you can plan goods movements by entering quantities of
representative materials. The system valuate these quantities with transfer prices from the profit
center view.

This allows you to plan sales quantities instead of revenues. The system uses transfer prices to
calculate the corresponding revenues. The system reads the corresponding material direct costs
from a material cost estimate.

It is also possible to plan stock changes with transfer prices. To do this, the system reads the all
material direct costs with transfer prices from the material cost estimate.

Integration
This planning function is integrated with transfer pricing and the material cost estimate.

Prerequisites
To valuate plan quantities with transfer prices, you need to store transfer prices from the profit
center valuation view in your system (see Transfer Prices in Profit Center Accounting [Page
121]).

To read material direct costs, the standard costs of goods manufactured from the profit center
valuation view must be stored in your system (see Updating Parallel Values in Material Costing
[Page 148]). Since material direct costs can only be determined here for representative materials,
you also need to define and activate the necessary representative materials (see Representative
Materials [Page 68]).

You have made the necessary settings in Profit Center Accounting Customizing for valuating
quantities and deriving material direct costs. For more information, see the Implementation Guide
(IMG), under Profit Planning [Ext.].

Features
Carrying Out Valuation
Enter the plan quantities in a suitable layout (see below). You can define the corresponding
revenues and costs in two ways.

1: Automatic derivation whenever you save the planned quantities
Select the following fields in the costs/revenues row in the planner profile:

•  Valuate with TP if you want the system to valuate the planned sales quantities with transfer
prices when you save your entries in the planning layout.

•  Mat.costs auto if you want to derive the costs for the planned sales quantities using material
direct costs with transfer prices when you save your entries in the planning layout.

•  TP:Valuate Changes in Stock if you want to derive the costs for planned stock changes using
the cost of goods manufactured with transfer prices when you save your entries in the
planning layout.
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2: Manual derivation
Do not select the fields mentioned above in the planner profile. Instead, after entering the plan
quantities in the layout, choose the required rows and then the required buttons.

•  If you choose Valuate with TP, the system will valuate the planned sales quantities with
transfer prices.

•  If you choose Derive Mat. Costs, the system will derive the material direct costs for the
quantities in question with transfer prices.

•  If you choose Valuate Changes in Stock, the system will derive the cost of goods
manufactured for the planned changes in stock with transfer prices.

Planning Layouts for Valuation
You can valuate plan quantities with transfer prices using special planning layouts (see Defining
a Layout [Page 284]). You can copy the standard SAP planning layouts and use these as
templates.

Standard SAP layouts for Profit Planning

•  In layout 8A-106 (8A-116), you can enter plan quantities for certain profit centers (profit
center groups). After you have carried out valuation with transfer prices, the corresponding
revenues are displayed in the same layout.

•  If, in addition to the revenues for a profit center (profit center group), you also want to derive
the corresponding costs, you can display these in layout 8A-107 (8A-117).

•  Layout 8A-108 (8A-118) provides an overview of planned sales and balance quantities, as
well as the corresponding material input, all valuated with transfer prices. The profit is
calculated and displayed from these values.

When you create your own layouts, be sure to include the following information in the header or
in the columns of your layouts:

− Fiscal year

− Account number

− Representative material

− Plant

− Quantity

− Unit of measure

− Value field

You can only valuate quantities and determine costs if this information is defined in the layout. If
transfer prices in your organization are dependent on the partner profit center, you also need to
define a column for the partner profit center in your layout.

Plan reconciliation report
Once you have derived your plan data, you can execute a standard SAP plan reconciliation
report. This provides a comparison at totals record level between the planned revenues of a profit
center and the planned costs of its partner profit center.
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Multiple Valuation Approaches in Overhead Cost
Controlling
Use
The SAP System enables you to work with multiple value flows.

For more information on the business theory of multiple value flows in the system and their
portrayal in the Controlling component (CO), see the SAP Library, under Accounting → EC
Enterprise Controlling → EC Profit-Center Accounting → Multiple Valuation Approaches/Transfer
Prices [Page 100].

To make the necessary settings for multiple valuations, see the Implementation Guide (IMG)
under Controlling  →  General Controlling → Multiple Valuation Approach / Transfer Prices [Ext.].

This section deals with the aspects of multiple valuation approaches that are relevant for
Overhead Cost Controlling (CO-OM).

Features
Value Flow
Distribution, Assessment and Periodic Reposting
You execute actual distribution, assessment and periodic repostings in parallel in all valuations.
The costs to be allocated are taken from the corresponding valuation. The tracing factor is
always taken from the operational valuation. The values allocated may differ in the different
valuation methods. An exception to this is assessment in Profitability Analysis (CO-PA). This can
only be carried out using the operational valuation.

Internal activity allocation
Internal activity allocations [Ext.] are made in the operational valuation. The plan price used for
allocation thus applies to all the valuations. A later release will allow different (manually defined)
plan prices for the various valuations, dependent on the receiver.

You can determine actual prices, and revaluate on orders in all valuation views. Actual costs are
split on the activity types, based on the planning for the operational valuation.

Accrual Costs and Overhead Rates
The operational valuation forms the basis for accrual calculations [Ext.] and overhead rates [Ext.].
The amounts determined are valid for all valuations.

Settlement
Settlement [Ext.] is executed in parallel in all valuation methods, except for settlement to fixed
assets or to profitability segments. For settlement to fixed assets, the SAP system uses the
company code currency. For settlement to profitability segments, it uses the operational
valuation. Line item settlement to a fixed asset is possible only if you use legal valuation as your
operational valuation.

Reposting
You can repost documents (with references) in each valuation for the amount updated when the
document was originally posted.
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It is not possible to repost values for multiple valuation approaches.

Documents and Line Items
 When you post a document, the system creates separate line items for each valuation, all of
which belong to the same document header.

Analyses and the Information System
You can only execute variance calculation [Ext.] in the operational valuation.

The information system in the Overhead Cost Controlling component can access all of your
valuations. A ready-for-input field appears for the valuation in the selection screen, if you have
activated the update for multiple valuation approaches in at least one controlling area of the
current client. For more information see: Financials → Controlling → Cost Center Accounting →
Information System (CO-OM) → Report Definition → Report Painter [Ext.]). In reporting, you can
run target/actual comparisons between plan values in the operational valuation and the actual
values in another valuations.

Availability control
 Commitments [Ext.] are only executed with the operational valuation.

 The active availability control compares the actual values for the operational valuation with the
released budget. This means that you can only control availability for the operational
valuation.

Reconciliation with Financial Accounting
All valuations are updated in the reconciliation ledger [Ext.]. When you enter reconciliation
postings [Ext.], the system reports the values to Financial Accounting in all valuations. However,
valuations that are not recorded in Financial Accounting are not considered. For more information
see the SAP Library under: Financials → Controlling → Cost Element Accounting → Information
System → Transfer Prices in the Reconciliation Ledger [Page 147].)

The default setting for the reconciliation reports and the cost flow report ensure that values are
displayed in the legal valuation.
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Transfer Prices in Cost Object Controlling
Use
Transfer prices are used to valuate the transfer of goods and services between the business
units of a corporate group. The value of a good can be updated in up to three different valuation
views.

The valuation views provides different perspectives on business transactions from the point of
view of the individual company, of the corporate group, and of the profit center. You can define
the following views in multiple valuation:

•  Legal view

•  Group view

•  Profit center view

Prerequisites
Maintain the central versions in Customizing for General Controlling.

To update inventory values in your actuals, you must be using the component Actual
Costing/Material Ledger.

To calculate work in process at actual costs, make the relevant settings in Customizing for
Product Cost by Order under Period-End Closing → Work in Process → Define Results Analysis
Versions [Ext.].

Features
If you are not using transfer prices, the data relevant to cost accounting is updated in the R/3
System in the operational valuation view. The operational valuation view is normally the legal
view.

If you are using transfer prices, certain data can be updated in parallel with the operational
valuation view in the group view and in the profit center view.

Transfer prices can be used in Cost Object Controlling in the following manufacturing
environments:

•  Make-to-stock production

•  Sales-order-related production with a valuated sales order stock

The following functions of Cost Object Controlling support transfer prices:

•  Preliminary cost estimates for manufacturing orders

The planned costs calculated in a preliminary cost estimate for a manufacturing order
can be updated in up to three valuation views. You create preliminary cost estimates for
manufacturing orders in Product Cost by Order.

•  Work in process at actual cost

You can update work in process at actual costs in up to three valuation views in parallel.
You can calculate work in process at actual costs in Product Cost by Order.

•  Distribution of actual costs for cost object hierarchies
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The actual costs updated to a cost object hierarchy can be distributed to the single
objects assigned to the cost object hierarchy (such as product cost collectors) in the
period-end closing activities of Product Cost by Period. You can perform this distribution
in multiple valuation views.

Note that the distribution is only based on one target cost version for target cost
calculation. This means that all valuations are distributed on the basis of the same target
costs.

•  Distribution for co-products

The costs of a joint production process collected on the order header of a manufacturing
order are distributed to the co-products at the end of the period. You can perform this
distribution in multiple valuation views.

•  Collective orders with automatic goods movements

Cost controlling of collective orders with automatic goods movements is carried out in the
Product Cost by Order component.

•  Sales order costing

When you create a sales order cost estimate in Product Cost by Sales Order, the
calculated planned costs can be updated in multiple valuation views.

•  Results analysis

When you perform results analysis in Product Cost by Sales Order, the calculated results
analysis data can be updated in multiple valuation views.

The planned costs used to calculate the results analysis data are not always available in
multiple valuation views. For example, if the results of a sales order cost estimate
updated to the sales order item are used to calculate the planned costs, these planned
costs are on the sales order item only in the operational valuation view.

•  Update of inventory values of finished products

When products are received into inventory (goods receipt posting) and when the
difference between the debit and credit of orders is settled, the values can be updated in
multiple valuation views.

•  Settlement

At the end of the period, the difference between the debit and credit of manufacturing
orders and product cost collectors can be settled to Financial Accounting (FI), Profit
Center Accounting (EC-PCA), Profitability Analysis (CO-PA), and Actual Costing/Material
Ledger (CO-PC-ACT). You can perform this settlement in multiple valuation views.

Constraints
Variances on production orders result automatically from the inventory receipt for each valuation
approach (CO version). These variances are posted to the price difference account.

The variance calculation function, which breaks down the total variance into variance categories,
is only supported by the operational version. You should take this into account if you are using
the application component Profitability Analysis and want to transfer these variance categories
into Profitability Analysis. The variances for the additional CO versions, too, can be transferred
into Profitability Analysis through automatic account assignment, but these variances can only be
transferred as a total and not broken down into variance categories. Variances from the group
view are not transferred into CO-PA.
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See also:
Implementation Guide (IMG)

•  General Controlling

•  Product Cost by Order

•  Actual Costing/Material Ledger

For detailed information on transfer prices, refer to the following:

Transfer Prices

and in the section Transfer Prices in the following sections.

For information on valuated sales order stocks, refer to the following section:

Valuated Sales Order Stock [Ext.]

For information on preliminary costing for manufacturing orders, refer to the following section:

Preliminary Cost Estimates for Manufacturing Orders [Ext.]

Preliminary Cost Estimates for CO Production Orders [Ext.]

For information on the distribution of actual costs for cost object hierarchies, refer to the following
section:

Actual Cost Distribution [Ext.]

For information on distribution for co-products, refer to the following section:

Distribution for Co-Products [Ext.]

For information on work in process at actual costs, refer to the following section:

Work in Process in Product Cost by Order [Ext.]

For information on collective orders with automatic goods movements, refer to the following
section:

Collective Orders with Automatic Goods Movements [Ext.]

For information on sales order cost estimates, refer to the following section:

Sales Order Costing [Ext.]

For information on results analysis, refer to the following section:

Results Analysis [Ext.]

For information on settlement, refer to the following sections:

Settlement in Product Cost by Order or Period [Ext.]

Settlement of Sales Order Items [Ext.]

For general information on updating the inventory values of finished products in multiple
valuation, refer to the document Actual Costing/Material Ledger [Ext.].

For special information on displaying material ledger data in multiple valuation, refer to the
following section:

Displaying Material Ledger Data [Ext.]
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Transfer Prices in the Reconciliation Ledger
Use
The SAP R/3 System can use up to three of the following valuation approaches simultaneously:

•  Legal valuation view

•  Group valuation view

•  Profit center valuation view

You assign valuation views for actual versions at controlling area level. One of the valuation
views takes a leading role. The system saves this valuation view in version 000.

You can display one of the three possible valuation approaches in the cost flow report. The legal
valuation view is set as the default setting. In the reconciliation reports 5AF1 and 5AF2 you can
display the valuation in company code or group currency.

Integration
For reconciliation postings, the system transfers all cost flows to the FI component, in the three
valuation views mentioned above.

Prerequisites
So that the reconciliation ledger can update all valuation approaches as delta values, the
following prerequisites must be met:

•  You have entered a valuation profile in your controlling area.

•  You have maintained an actual version for parallel valuation approaches.

•  You have activated multiple valuation approaches/transfer prices in your controlling area.

For more information on transfer prices, see Transfer Prices [Page 100].
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Multiple Valuation Approaches in Product Cost
Controlling
Use
In Product Cost Controlling, you can use multiple valuation approaches to calculate standard
prices according to the legal, group and profit center valuation view.

Release 4.0 provides a group costing function that calculates the group cost of goods
manufactured.

Materials purchased from companies within the group are displayed as material expenses for the
receiver company, even though these expenses include direct costs, overhead, and the profits of
the sender company. If the production process has several steps, more and more costs become
material costs. Release 4.0 lets you show shares of the value added and internal profits
separately.

From the profit center valuation viewpoint, the use of transfer prices for internal sales means that
the sender profit center’s cost of goods manufactured is replaced by the transfer price in the
receiver profit center’s point of view.

The structure of a group cost estimate adds together the cost component split (including profits)
of all the steps involved in the production process without losing the cost component splits of the
previous steps. In addition, the split is shown separately by supplying company codes and profit
centers. Likewise, the profit markup of the supplying company codes and profit centers is also
displayed.

This information forms the basis for the calculation of the group cost of goods manufactured
(without internal profits) and the cost of goods manufactured from the profit center valuation view
according to the relevant transfer prices.

The different views represented in material costing mean that you can store standard prices in
the material ledger for the desired valuation methods.

For more information on using multiple valuation approaches in material costing, see Group
Costing [Ext.].

Integration
See Consistency of the Valuation Settings in Different Applications: Currency and Valuation
Profile [Page 108].
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Multiple Valuation Approaches/Transfer Prices in CO-PA
Use
The Profitability Analysis (CO-PA) application component normally represents external sales with
customers outside the group and other companies within the group. This allows you to analyze
the external sales and valuate these using the cost of goods manufactured from a legal or group
standpoint.

Organizations that want to handle profit centers as independently operating companies, however,
need to be able to see internal sales between profit centers (exchanges of goods, goods issues,
stock transfers, and so on) as well as external sales in order to analyze their profit centers
correctly in this environment. Moreover, it may be necessary to valuate both internal and external
sales from the viewpoint of the individual profit centers (costs of goods manufactured on the
basis of transfer prices) in addition to the legal viewpoint.

If your organization valuates exchanges of goods between profit centers with transfer prices, you
can update this information in costing-based CO-PA and thus evaluate your sales from both the
legal viewpoint and the profit center viewpoint. The following valuations are possible:

Group

Company code 3Company code 3

Retail
company

Profit Center

Company code 2Company code 2

Production

Division 3Division 3

TP

TP

TP

Division 2Division 2
Division 1Division 1

Group result
Revenue with third parties

-
 Cost of sales

(corporate group)

Company result
Revenues with third

parties + other companies
in corp. grp

-
Legal cost of sales

Profit Center Result

(Intracompany)

(Intercompany)

Revenues with third
parties + other companies

in corp. grp +
profit centers

-
Cost of sales (PrCtr)

For detailed information on transfer pricing and multiple valuations, see Transfer Prices [Page
100] in the online documentation for Profit Center Accounting.

Prerequisites
To be able to update values with profit center valuation in CO-PA, you system must meet the
following criteria:

1. Your system must valuate exchanges of goods between profit centers using transfer prices.
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2. A currency and valuation profile (in which at least one valuation approach uses profit center
valuation) must be defined and assigned to the desired controlling area in Customizing under
General Controlling → Multiple Valuation Approaches/Transfer Prices, and multiple
valuations must be activated.

In addition, certain settings must also be made for CO-PA Customizing.

1. You must activate profit center valuation for at least one currency under Structures →
Operating Concern → Define Operating Concern → Attributes.

2. You must define accounts for internal goods movements between profit centers to value and
quantity fields in CO-PA and activate profit center valuation (Flows of Actual Values →
Multiple Valuation Approaches/Transfer Prices).

3. You must activate the characteristic Partner profit center (field PPRCTR) under Structures
→ Define Profitability Segment Characteristics (Segment-Lvl Characteristics).

To be able to analyze the results generated between profit centers, you need to know
which profit centers sold to which other profit centers. Consequently, each internal
transaction has to have two profit centers, which are stored in the characteristics Profit
center (PRCTR) and Partner profit center (PPRCTR). This gives you both profit
centers as characteristics for analysis in CO-PA.

The characteristic Partner profit center is a fixed characteristic in the operating concern
data structures, and must be active as a segment level characteristic.
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Updating Multiple Values in Financial Accounting
Use
As described in Multiple Values for Material Stocks Using the Material Ledger [Page 120], the
material ledger stores multiple valuation approaches for all goods movements and materials
usage. When you transfer, procure or use materials, you can also post multiple values in
Financial Accounting.

These additional values representing the three valuation views -- legal, group and profit center --
are stored in separate currency fields. The functions for storing multiple currencies has been
enhanced to allow you to store multiple valuation views in Financial Accounting as well.

The following example of a cross-company sale is intended to show the effects these new
functions having on posting logic.

L
G

L
G

G
L

L
G

L
G

L
G

L
G

F IF I Company code 1

Goods issue

Cost of Sales Stock Stock GR/IR
L 50.00
G 40.00 40.00

50.00 L 80.00
G 40.00

80.00
40.00

Company code 2

Goods receipt

Invoice receipt

Billing document

L 80.00
G 40.00

GR/IR

Receivables Revenues
L 150.00
G 150.00

130.00
40.00

20.00
20.00

90.00

Non operating profit Sales tax Non operating profit Price difference

SupplierInput tax
150.00
150.00

L 20.00
G 20.00

G 90.00
L 50.00

In the above example, the goods movements are posting using the legal and group valuation
approaches. Whereas from the legal view valuation differences may arise in the individual
company codes, and even within plants, the cost of goods manufactured according to the group
view are always 40.00 USD.

Note that receivables and payables are always represented from the legal view. This is because
the payments that balance out these accounts are only stored from the legal view. Balances that
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arise on account of this are set off against valuation clearing accounts (referred to as
“Non-operating profit” in the example).

For more information about using multiple valuation approaches in Financial Accounting, see
Transfer Prices in Financial Accounting [Ext.].

Integration
See Consistency of the Valuation Settings in Different Applications: Currency and Valuation
Profile [Page 108]
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Parallel Valuation Approaches in Asset Accounting
Use
If you want your profit center managers to be able to analyze the assets in their area of
responsibility, you need to valuate assets in Profit Center Accounting using the same valuation
approach as the one they were originally posted with in Asset Accounting. This is why you can
settle assets to the relevant valuation areas in Asset Accounting using the legal, group, and profit
center viewpoints in Profit Center Accounting. This applies to collective as well as line item
settlement.

Within a valuation area, define an additional valuation area for each valuation view.

Example:

Valuation area 20 (costing-based valuation) includes:

Valuation area 20 (costing-based valuation in legal valuation view)

Valuation area 21 (costing-based valuation in profit center valuation view)

Valuation area 22 (costing-based valuation in group valuation view)

Integration
Note that you must use the same valuation approaches in Asset Accounting as in Financial
Accounting. Additional valuation approaches in Asset Accounting are not supported. See also
Updating Multiple Values in Financial Accounting [Page 151]
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Valuation in Procurement and Sales
Use
To use transfer prices, you must transfer values using multiple valuation approaches between the
individual companies in your organization.

It is usually not desirable to have to edit or even create multiple valuation approaches by hand.
Consequently, the system uses automatic data interfaces to ensure that parallel values are
transferred for all purchasing and sales transactions. The following section describes what
settings you need to make to set up these parallel value flows.

Integration
A typical example would be the following process:

1. A stock transport order is entered in group company A.

2. From this stock transport order, group company B creates a delivery and a goods issue
posting. No sales order is created for this transaction.

3. When group company B writes the subsequent outgoing invoice to the purchasing
company, the values for this invoice are automatically transferred using the IDoc
interface. This transfer includes the legal valuation approach as well as the group and
profit center approaches.

4. After posting the goods receipt, group company A posts the invoice receipt, which copies
the legal, group, and profit center values from this interface.

Features
In order to ensure that all value flows are updated automatically and consistently throughout the
system, the following documents need to be transferred automatically between company codes
in the group:

•  Purchase order - transferred to company code B (seller) when the stock transfer order is
created.

•  Outgoing invoice - transferred to invoice verification in company code A.

In Release 4.0A, you need to use the IDoc interface and thus also the ALE functions. This is also
the case when both company codes are in the same system. Consequently, you have to carry
out the following steps to set up the transfer of multiple valuation methods:

•  Initial Steps in SD

•  Setup of the ALE Functions

•  Settings for the Data Transfer to Invoice Verification

Initial Steps in SD
Prerequisite for transferring parallel values between company codes is that you include the
necessary conditions for the profit center valuation view and the concern valuation view in your
pricing procedure.
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For technical reasons, only one "real" pricing condition is permitted per pricing procedure. The
profit center valuation view and the group valuation view must therefore be created as static
conditions. The following conditions are obligatory:

Internal billing document (to affiliated company)

Condition* Cond.Type Note
Legal View IV01
Profit Center
View PC00

Normally contains access 
sequence

Group View KW00 b 

No access sequence. 
The goods issue value is rea
from the Material Ledger 
document.

Legal View VPRS G Goods issue value from lega
view.

Profit Center 
View

PCVP h 

No access sequence. 
The goods issue value is rea
from the Material Ledger 
document.

Group View KW00 b 

No access sequence. 
The goods issue value is rea
from the Material Ledger 
document. 
In the group view, the costs o
sale are equal to the revenue

* Example

Revenue

Cost of Sales
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External billing document (to customers)
C o n d itio n * C o n d .T yp e No te

L e g a l Vie w P R 0 0

P ro fit C e n te r 
Vie w

P C 0 0 c  

No rm ally c o ntains  ac c e s s  
s e q ue nc e . 
I f  re q uie d , re ve nue  f ro m  le g
vie w c an b e  inc lud e d  in P C 0
us ing  a c alc ulatio n fo rm ula. 
S e e  no te  3 6 4 4 4 9 .

G ro u p  Vie w (P R 0 0 )

R e ve nue  f ro m  le g al vie w is  
trans late d  c alc ulate d  
auto m atic ally into  the  g ro up  
vie w.

L e g a l Vie w V P R S G  

P ro fit C e n te r 
Vie w

P C V P

h 

-------------
n

No  ac c e s s  s e q ue nc e . 
T he  g o o d s  is s ue  value  is  re a
fro m  the  M ate rial L e d g e r 
d o c um e nt.
-------------------------------
In the  c as e  o f  third -p arty 
b us ine s s  trans ac tio ns .

G ro u p  Vie w K W 0 0  b  

No  ac c e s s  s e q ue nc e . 
T he  g o o d s  is s ue  value  is  re a
fro m  the  M ate rial L e d g e r 
d o c um e nt. 
In c o ntras t to  inte rnal b illing  
d o c um e nts , K W 0 0  is  o nly 
p o s te d  o n the  c o s t s id e  fo r 
e xte rnal b illing  d o c um e nts .

* E xam p le

R e v e n u e

o s t o f S a le s

For a detailed description of the condition technique and multiple valuation approaches, see OSS
note 135288.

 Third-party business transaction / profit center valuation view
In third-party business transactions, the billing company code and the delivering
company codes are not the same. This also applies to the billing and supplying profit
centers. In the profit center view, note the following:

The supplying profit center receives its revenue through internal clearing (condition
PC00). At the same time, this revenue represents the cost of sales for the billing
profit center (condition PCVP). You now have to ensure that PC00 is transferred
after PCVP.

To do this, assign the same access sequence to both conditions. The condition
category h, which is normally used for the moving average price in the external billing
document, reads only the goods issue value from the material ledger document. As
such, it does not have an access sequence assigned to it. For third-party business
transactions, you must therefore add another condition category to PCVP, that being
condition category n.

•  The internal billing document is sent automatically to the purchasing company code, where it
is posted as a goods receipt. To transfer the values automatically to the purchasing company
code, you need to define the same settings you normally define in Customizing for ALE (see
ALE - Consultant's Guide).
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Setup of the ALE Functions
To transfer the values automatically to the purchasing company code, you need to define the
same settings you normally define in Customizing for ALE (see ALE - Consultant's Guide).

Settings for the Data Transfer to Invoice Verification
Prerequisite for posting the invoice in the purchasing company code is that the purchase order
number and the purchase order item be transferred as reference information.

In addition, you can predefine the document types and program parameters in Customizing
under Materials Management → Invoice Verification → Conventional Invoice Verification → EDI.
Typically, the keys and the value-added-tax indicator and the company code are converted for
this transfer.

Once you have made these settings, every incoming invoice from a vendor that is defined as an
affiliated company in its master record (VBUND indicator) will be posted using parallel valuation
methods.

With a third-party business transaction, the goods receipt is made via the EDI interface in
Financial Accounting, as there is no purchase order in the billing company code.

If the goods receipt from an affiliated company takes place before the invoice receipt,
the goods receipt is valuated in the legal valuation view at the order price. In the
profit center valuation view and the group valuation view, the system takes the
current material price for each valuation view from the Material Ledger. Using
customer enhancement EXIT_SAPLPC32_003, you can ensure that in the profit
center view or group view, the goods receipt is valuated with the order price
according to the legal view in certain cases.

When an invoice comes from an affiliated company, the system expects the corresponding IDoc
to contain all valuation views that are stored in the controlling area. If this is not the case,
because the supplying company belongs to the group but does not use multiple valuation
approaches, the system sends an error message. In such cases, you can avoid error messages
by using customer enhancement EXIT_SAPLPC32_004. For further details, see OSS note
366968.
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Implementing Transfer Pricing in a Live System
If you want to implement transfer pricing in a live system, you need to analyze the effects this
would have on all your live applications carefully. What measures you need to take will depend
on how your installation is customized. SAP can only provide a few standard programs to support
you in this.

This section tells you under what conditions you can implement transfer pricing and multiple
valuation views in a live system. It also tells you what activities you need to carry out depending
on which application components you are actively using and how your system is set up.

If your system meets the conditions described here, you can activate multiple valuation views in
the standard system on a project basis using the conversion programs provided or after
consulting SAP.

The Controlling and Material Ledger application components form the basis for transfer pricing.
Consequently, certain minimum criteria must be met in these applications before you can
implement multiple valuation approaches in your system. Using multiple valuation approaches is
optional in Financial Accounting (FI). However, you must use multiple valuation approaches in FI
if you want to do so in Asset Accounting (FI-AA).

Generally, you can implement multiple valuation approaches in the standard system without
carrying out any conversions if the controlling area currency is the same as the group currency
and if the material ledger is not yet active. If you want to activate multiple valuation approaches in
FI, you can do this as long as you are not already using multiple currencies. However, be sure to
note the effects this has on open items.

The following sections tell you the requirements for implementing multiple valuation approaches
in the respective applications if you have already gone live, and what scenarios you can
implement:

Controlling [Page 159]

Material Ledger [Page 161]

Financial Accounting and Asset Accounting [Page 162]

For more information on the management principles behind transfer pricing and on the integrated
flow of values between applications, see:

Managerial Aims of Transfer Pricing [Page 102]

Multiple Value Flows in Financials [Page 107]
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Controlling
To read about the general requirements for using transfer prices in Controlling, see Multiple
Value Flows in Controlling [Page 115].

To ensure that data is updated consistently, you need to use certain currency combinations in
your controlling area. The following table shows which currency combinations allow you to
change over to multiple valuation approaches.

Current Settings in Live System: Examples

Scenarios in CO Controlling area
currency

Object currency Relationship Comment

Scenario 1 10 any 1:1; N:1 OK

Scenario 2 20=10 any 1:1 OK + action

Scenario 3 20(40, 50, 60)=30 10 N:1 OK + action

Scenario 4 20(40, 50, 60)<>30 10 N:1 No � Consultant

Scenario 5 30 10 N:1 OK

Legend: 10 Company code currency

20 Controlling area currency

30 Group currency

40 Hard currency

50 Index currency

60 Company currency

Scenario 1:
The controlling area currency is the same as the company code currency. An additional valuation
in the group currency is not required. All valuation approaches use the company code currency.
No conversions need to be carried out. You can activate transfer pricing.

Scenario 2:
The controlling area currency is the same as the company code currency. Currency type "20" is
used as the controlling area currency. An additional valuation in the group currency is not
required.

All you have to do is change the currency type. For more information, see Customizing. You can
activate transfer pricing.

Scenario 3:
Currency type "20" (40, 50, 60) is used as the controlling area currency. This currency has the
same currency key as the group currency.

All you have to do is change the currency type. For more information, see Customizing
(Implementation Guide for Controlling General). After this, all requirements for using multiple
valuations are fulfilled. No conversions need to be carried out. You can activate transfer pricing.
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Scenario 4:
Currency type "20" (40, 50, 60) is used as the controlling area currency. This currency does not
have the same currency key as the group currency. The requirements for using multiple
valuations are not fulfilled.

You need to convert the data in Controlling. This scenario is not supported by the standard R/3
System. The conversion process is complex and can only be carried out on a project basis.

Scenario 5:
You are using the group currency as the controlling area currency. This scenario is usually used
for cross-company controlling. When this is the case, the company code currency is used as the
object currency. Thus all requirements for using multiple valuations are fulfilled. No conversions
need to be carried out. You can activate transfer pricing.

CO Versions
In a currency and valuation profile, you define which valuations are stored in which currencies.
You can store up to three valuations in either one or two currencies in parallel. In CO, the
different valuation approaches are stored in different actual versions. These versions need to be
assigned to a valuation view (see Multiple Value Flows in Controlling [Page 115]).

If your system is already live, version 000 is already defined for the legal valuation view.
However, when implementing transfer pricing, you may want to assign this version to another
view. This cannot be done using the normal version maintenance functions. Instead, you need to
use a special conversion program in Customizing. You can only change this assignment before
you activate the currency and valuation profile. For more information, see Customizing
(Implementation Guide for Controlling General).
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Material Ledger
To read about the requirements for using multiple value flows in the material ledger, see Multiple
Values for Material Stocks Using the Material Ledge [Page 120]r.

The following scenarios make it possible for you to activate multiple valuations in the material
ledger:

Scenario 1: The material ledger is not yet active
The material ledger is not yet active and therefore can be activated for the desired valuation
approaches. No conflicts can arise with data already posted in other currencies or valuations.

Scenario 2: The material ledger is already active
The material ledger is already active for multiple currencies. These currencies correspond to the
group currency. Legacy data does not need to be translated.

After analyzing the current situation in detail, you can change the currency type (combination of
currency and valuation view) on a project basis using a special conversion program. The system
acts as if this currency type had been active the whole time.

Scenario 3: The material ledger is already active
The material ledger is already active for multiple currencies.

This scenario is based on the assumption that the legacy data in the material ledger is no longer
relevant following the change of valuation approach. Consequently, you can deactivate the
material ledger and then change the currency type. Then reactivate the material ledger. When
you do so, the system deletes all the existing data in the material ledger and recreates it using
the new currency and valuation settings.

Scenario 4: The material ledger is already active
The material ledger is already active for multiple currencies. You still want to be able to use the
legacy data, and the currency keys used are not the same as the group currency.

In this scenario, you must proceed as you do when converting the data for the euro. The system
converts the currency key as well as translates the values. This procedure is highly complex and
can only be carried out on a project basis.
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Financial Accounting and Asset Accounting
To read about the requirements for using multiple value flows in Financial Accounting (FI) and
Asset Accounting (FI-AA), see Update of Multiple Values in Financial Accounting [Page 151] and
Multiple Values in Asset Accounting [Page 153].

The following scenarios make it possible for you to activate multiple valuations in FI:

Scenario 1: Multiple currencies not currently used in FI
Activating an additional valuation view (such as profit center valuation) in FI Customizing does
not lead to any changes to data already posted. However, nonsense exchange rate differences
arise in the additional valuation view when you clear open items. Moreover, all accounts have a
balance of "0".

In this case, you have the following options:

•  Wait until all open items have been cleared before activating the additional valuation
view.

Up to that point, your balance sheet data in the additional valuation view is worthless due
to the exchange rate differences. Afterward, all you have to do is post your initial
balance. Problems with exchange rate differences may arise with some business
transactions (such as backdated tax calculation for cash discounts) or when you post the
initial balance. The standard programs are not designed to cope with situations where
data with and without additional valuations exists in the same posting. This procedure is
not supported by SAP.

•  Cancel and repost open items that were not created with multiple valuation
approaches.

This option is useful if you activate multiple valuations somewhere in the middle of a
fiscal year (year "X") but do not need to use the values in the additional valuation until
fiscal year "X+1". Until then, almost all the open items created without the additional
valuation will have been cleared. Any remaining open items need to be processed
manually or using a program. During fiscal year "X", exchange rate difference postings
are noticeable when you clear open items because additional postings lines with a value
of "0" are created in the company code currency. This procedure is not supported by
SAP.

•  Covert all documents.
This is only possible if need to analyze reports that contain exactly the same amounts in
the additional valuation (for example, group currency) as in legal valuation. That is the
case when the company code is the parent company and the group currency is active, so
that you can report on all company codes in the group currency.

•  Convert open items.
In this option, you need to assign the group currency to all open items. This makes all the
values needed for future postings available in the group currency. Items that have
already been posted and are no longer open are not converted to the group currency.

Amounts in the additional valuation approach (group currency) are added to the open
items. Other document lines and documents without open items remain unchanged (with
no amounts in the group currency). You should carry out this conversion at the end of
your fiscal year, so that you have correct values in the group currency for the entire year.
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You can create initial balances in the group currency by translating the values in the legal
valuation view.

Only document lines with open items and no group currency are converted. The system
adds one line contain an amount (not "0") in the group currency to each document. this
exchange rate difference is posted to a special profit and loss account ("Currency
transfer") that you need to specify.

Example with a hard currency (company code currency) of DEM and group valuation
in the group currency USD:

Document before conversion:

Item PK Account no. Name DEM USD

001 31 Vendor Vendor -1500.00 -0.00

002 40 400000 Material 1500.00 0.00

Document after conversion:

Item PK Account no. Name DEM USD

001 31 Vendor Vendor -1500.00 -1000.00

002 40 400000 Material 1500.00 0.00

003 40 233233 Currency transfer 0.00 1000.00

The translation is carried out using the exchange rates for a specific date, which you specify, and
using the settings made for multiple local currencies in Customizing. It is currently not possible to
translate using past exchange rates.

You should introduce the group currency at the end of the fiscal year, before any postings are
made in the new fiscal year. It is also possible to activate the group currency earlier (before the
end of the year) to reduce the number of open items that need to be converted. One
disadvantage of this is that users already see values in the group currency even though they do
not need to work with them yet. the documents may often have extra lines in the group currency
with exchange rate differences.

To obtain an opening balance sheet in the group currency, you can valuate the balances of
accounts without open items in the group currency and post the results with "Currency transfer"
as the offsetting account. The values are translated using the exchange rate for a specific date,
which you specify. Balance sheet adjustment accounts for exchange rate differences from the
open item valuation cannot be valuated. If desired, you can also valuate profit and loss accounts.

Reconciliation accounts in Asset Accounting (FI-AA) are not affected. Their balance in the group
currency remains zero. You need to process these accounts separately.

Currently no other methods are supported for creating the opening balance sheet in the group
currency.
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Asset Accounting (FI-AA)
In FI-AA, you need to create an additional valuation area for each additional currency used in FI.
Acquisition values and depreciation rules for these areas need to be copied with no possibility of
alterations from the master area "01".

Scenario 2: Multiple currencies currently used in FI
You need to analyze whether currencies currently being used correspond to the currencies you
need for your multiple valuations.

You have the following settings in your system:

Financial Accounting

Company code currency 10

Local currency 1 30 = Group currency

Local currency 2 40 = Hard currency (<> Group currency)

You want to store the following valuation approaches in your system:

Currency and valuation profile
10 Legal valuation/company code currency

31 Group valuation/group currency

32 Profit center valuation/group currency

You want to replace the multiple currencies with multiple valuation approaches.

Since local currency 1 uses the same currency key as the currency you want to use
for group valuation and profit center valuation, you can change the currency type and
thus implement multiple valuation approaches. To do this, you need to run a
conversion program that converts all the document headers in FI from the old
currency type to the new currency type.

Local currency 2, however, cannot be changed over to a different valuation view,
since the currency key of the local currency is not the same as that in the currency
and valuation profile. In this case, an additional currency translation would need to
be carried out on top of the currency type change. This is as complex a process as
the euro conversion and is not supported in the standard R/3 System. However, it is
possible to do this on a project basis in cooperation with SAP.
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Planning
Planning of value added or activities in internal areas of responsibility (profit centers) forms an
essential part of overall corporate planning.

The integrated nature of corporate planning is especially noticeable in profit center planning,
because there you can combine, extend, and alter plans from a number of other applications.

Aims
The principal aim of profit center planning is to provide data and key figures for the purpose of
planning for responsibility areas (profit centers).

If the necessary data already exists in other applications, you can transfer it to your profit centers.
Then you can add any missing plan information (revenues, costs, changes in stock, and so on)
directly in Profit Center Accounting. Finally, you can carry out plan closing measures, such as
revaluation, assessment, distribution, and so on.

Requirements of Profit Center Planning
To be able to carry out comprehensive profit center planning, it is necessary to take both
managerial and technical requirements into account in the planning process.

Managerial Requirements
To make it possible to control and evaluate internal responsibility areas effectively, you should
limit profit center planning to values that are easily measurable and can be influenced directly by
the person responsible. The profit center managers are only able to utilize the planned data and
targets if they can influence the costs, revenues and stocks in their area. Since your concrete
organizational structure and the scope of your organization's responsibility areas depend largely
on individual factors, you need to be able to organize your profit center planning as flexibly as
possible.

Software Requirements
Comprehensive profit center planning must be supported with efficient software. The following
factors play a role in how to define your software requirements:

•  Planning scope

•  Planning process

•  Planning techniques

The planning scope refers to the levels of responsibility and the degree of detail to be planned.
The planning time frame also needs to be established (annual, quarterly or monthly planning).

The planning process refers to the sequence in which you carry out the various planning
activities and the planning areas to be coordinated.

The entire planning process must be effectively supported by various planning techniques. This
calls for comprehensive planning functions and calculation functions.

Features
Planning in Profit Center is described in detail in the following sections.
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Integration of Profit Center Planning [Page 167]

Planning Process [Page 170]

Plan Versions [Page 171]

Plan Data Transfer [Page 173]

Planning Profit Centers Directly [Page 182]

Assessment and Distribution [Page 321]

Currencies in Planning [Page 224]
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Integration of Profit Center Planning
Profit center planning forms part of corporate planning. For this reason, planning integration and
reconciliation are particularly important. In the following topic, you will find information about the:

•  integration of profit center planning in short-term corporate planning

•  the role of Profit Center Accounting in medium-term corporate planning

•  separate reconciliation of profit center planning with other areas in the business.

Short-Term Corporate Planning
Profit center planning is a part of short-term corporate planning and thus encompasses as span
of one fiscal year. Short-term corporate planning generally consists of the following partial plans:

•  sales plan

•  master production schedule

•  cost plan

•  sales revenue plan

The planning process combines these individual planning areas into an integrated planning
network. You can use different Plan Versions [Page 171] to reflect changes during the planning
process or different planning scenarios at the same time. The integration of content and time-
frames in planning is generally influenced by the following considerations.

Sales Plan
The starting point for short-term planning is the sales plan, in which you determine the quantities
you expect to sell during the planning period. The sales plan is usually created by the sales
department. The planned sales quantities are then passed on to production planning so that the
planned capacities and activities can be coordinated.

Master Production Plan
The master production plan is worked out in close coordination with the sales plan. It determines
both the capacities and the quantity requirements for raw materials and operating supplies. The
planned activities established here are forwarded to the cost centers, which must supply these
capacities in the form of activity units. Furthermore, the cost center managers must plan the
costs to be incurred and the activity quantities to be taken from other cost centers based on the
planned capacities and activities.

Cost Plan (Cost Center Plan)
Once the activity units have been planned, it is necessary to plan the costs expected for these
activities. Cost center planning can thus be divided into two stages:

•  planning the activity units

•  planning the expected costs incurred

Together with sales planning, cost planning forms the basis for revenue and profit planning.
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Sales and Profit Plan
The planned costs and sales quantities can then be used to derived planned contribution
margins. The costs from cost center planning and the planned sales quantities (valuated based
on the expected revenue) are used in sales revenue planning.

Profit center planning represents these planned profits by area of responsibility.

Medium-Term Corporate Planning
You can use profit center planning to create a medium-term rough plan when you do not have a
detailed plan. For example, if you have already created a detailed plan for the fiscal year 1998,
you can use these values as a basis for your 1999 plan, adding a revaluation factor to these
values.

Integrated Profit Center Plan
The planning of profit centers is performed in two stages:

1. Transferring Plan Data Online from Other Applications [Page 175]

Plan data can currently be transferred from the following applications:

− Cost Center Accounting

− Project Management and

− Internal Orders

− Profitability Analysis

− Production Planning

Profit
center

Account-based
Profitability Analysis

Cost center

Internal
order/project/
network

SOP/MRP

Sales order/
project

The data is planned for these objects and then transferred to Profit Center Accounting.
Here the integrated nature of profit center planning takes on great importance, since it
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summarizes the individual sub-plans under the aspect of profits for areas of
responsibility. Plan data is transferred either

• periodically

whereby all existing plan data from the above applications is transferred per
controlling area and plan version

or

• online

whereby the following plan activities are transferred online:

− primary cost planning

− planned accruals

− activity input planning

− plan assessment

− plan distribution

− plan overhead rates

Plan data is represented on profit centers by fiscal year, period, company code and plan
version.

2. Planning Profit Centers Directly [Page 182]

Planning can be carried out directly on profit centers within Profit Center Accounting.

The following planning functions are available:

•  planning or plan maintenance of all cost and revenue elements

•  plan assessment

•  plan distribution
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Planning Process
Use
Profit center planning is a process that is handled differently in almost every company. The type
of industry, particular organizational structures and responsibilities are factors which determine
how a company performs its planning.

You can set up the transfer of plan data so that planning in other CO applications is represented
on profit centers online. You can, however, also transfer the plan data periodically.

Features
Profit center planning is supported by the following planning tools:

•  Profit center planning has been so designed to enable you to set up the planning screens
yourself using various parameters.

Before you start planning your profit centers, you must check the layouts [Page 280] that
were delivered with the system and, if required, create your own planning layouts.

•  The planning process is not a single process carried out once, but an iterative process that
runs in several cycles. This is also reflected in the storage of the planning data in the system.
The system allows the parallel storing of alternative plan versions [Page 171] for such
purposes.

Activities
You need to carry out a number of steps to configure planning in EC-PCA. See Customizing for
Profit Center Accounting for more information on this. There you can also maintain your planning
layouts [Ext.] and planner profiles [Ext.].

You can also carry out the necessary settings from the application menu by choosing
Environment → EC-PCA configuration → Planning. See also: Plan versions [Page 171] and
Distribution Keys [Page 210].
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Plan Versions

Definition
Makes it possible to have different data for the same object. The following characteristics are the
ones you are most likely to use:

•  The type of assumptions you are making (optimistic/pessimistic)

•  The time of creation (original plan/forecast)

•  The extent to which the plan is intended as binding

Use
The plan data in Profit Center Accounting is contained in different plan versions. These plan
versions let you store separate sets of plan data for the same profit center. For example, you can
make a distinction between an operational plan and a strategic plan, or between an optimistic
plan and a pessimistic plan. You can display different plan versions as well as actual data in the
planning transaction, and use this data to calculate new plan data. You can also analyze and
compare your plan versions in the information system.

If you want to transfer plan data from other components of the R/3 System, such as Cost Center
Accounting, you also need to maintain the proper control parameters for Profit Center
Accounting.

Integration
A plan version is always valid for all of the CO Module. When you define a plan version, you also
have to maintain specific parameters for the applications in which you want to use it.

Structure
You normally maintain plan versions in Customizing. However, you can also do this from the
application menu by choosing the menu option Environment → EC-PCA configuration and then
double-clicking the option Planning: Plan Versions from the list.

To create a new plan version, choose the function New entries. For plan versions in Profit Center
Accounting, the field Plan must be active. Then you need to make the other settings for planning
in Profit Center Accounting. To do so, select the desired plan version and then choose the line
Settings for Profit Center Accounting in the navigation box. The system takes you to the screen
where you maintain the fiscal-year dependent control parameters for Profit Center Accounting.
To enter new fiscal years, choose Edit → New entries.

If the Lock indicator is active for a fiscal year, the plan is locked and can no longer be changed.
This makes it possible for you to protect a plan against changes when you are finished
maintaining it.

The Online data transfer indicator controls whether the plan data should be transferred
automatically by activity. If the indicator is not active, you need to transfer the postings by fiscal
year (see Posting Plan Data Subsequently [Page 176]).

The Line items indicator controls whether plan line items are updated in Profit Center Accounting.
The line item documents record every change made to a plan.
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You also need to specify an exchange rate type to determine which rate the system should use
to translated the plan data in that version. if you do not enter anything in the Value date field, the
system uses the first day of the month. By entering a specific date, you can translate all the
currencies using that date.
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Plan Data Transfer
Use
As with actual data, you can also transfer plan data from CO objects to Profit Center Accounting.

In contrast to actual data, however, you can store plan data in a number of different versions.
These versions have a uniform meaning throughout all of CO and Profit Center Accounting (see
Plan Versions [Page 171]).

This lets you summarize plan values from different CO objects with the same version in profit
centers.

There are two ways you can transfer plan data from the various CO objects to Profit Center
Accounting:

•  in realtime by activity (see Transferring Plan Data Online from Other Applications [Page 175])

•  subsequently using the manual posting function (see Posting Plan Data Subsequently [Page
176])

The plan data is always transferred from objects of short-term company planning
(planning period of one fiscal year) to Profit Center Accounting. The data from object
planning, such as the plan data for a specific production order, is not transferred.

The plan data from the various objects is valid for the same planning period and can
therefore be summarized in Profit Center Accounting.

To depict plan results using the period accounting method, you can create certain elements of
profits, such as changes in inventory or material direct costs, when you plan profit centers directly
(see Planning Profit Centers Directly [Page 182]).

Integration
See Integration of Profit Center Planning [Page 167].
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Prerequisites
As with actual data, you cannot transfer plan data until you have made all your Profit Center
Assignments [Page 76].
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Transferring Plan Data Online from Other Applications
Use
It is possible to transfer plan data realtime from cost centers and internal orders to Profit Center
Accounting for each activity. The system reflects every planning activity in Cost Center
Accounting and Internal Orders immediately in Profit Center Accounting. This lets you observe
the progress of your profit center plan.

Prerequisites
To use the realtime plan data transfer, you need to have done the following:

•  Activated the online transfer in the profit center part of the plan version

•  Activated the switch Plan integration on the fiscal year screen for the plan version in
Overhead Cost Controlling.

•  Activated planning integration for each order type for internal orders (see Customizing for
Internal Orders)
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Posting Plan Data Subsequently
Use
If you do not transfer plan data for CO objects to Profit Center Accounting online, you can post
this data en bloc for a single plan version and fiscal year under the function Planning → Plan
data transfer → CO plan data.

To select all the plan data of one object type (such as cost centers), enter that object type under
Objects. If you wish to select only certain values of that object type (individual cost centers or a
cost center group), you can enter these under Characteristic values.

Prerequisites
Note that you cannot repeat a transfer of individual objects unless you have activated the line
item update in Profit Center Accounting for this version. This is the only way you can delete
previously transferred plan data before you run the transfer again.

If you are not working with line items, you always have to post all objects of a given object type
(cost centers for example) when you repeat the transfer.

Features
You can post the following objects:

•  cost centers

•  internal orders

•  projects

•  business processes

•  networks

•  account-based profitability segments

•  SOP orders

•  MRP orders

•  real estate objects

The system reads the plan summary records for these objects and transfers them to Profit Center
Accounting.

Planned overhead (planned primary costs, results analysis, distribution, planned secondary
costs, assessment, and so on) is posted to profit centers via the assignment of cost centers and
internal orders.

For make-to-order production using the R/3 Projects System, you can transfer the plan data from
WBS elements or from networks.

Account-based profitability segments let you transfer revenues from revenue planning. The
prerequisite for this is that you specified the controlling area and profit center in Profitability
Planning.

SOP orders and MRP orders are objects in sales and production planning. Their purpose is to
provide a rough plan of the production activities required to realize the planned sales. The
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production plan for product groups is divided among the individual products, which are assigned
to profit centers.

A routing tells you which activities are required from which work center, and consequently also
from which cost center. These activities can be scheduled automatically for the cost center. This
makes it possible to allocate data between the profit center of the product and that of the cost
center involved. When transferring plan data from SOP and MRP orders, the scheduled
utilization of plan activities is therefore transferred to Profit Center Accounting.
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Transferring Plan Data from CO-PA to EC-PCA
Use
It is possible to transfer planned values and quantities periodically from costing-based Profitability
Analysis (CO-PA) to Profit Center Accounting. (Previously it was only possible to post plan data
subsequently from account-based CO-PA [Page 176].) To do so, you need to assign the value
and quantity fields in CO-PA to the accounts in Profit Center Accounting. You can define rules in
Customizing to derive the correct account in EC-PCA.

Prerequisites
The operating concern you want to transfer the data from in CO-PA must be generated.

In addition, plan data must exist for combinations of profit center, controlling area, and
company code in costing-based CO-PA. Note that when no profit center is found for a posting to
CO-PA, the system automatically assigns that posting to the dummy profit center. Plan data that
is not assigned to a specific controlling area and company code cannot be transferred to
EC-PCA.

Features
Initial Steps
You can define one or more derivation rules in order to determine an account to which certain
values should be posted. You can define up to six source fields for each derivation rule to use as
the basis for determining the account to which a certain value field should be transferred. These
source fields are the controlling area and the value or quantity field you want to transfer, plus
any combination of up to four other characteristics in CO-PA.

First derivation rule:

Source fields Target field

Controlling area Company code Partner profit
center

Value or
quantity field

Account

0001 0001 P100 REVEN 800000

0001 0001 P100 SAQTY 801000

0001 0001 P200 REVEN 802000

0001 0001 P200 SAQTY 802000

0001 0001 REVEN 800000

0001 0001 SAQTY 800000

In this example the system first assigns the revenue and sales quantity fields to different
accounts depending on which company code and which partner profit center the values are
assigned to. The last two lines represent external sales, where the partner profit center is blank.
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Second derivation rule:

Source fields Target field

Controlling area Company code Value or quantity field Account

0001 0001 FRACHT 471000

0001 0002 FRACHT 472000

In the second step, the freight costs are assigned to different accounts depending on the
company code.

It is possible to assign more than one value field to the same account. If you do, the system adds
their values together. You can also assign more than one quantity field to the same account,
provided that they have the same unit of measure. You can also assign both a value field and a
quantity field to the same account, so that values and quantities that belong together (such as
sales revenues and the corresponding quantity) are transferred in the same EC-PCA line item.
For more information on derivation, see the documentation for CO-PA, under characteristic
derivation [Ext.].

All values and quantities in CO-PA that are posted with a different +/- sign in Profit Center
Accounting need to be explicitly specified in Customizing. This is particularly important for value
fields that you transfer to credit accounts (such as revenues), which are negative in Profit Center
Accounting. As quantities in the actual system normally have the same sign as the currency
amounts which belong to them, plan quantities (such as sales quantities) should be negative on
the credit side. For more information, see the Implementation Guide for Profit Center Accounting,
under. Maintain +/- Sign Rules [Ext.]

Plan Data Transfer
You can execute the transfer from the application menu of either EC-PCA or CO-PA:

•  EC-PCA: Planning → Plan data transfer → Costing-based CO-PA

•  CO-PA: Planning → Integrated planning → Transfer plan to EC-PCA

When you carry out the transfer, you can specify selection criteria to determine which data you
want to transfer (data for a particular profit center, for example). Note that either a single value,
an interval, or an asterisk (*, for all values) must be specified for each characteristic.

In the processing rules, you can specify characteristics whose values you want to summarize.
This is not allowed for the characteristics controlling area, company code, and profit center,
since these characteristic values are required information in Profit Center Accounting.

On the Value Fields selection screen, you can select the value and quantity fields that you want
to transfer. If you select fields for which no derivation rules are defined in Customizing, those
fields cannot be transferred. In Customizing you can tell the system to display an error message
in such instances. For more information, see the documentation for Profitability Analysis, under
Influencing the Standard Derivation Procedure [Ext.].

The system only transfers those changes made since the last transfer to Profit Center
Accounting. That means that you can repeat the transfer as often as you like.

The log tells you what selection criteria, processing rules, and value and quantity fields you
defined, along with the number of objects that were selected and transferred without errors. If
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errors occur for an object, that object is not transferred. In the detail log, you can see which
objects were not transferred and what errors occurred. Once you have removed the errors, you
can transfer these objects again.
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Transferring Planned Statistical Key Figures
Use
There can be a number of reasons why you might want to plan statistical key figures. For
example, you may want to use them as a tracing factor for distributing or assessing data between
profit centers, or you may want to calculate other key figures with them in the information system.
In addition to planning statistical key figures manually for your profit centers, you can also
transfer key figures from Cost Center Accounting, including those transferred there from the
Logistics Information System (LIS) (see also Statistical Key Figures and Statistical Key Figure
Groups [Page 73]). These key figures can be transferred in realtime or subsequently in regular
intervals.

Integration
See Integration of Profit Center Planning [Page 167].

Prerequisites
Realtime Plan Data Transfer
Plan integration must be active for Controlling, and the online transfer to Profit Center Accounting
must be active for the relevant plan version.

If you activate the online transfer of statistical key figure data after going live with Profit Center
Accounting, you first need to create an initial balance with this function. For more information,
see Customizing.

Subsequent Posting
If you have already transferred statistical key figures to Profit Center Accounting, you need to
delete this data before repeating the transfer.

Features
To transfer planned statistical key figures, choose Planning → Plan data transfer → Statistical
key figures.
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Planning Directly in Profit Center Accounting
Use
You can plan profit centers directly in order to modify your planned profits or balance sheet items
for the individual profit centers. For example, it may be necessary to create or alter the following
items manually:

•  revenues, if you are not using account-based Profitability Analysis

•  changes in stock

•  capitalized internal activities

•  material direct costs in production planning

•  individual balance sheet items

•  statistical key figures

Prerequisites
When planning directly on profit centers, you can create plan data or alternatively change plan
data transferred from other CO applications. To do this, you require a plan version valid for the
fiscal year and a planning parameter (see General Requirements in Planning Process [Page
170]).

If, in Profit Center Accounting, you wish to access plan data transferred online or periodically, you
must use the plan version in Profit Center Accounting with which the plan data was transferred.
This is the case for displaying and changing plan data.

You can, however, also create an alternative plan for profit centers which you save in your own
plan version.

Features
To carry out direct planning, you can use various planning techniques. The planning techniques
help you to plan quickly and efficiently.

In the following sections, the following planning techniques are described:

•  Manual Planning Using Planning Layouts [Page 183]

•  Quantity-based Profit Planning [Page 217]

•  Automatic Planning: Copy [Page 220]

•  Assessment and Distribution [Page 321]
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Manual Planning with Layouts
Use
You can enter plan data manually in the following planning areas:

•  Costs and revenues

•  Balance sheet values

•  Statistical key figures

You do this using forms known as layouts [Page 280]. You can use the standard planning layouts
in the R/3 System or define your own layouts.

Features

Planning on the basis of flexible layouts has the following advantages:

•  You can define more than one lead column.

•  Flexible value columns let you

– Plan more than one column

– Plan quarters, half years, or years

– Centralize or decentralize your planning

– Plan in different currencies

•  You can define formulas in individual columns.

You can create various layouts for each planning area, with differing lead columns,
characteristics etc. for example. This allows you to set up multi-faceted planning, in order or meet
specific business requirements, such as version, half-year or quarterly planning.

Activities
You create layouts in Customizing for Profit Center Accounting, under Maintain Planning Layout
for Costs/Revenues [Ext.], Maintain Planning Layout for Balance Sheet Values [Ext.], and
Maintain Planning Layout for Statistical Key Figures [Ext.]

In Customizing, under Maintain Planner Profiles [Ext.], you have to assign each layout to a
planner profile
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Layout
Definition
A layout is a form that determines the layout of screens for entering data.

Use
In Profit Center Accounting, layouts are required for the following functions:

•  Manual entry of

− actual data

− statistical key figures

•  Manual planning of

− costs and revenues

− balance sheet items

− statistical key figures

Structure
All planning layouts have the following basic structure:

T i t l e

Headings

Lead columns Val.columns

The header (headings) of the layout contains a number of text lines that describe the object(s)
that can be planned using this layout. These contain the characteristics that were specified in the
General data selection of the layout.

The lead columns contain the dimensions that you plan. You can define several lead columns.
You create lead columns using SAP characteristics, such as profit center or account.

The value columns are where you enter your data. In other words, this is where you enter the
actual or plan values.
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A value column can contain any of the following:

•  characteristics

•  attributes

•  formulas

You define the three areas of a layout in Customizing for Profit Center Accounting.

•  Actual Data and statistical key figures: Actual Postings → Manual Entry using a Layout

•  Plan data: Planning → Manual Planning

Once you have defined a layout, you can only change it in Customizing. It is no
longer possible for you to change the layout from the application - that is, when
entering values.
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Standard Layouts for Plan Data
Definition
Layouts which SAP delivers as standard. You can use these standard layouts as templates for
your own layouts, or simply use them as they are.

Do not make changes on the actual samples delivered by SAP. Instead, make a
copy of them and make your changes here.

Structure
The following layouts are delivered as standard for profit center planning:

1. Profile SAP800: Profit center group planning (central planning)

•  Planning layouts for costs/revenues

8A-101 Account group/profit-center-group
Planning single accounts or groups of accounts for more than one profit center (in
profit center currency)

8A-103 Account group/profit center group + quantity
like 8A-101, plus planning of quantities

•  Planning layouts for statistical key figures

8A-301 Statistical key figures group/profit-center-group
Planning single statistical key figures or groups of statistical key figures for more than
one profit center

•  Planning layouts for balance sheet accounts

8A-401 Balance sheet account group/profit-center-group
Planning single balance sheet accounts or groups of balance sheet accounts for
more than one profit center (in profit center currency)

8A-403 Balance sheet account group/profit center group + quantity
like 8A-401, plus planning of quantities

2. Profile SAP801: Profit-center-planning (decentralized planning)

•  Planning layouts for costs/revenues

8A-111 Profit center/account group
Planning the accounts in an account group for a profit center (in profit center
currency)

8A-112 Profit center/account group/partner profit center
like 8A-111, plus each account distinguished according to partner profit center

8A-113 Profit center/account group + quantity
like 8A-111, plus planning of quantities

8A-114 Profit center/account group(partner profit center + quantity
like 8A-112, plus planning of quantities
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•  Planning layouts for statistical key figures

8A-311 Profit Center/statistical key figure group
Planning the statistical key figures in a statistical key figure group for a profit center

•  Planning layouts for balance sheet accounts

8A-411 Profit center/balance sheet account group
Planning the balance sheet accounts in an account group for a profit center (in profit
center currency)

8A-413 Balance sheet account group/profit center group + quantity
like 8A-411, plus planning of quantities

3. The following layout for profit center group planning (central planning) are delivered without
assignment to a profile

•  Planning layouts for costs/revenues

8A-106 Profit planning of profit center groups
Planning the quantity of a representative material for a profit center group and
valuating the quantity with transfer prices

8A-107 Profit planning of profit center groups
Planning the quantity of a representative material for a profit center group and
deriving the corresponding material direct costs

8A-108 (8A-118) Profit center planning of profit center groups
provides an overview of planned sales and balance quantities, as well as the
corresponding material input, all valuated with transfer prices. The profit is calculated
and displayed from these values.

8A-155 Three-year planning
Planning the accounts in an account group for one or more profit centers (in profit
center currency) for three consecutive years

8A-156 Profit center comparison
Planning the accounts in an account group for two profit centers (in profit center
currency) as a comparison (with form totals)

8A-165 Comparison of two plan versions over three years
Planning the accounts in an account group for one or more profit centers (in profit
center currency) for three consecutive years comparing two plan versions

8A-181 Planning with plan data as reference
Planning the change in accounts in an account group for one or more profit centers
(in profit center currency) comparing two plan versions

8A-182 Planning with actual data as reference
Planning the change in accounts in an account group for one or more profit centers
(in profit center currency) comparing two actual versions from the previous year

8A-186 Distribution to profit centers
Planning the sum and distribution as a percentage of plan values to accounts in an
account group for two profit centers (in profit center currency)

•  Planning layouts for statistical key figures
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8A-356 Profit center comparison
Planning the statistical key figures in a group for two profit centers as a comparison
(with form totals)

4. The following layout for profit center planning (decentralized planning) are delivered without
assignment to a profile

•  Planning layouts for costs/revenues

8A-COPA Transfer plan data from CO-PA
Processes plan data from costing-based Profitability Analysis

8A-116 Profit planning of profit centers
Planning the quantity of a representative material for a profit center and valuating the
quantity with transfer prices

8A-117 Profit planning of profit centers
Planning the quantity of a representative material for a profit center and deriving the
corresponding material direct costs

8A-118 Profit planning of profit centers
provides an overview of planned sales and balance quantities, as well as the
corresponding material input, all valuated with transfer prices. The profit is calculated
and displayed from these values.

8A-115 Profit center/account group/functional area
Planning the accounts in an account group for a profit center (in profit center
currency) with each account distinguished according to functional area

8A-157 Profit center quarterly planning
Planning the accounts in an account group for a profit center (in profit center
currency) with separate representation of the individual quarters and form totals

8A-161 Comparison of two plan versions
Planning the accounts in an account group for a profit center (in profit center
currency) with a comparison column for a different plan version

8A-162 Previous year comparison
like 8A-161, but with a comparison column for the same version from the previous
year

8A-163 Comparison of current plan/actual from previous year
like 8A-161, but with a comparison column for the actual data from the previous year

8A-191 Profit center in transaction currency
Planning the accounts in an account group for a profit center in transaction currency

•  Planning layouts for statistical key figures

8A-361 Comparison of two plan versions
Planning of the statistical key figures in a statistical key figure group for a profit
center, with a comparison column for a different plan version
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Defining Layouts
Purpose
In Profit Center Accounting, layouts are required for the following functions:

•  Manual entry of

- actual data

- statistical key figures

•  Manual planning of

- costs and revenues

- balances

- statistical key figures

If you do not wish to use a standard SAP layout, you can define your own layout according to
your own requirements.

Process Flow
•  Define the general data selection

•  Define the lead columns

•  Define the value columns

Define General Data Selections
The general data selections determine what data appears in the headings of the layout. The
characteristics specified in the general data selections (such as company code, version, fiscal
year) apply to the whole planning layout. You can define variables for the characteristics in both
the general data selections and the columns. Variables make it possible for the planner to specify
which value(s) of that characteristic he or she wants to plan.

In a layout for creating a document, you choose the characteristics company code
and transaction currency in the general data selections. You use profit center,
account and posting line in the lead column.

In a layout for cost and revenue planning, you choose the characteristics “Version”,
“Period”, “Fiscal year” and “Profit center” in the general data selections. The value
columns contain key figures.

In a layout for a quarterly comparison in the plan version, you choose the
characteristics “Version” and “Fiscal year” in the general data selections, and place
the period and the profit center in the lead column and value columns.

Defining Lead and Value Columns
The structure of the rows and columns depends on which of the EC-PCA standard characteristics
you choose.
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You must specify characteristic values to each characteristic that you choose. For example, you
might choose the characteristic “Profit center” and then specify the values “Profit center 4711”
through “Profit center 4719”.

Defining Lead Columns
There are two ways you can define lead columns:

1. You can define one or more lead columns by double-clicking on the column headers.

This allows you to select one characteristic for each column header.

Cost Planning

1st lead column 2nd lead column 1st value column

Profit center Account Plan costs

4711 - 4719 400 000 - 403 000

420 000 - 429 000

If you define your lead columns like this, the SAP R/3 System proposes all the possible
characteristic value combinations of the defined lead columns.

2. You can define a single lead column by entering individual objects in the rows.

This allows you to choose one characteristic for each row or combine several
characteristics.

Version Planning

Lead column 1st value column

Version/quarter Plan costs

Version 1/quarter 1

Version 2/quarter 1

Version 1/quarter 2

Version 2/quarter 2

When you define a lead column this way, you can select specific characteristic values.

Defining Value Columns
There are three different classes of value columns:

1. You can define a column using a key figure with characteristics or using characteristics only.

In the dialog box for the first value column, you determine whether to use a key figure
with characteristics or only characteristics.
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To define a value column of the element type “Key figure with characteristics”, choose
one key figure from the list of existing key figures. Then you can specify characteristics
and characteristic values.

To define a value column of the element type “Characteristic”, choose characteristics and
then assign characteristic values.

2. You can define an attribute column.

Depending on the attributes used, you have two options for defining attribute columns.

– Attribute columns that directly apply to a value column

The attributes Distribution key, Unit, and Action should be assigned to a value
column. To create an attribute in this way, choose Edit → Columns → Append
add. fields.

– Attribute columns that do not directly apply to a value column

You can define all other attribute columns by double-clicking on the blank space next
to a column.

The Long text indicator shows which data records have long texts defined for them
when plan or actual data are created.

3. You can define a formula column

Formula columns are based on the values of columns already defined. You can see the
available value columns in the dialog box where you define the formula. The system
calculates the formula columns when you enter the values in the corresponding value
columns.

Defining Inverse Formulas
Inverse formulas let you enter values in a formula column and then have the system calculate
values for another column. To read about how to define an inverse formula, see Customizing.

You plan to give your employees a raise in the form of a percentage. You want the
system to calculate the plan value of the current year based on the percentage and
plan value of the previous year.

1. Define the following layout:

Layout

Lead column Value column 1 Value column 2 Formula column

Cost element Plan, current year Plan, previous year % raise
((Plan current -
Plan previous)
/Plan previous) x
100

Lock the column Plan, current year against user input and make the column % raise
as ready for input. Afterwards, create the inverse formula.

2. Plan (example):
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If you copy plan values from the previous year to the current year before beginning
manual planning (Planning → Copy plan template), you can then calculate the new
plan costs by entering the percentage raise.

After Copying the Plan Data

Cost Element Plan, Current Year Plan, Prev. Year % Raise

430000 50,000 50, 000 0

After Entering the Increase Manually

Cost Element Plan, Current Year Plan, Prev. Year % Raise

430000 50,000 50, 000 10

After Calculating the New Planning Costs

Cost Element Plan, Current Year Plan, Prev. Year % Raise

430000 55,000 50,000 10
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Entering and Displaying Plan Values
Prerequisites
A suitable planning layout has already been defined for you, or you use one of the standard
planning layouts delivered with the R/3 System. This planning layout must be contained in the
planner profile that you are working with (see Maintaining a Planner Profile [Page 199]).

Procedure
To access the planning function, choose one of the following:

Planning → Costs/revenues → Change

Planning → Balance sheet accounts → Change

Planning → Statistical key figures → Change

If you have not already specified a planner profile in this session, the system displays a dialog
box in which you need to specify one.

Then the system displays the planning screen.

It is possible to define planner profiles so that users can enter their plan data in a
Microsoft Excel spreadsheet integrated in the R/3 user interface. For more
information, see Integrated Excel Integration in Planning [Page 201].

Now make the desired entries on the following screens:

1. Characteristic screen [Page 290]

2. Overview screen [Page 196]

3. Period screen [Page 296]

Result
To display the plan data you entered, choose one of the following:

Planning → Costs/revenues → Display

Planning → Balance sheet accounts → Display

Planning → Statistical key figures → Display
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Characteristic Screen
Procedure
Most layouts usually contain variables for certain characteristics (profit center, account, and so
on). By entering individual values for these variables on the characteristic screen, you specify
which characteristics you want to plan/enter in this session.

If default parameters were set for a characteristic when the corresponding layout was defined,
this characteristic appears on the characteristics screen, but cannot be changed. Instead, the
value displayed is a fixed value, corresponding to the value assigned to the characteristic when
the layout was defined.

1. In all fields not containing fixed values, enter the characteristic values and/or groups or
intervals of characteristic values for which you want to plan/enter data.

If you plan costs and revenues in the transaction currency, see Currencies in
Planning [Page 224].

2. If no default parameters have been set here, specify whether you want to perform “free” or
“form-based” planning.

If you select Free, the system displays all the objects (characteristic values) that meet
the selection criteria and already have data entered to be changed. In addition, you can
add further objects and plan these as well.

If you select Form-based, the system displays all those objects that meet the selection
criteria, regardless of whether or not plan data has been planned/entered for them. Each
time you call up a form-based layout, the system displays the same structure of
characteristic values. You cannot add any new characteristic values.

You enter/plan statistical key figures centrally for all profit centers belonging to the
profit center group “ABC”. On the initial screen of the planning transaction, you enter
profit center group “ABC”. This group contains profit centers 4110, 4120, 4130 and
4140. No values have yet been entered/planned for profit center 4110.

If you select Free, the system displays profit centers 4120, 4130, and 4140 along
with the corresponding plan data. The system does not offer you the possibility of
changing profit center 4110. You can add the profit center you still want to enter/plan.

If you select Form-based, the system displays all profit centers from the above-
mentioned group which are to be entered/planned; it is not possible in to add extra
profit centers to these rows.

3. Choose  to display the layout as it was defined in Customizing for Profit Center
Accounting.

You cannot make any changes here, as the purpose of this screen is merely to display
how the data was entered.

In Planning, the following functions are available:

−  Profile
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Displays the current planning profile with the corresponding layouts.

−  or 

Allows you to scroll between characteristic screens of the other layouts in the current
planning profile.

4. Return to the characteristic screen. By choosing  you can go to

− the entry screen [Page 292] for actual document entry

− the overview screen (plan data) [Page 196] for planning

− the overview screen (statistical key figures) [Page 294] for entering statistical key
figures
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Overview Screen (Plan Data)
Procedure
Once you have entered values for variables, you can enter your plan figures on the overview
screen. The overview screen is designed like the planning layout. Before displaying the overview
screen, the system reads the plan figures from the database for the profit centers you want to
plan, and summarizes them according to the specified characteristics. When you post new or
changed plan data is posted, the system leaves any unspecified characteristics blank. An
exception here is the origin object type - which is always 01 (Origin: Profit Center Accounting) -
and the quantity unit, which is derived automatically if you are planning statistical key figures.

To prevent several users planning a profit center simultaneously, the system locks the objects
you want to plan.

On the overview screen, proceed as follows:

1. Enter plan data for the characteristic combinations you have selected.

When planning on the overview screen, the system distributes data according to the
default distribution key if you have not entered another distribution key.

Note that, in contrast to previous Releases, fixed values (statistical key figures of
type 1) can only be planned for previously selected periods. The fixed value is no
longer updated in later periods.

2. The following functions are available here:

Format to Print [Ext.]

Cut [Ext.]

Copy [Ext.]

Paste [Ext.]

Change values [Ext.]

Goal seek [Ext.]

Insert [Ext.]

Clear row, redo, undo [Ext.]

Overview screen [Ext.]

Period screen [Ext.]

Next combination, previous combination, other combination [Ext.]

Next layout, previous layout [Ext.]

Number format [Ext.]

Lead columns [Ext.]

All key values on/off [Ext.]

Header display on/off [Ext.]
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3. You can create long texts for individual data records by selecting the desired row and then
choosing Edit → Planning functions → Long text. The key of the long text can contain the
following characteristics:

Ledger, record type, version, fiscal year, controlling area, profit center, account,
statistical key figure, company code, partner profit center, plant, representative material.

Note that it is not possible to write separate long texts for records with different
characteristic values. For example, you cannot define two long texts for records that
have different functional areas but are the same in all other characteristics.

4. Save your entries.

The data you enter or change is written to the database. All unspecified characteristics
remain blank.
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Period Screen
Procedure
On the period screen, you can display and change the distribution of your statistical key figures
or plan data to periods. To reach the period screen, proceed as follows:

1. On the overview screen, position the cursor on an entry and then choose Period screen.

2. You can either use the default values provided by the system or enter your own period
values.

If desired, you can set a distribution key other than the default one provided by the
system in the overview screen. This allows you to distribute the data to periods
differently.
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Defining a Planner Profile
Use
Planner profiles are used to control the planning process. They are structured hierarchically. In a
planner profile, you specify which planning layout will be used for each planning area
(costs/revenues, balance sheet accounts, or statistical key figures).

The planning layouts are assigned to lines of the planner profile. You can create any number of
lines for each planning area. The order of these lines determines the order in which a user
working with this planner profile receives the planning layouts. It is also possible to enter the
same layout in different lines, but specify different parameters each time.

Planner profile PROFILE1 is assigned to the planning area “Costs/revenues”. It
contains two lines, each of which has planning layout PL01.

In line one, the planning layout contains version 1, while in line two it contains
version 2.

In planning, the user working with this planning layout can use the functions Next
layout and Previous layout to scroll back and forth between these layouts.

You can only plan using planning layouts if you work with a planner profile.

Features
You can specify the following in a planner profile:

•  By assigning an authorization group to a planner profile, you can control what objects your
users are authorized to process. This is particularly important for decentralized planning. You
can design planner profiles specifically for each planner and assign an authorization group to
these planner profiles to ensure that each planner plans only in his or her authorized area.

•  If you select the Auto. valuation indicator, you can have the system automatically valuate the
planned representative material quantities when you save your plan data (see Quantity-
Based Profit Planning [Page 217]).

•  If you select the Mat.costs auto. indicator, you can have the system derive material direct
costs for the changed quantities when you save your plan data.

•  If you would like to process your plan data in Microsoft Excel using the planning layout, select
the Integrated Excel indicator. If you do this, you also need to enter a File description or have
the system define one. For more information on integrating Excel, see Setting Up Integrated
Excel [Page 203].

•  By specifying fixed parameters for each planning layout in the planner profile, you can
ensure that your planners only plan specific objects. You can also specify whether the
user should be able to overwrite these values, or you can forbid this by selecting the
appropriate indicator in the planner profile. In planning, the R/3 System asks you to
replace the variables defined in the planning layout.
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For users who always work with the same planner profile, you can specify this in their user
parameters using the parameter ID PPP. You do this by choosing System → User profile → Own
data.

For more information about defining planner profiles, see Customizing.

Standard Planner Profiles
The following planner profiles are predefined in the standard R/3 System:

•  Profile SAP800: Profit Center Group Planning (Centralized)

•  Profile SAP801: Profit Center Planning (Decentralized)

For a list of the planning layouts contained in these profiles, see the section Standrad Layouts for
Plan Data [Page 186].



 SAP AG Profit Center Accounting (EC-PCA)

Integrated Excel in Planning

April 2001 201

Integrated Excel in Planning
Use
For planning with integrated Excel, Microsoft Excel is used as a planning screen for your
planning data in the SAP System. This allows you to combine the comfort of Excel's formatting
and data processing functions with the powerful planning functions of your SAP application. You
are therefore able to use the Office input interface with online planning in the SAP System.

There are two ways of using Excel to plan your data:

•  Planning with Excel integrated into the user interface of the SAP System

Excel replaces the standard SAP planning screen. This enables you to plan using the
functions of both the SAP System and Excel.

•  Offline planning in Excel and uploading data into the SAP System

From one or more PCs that are not connected to the SAP System, you can enter your
planning data into several Excel spreadsheets. This data can then be uploaded into the
SAP System, where you can process it further using the SAP planning functions.

Prerequisites
Software
To be able to plan using integrated Excel, the following should be installed on your PC:

•  The Windows NT 4.0 or Windows 95 operating system

•  Microsoft Excel 97

•  A current SAP GUI (32 Bit) matching your System Release

Hardware
To ensure good response times, your PC should have a Pentium II processor and 64 MB RAM.

Features
In Customizing, you can define Excel spreadsheets for use as templates in planning. In those
templates, you can move data around, insert graphics, define macros, and format text and cells.
You can use this template to plan with integrated Excel or to plan with the upload function.

Link between Excel and the SAP System
From the technical point of view, Excel is called up by the SAP System using OLE (Object
Linking and Embedding), an interface in the Office programs. Integrated Excel into the SAP
System allows you to use the same Excel functions that are available with the integration of
Excel in Word, for example.

On a more detailed level, the link between the Excel spreadsheet and the SAP planning layout is
created above the position of the data in the Excel spreadsheet:
The SAP System uses Customizing to determine which SAP data is in Excel and where it can be
found. The position of the data cannot be changed in the planning screen to ensure that the data
is imported correctly. The fields of the planning layout are mapped to the Excel spreadsheet
using File Description [Ext.].
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Constraint
You cannot use integrated Excel to enter any planning data in the period screen.

Activities
Initial Steps
To be able to use Microsoft Excel as your planning screen, you need to activate the indicator
integrated Excel in Customizing for your application when Setting Up The Planning Framework
[Ext.] (only CO-PA), or when you assign your planning layouts to a planner profile.

In Customizing, you can also design an Excel spreadsheet to be used as a template for planning
in Excel.

For more information about setting up integrated Excel, see Setting Up Integrated Excel [Page
203].

Planning in Excel
•  Excel integrated in the SAP interface

To plan directly in the SAP System using integrated Excel, you can choose between
executing a corresponding parameter set (only CO-PA) or using a planner profile in
which Excel was activated as the planning screen for one or more layouts. You enter
your planning data in Excel and can use Excel functions such as macros or diagrams as
well as all the usual SAP planning functions. For more information on planning with
integrated Excel, see How To Plan Using Integrated Excel [Page 206].

•  Planning in Excel and uploading data into the SAP System

The Excel template created in Customizing can be copied as often as required and used
to create planning data in Excel. By using the uploading function for Excel, you can
transfer the individual files into the SAP system. This means that planning data can be
entered into different PCs, local planning thereby being possible. For more information
on the required procedure, see Planning Offline and Uploading into the SAP System
[Ext.].
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Setting Up Integrated Excel
Prerequisites
Your Planning Layouts [Ext.] must be defined.

If you want to change a planning layout for which you have already created an Excel
template, you must create a new Excel template.

For technical reasons, it is necessary that the system already contain planning data that
corresponds to the planning layout (at least one row) before an Excel spreadsheet can be
formatted as a template. If no such data is present in the system, you need to create some. One
way of doing this is by entering data into the appropriate layout without integrated Excel.

Procedure
Activating Excel
Depending on the application you are working in, you should proceed as follows:

•  In Profitability Analysis (CO-PA), you set the integrated Excel indicator to "active" when
you define a parameter set for the planning method Enter planning data or Display planning
data (for more information, see the section Set Up Manual Entry of Planning Data [Ext.]).
When you first select this parameter set in the planning framework, the structure that you
specified in the planning layout is represented in the upper left-hand corner of an Excel
sheet.

•  In the other applications, select Integrated Excel in Customizing on the Define Planner
Profiles screen when you assign planning layouts to the planner profile. This activates Excel
as the planning tool for that layout in that planner profile. When you enter planning, the
system displays the planning layout you defined in the upper left-hand corner of an Excel
spreadsheet.

When moving the planning layout, you can enter a specific name for the file description.
This makes sense, for example, in cases where you intend to use the file description
several times. If you do not enter anything here, the system automatically creates a file
description when you save your planner profiles. This file description will reflect the
position in the profile.

If you want to customize a particular spreadsheet to be used uniquely with that layout
in planning, you need to define an appropriate template (see "Defining an Excel
Template").

If you want to upload an Excel spreadsheet, you need to edit an Excel sheet
template in order that the system can generate a file description. This file description
is required for the upload. Furthermore, you need to make several additional settings
(see Planning Offline and Uploading into the SAP System [Ext.]).
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Defining an Excel Template
1. CO-PA: Execute the planning method Enter planning data, using the related parameter set.

Doing so takes you to an unformatted Excel sheet. There you choose Settings → Formatting.

Other applications: In the IMG for defining the planner profile, choose Default
Parameters and enter values for the variables defined in the planning layout. You must
do this so that you can open the spreadsheet in the next step. If desired, you can delete
these entries again after you have customized your Excel template.

To open Excel in the SAP window, choose .

2. In the Maintain File Description screen, you can now customize an Excel spreadsheet as a
template for your planning screen.

Note the following:

− To move planning data within the spreadsheet, only use the appropriate SAP
function. To do this, select the data you want to move using , and then position the
cursor on the target location and choose . You save the link between the old position
and the new position of the data by choosing  Save file description [Ext.].

− The first Excel spreadsheet is protected. Cells that were not locked against entries in the
SAP entry screen, such as those that can be defined in the planning layout, are excluded
from this protection in Excel. If you want to use functions in Excel that extend beyond
editing those cells where entries can be made, you first need to remove the general
spreadsheet protection in Excel.

After editing, you should then reactivate the spreadsheet protection in Excel to
ensure that, for subsequent planning, the only data that can be entered corresponds
to that specified in the SAP System.

− You can use the Excel formatting functions (such as different fonts or colors) to format
the Excel template.

− You can use Excel to create diagrams, macros and formulas and then use these for
additional calculations, for example. It is recommended that you insert these into a
second spreadsheet to avoid the data conflicting with the actual R/3 planning data later.
The SAP planning data is imported from the first spreadsheet only.

− When you enter formulas in the SAP data area in Excel, they are overwritten by the
formula result during posting, and the formulas themselves are then discarded.

− You can save the Excel formatting in the SAP System by choosing  Save Excel layout.

3. If you later want to upload files from your PC to the SAP System, you must enter a generic
file name [Ext.] (see the section Planning Offline and Uploading into the SAP System [Ext.]).

4. Choose  in the toolbar. This function will also save the file description and the Excel
template.

Data saved with this function is permanent from then on.

5. Choose .
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CO-PA: You then return to the planning framework.

Other applications: You return to the Default Parameters screen. Delete any values you
entered for the variables if you do not want to have them displayed as the template in
planning. Choose .

The default parameters are only saved temporarily at this point.

For this reason, you should then finish by saving the planner profile. Only then does
the system assign a definitive file description to the planning layout and save the
values for the variables are saved permanently.
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How To Plan Using Integrated Excel
Prerequisites
To be able to use Microsoft Excel as your planning screen in the SAP System, you need to make
the appropriate settings either in Customizing under Define Planner Profile or when defining the
parameter set for the Enter planning data planning method (CO-PA only). For more information,
see Setting Up Integrated Excel [Page 203].

Procedure
1. CO-PA: Execute the planning method Enter planning data using a parameter set for which

Excel has been activated as the planning tool. This automatically calls up Excel within the
SAP window.

Other applications: Enter planning using a planner profile and choose a planning layout
for which integrated Excel has been activated. To open Microsoft Excel in the SAP
System window, choose . (It is not possible to use Excel to create planning data in the
period screen.)

− If you have used Customizing just to set the indicator for integrated Excel and no special
formatting has been made in the Excel template for this planning layout, the system
displays the planning data unformatted in the upper left-hand corner of the spreadsheet.

− If you have formatted an Excel template in Customizing, the system opens this template
in Excel.

2. Enter your planning data.

Note the following:

− You must avoid any use of the following Excel functions:
- Delete
- Paste
- Sort
Use of the above functions prevents data from being imported correctly into the SAP
System.

− If you want to delete data, choose  in the SAP System.

− Enter new objects for planning directly beneath the existing SAP data (where
appropriate, beneath the totals row). To paste, use the SAP possible entries function
(available via ). Note that the system does not recognize data that is separated from
the existing SAP planning data by an empty row.

− You can sort additional data into existing data by choosing Edit → Sort in the SAP
menu.

− If the Excel spreadsheet is protected, then the entries that can be made in the individual
cells correspond to those specified in the SAP System.

− You can access SAP possible entries by choosing ..

− The SAP System only imports data from the first spreadsheet in an Excel folder. You can
perform additional calculations or add diagrams on a second spreadsheet. These
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calculations and diagrams are only kept during your planning session if they have not
already been created in Customizing.

− When you enter formulas in the SAP data area in Excel, they are overwritten by the
formula result during posting, and the formulas themselves are then discarded.

− If you want to save, use an SAP planning function or run a validity check, you need to
make sure that no cell is currently being edited in Excel. You can control this by
displaying the "Formula Bar" in Excel (choose View → Formula bar).

− To run a validity check for the data you have entered, choose  in the SAP System.

3. Post the data by choosing .

You then return to the initial screen.
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Uploading Data from Microsoft Excel
Use
The function Planning in Integrated Excel allows you to edit your EC-PCA plan data in Microsoft
Excel instead of using the R/3 user interface, and upload this data directly into the R/3 System.
For more information, see Integrated Excel in Planning [Page 201]. It is also possible to save the
data you create in Excel on your PC, and upload it into Profit Center Accounting later using the
"Flexible Upload" function. Before you can do this, you need to have carried out a number of
preparatory steps.

Prerequisites
To use Excel with a particular planning layout, you need to define that layout and assign it to a
planner profile (see Layout [Page 280] and Defining a Planner Profile [Page 199].)

When you define the planner profile, enter a file description for the desired layout on the Layouts
for Profit Center Accounting screen. The file description maps the fields of the planning layout to
the Excel spreadsheet.

To map the Excel files stored on your PC with the corresponding file description, you also must
enter a generic file name (such as "SALES*.TXT") for the Excel files that you want to have
loaded. To do so, choose the Overview icon on the Default Parameters screen, then choose
Generic file.

Then save the Excel layout on your PC by choosing File → Save as... In this file you can then
create and save the plan data you require.

Because R/3 interprets each row of the layout as a separate object when you upload, you need
to delete all the totals rows from the spreadsheet, otherwise these will be written to the database
as separate objects.

The system uploads exactly those objects that are stored in the file. For example, if you want to
delete a profit center before uploading, you should enter the value "0" for that object. If you
remove the profit center entirely from the spreadsheet, R/3 will not set its value back to zero.

You need to save the Microsoft Excel file in.TXT or .CSV format before uploading.

Features
When the above requirements are met you can upload Excel files by choosing Planning → Plan
data transfer → Upload Excel file → Execute from the EC-PCA application menu.

The system asks you to specify a controlling area. You can upload data from a single file or from
all the files in a single directory. When you upload data from more than one file, the system
creates a few files on your PC. These files are overwritten every time you carry out an upload.

Before you upload an entire directory, make sure that you have no files with the
names dir_file.TXT or dir_file.BAT in that directory. If you do, rename those files,
otherwise they will be overwritten.

Specify which type of decimals you have used in your Excel files. For .CSV files, you also must
specify what character separates the fields. For.TXT files, the system always assumes that TAB
separates the fields.
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Once you have carried out the upload, you can check the log by choosing Planning → Plan data
transfer → Upload from Excel → Log.
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Distribution Keys
Definition
The distribution key is a tool used in planning which enables you to distribute an annual plan
value over the plan periods according to your requirements.

Use
Distribution keys are available for use by all CO applications. If a new distribution key is created
in one application, all other CO applications will have access to it in planning too.

Structure
Various standard distribution keys exist in the system which you can use but not change. If
necessary, you can create your own distribution keys.

The following standard distribution keys are available:

Distribution key Effect

0 Manual distribution to periods

1 Equal distribution of annual plan value to periods

2 Distribution as before

3 Value entered interpreted as percentage and multiplied by the previous
value of the period

4 Periods containing a value distributed to following periods containing no
value

5 Periods containing a value copied to following periods containing no value

6 Individual period value copied to following period

7 Annual plan value distributed according to the number of calendar days per
period

For the transfer of plan data itself, a distribution key is not required as the data is transferred with
period distribution. You can, however, change the distribution key for transferred plan data using
Plan data → Change.

If you plan profit centers directly, you can distribute your annual plan value to the plan periods
using various distribution keys. When planning on the period screen, the distribution key is
automatically set to 0 for manual distribution.

You normally maintain distribution keys in Customizing. However, you can also create, change,
display or delete distribution keys from the application menu by choosing the menu option
Environment → EC-PCA configuration and then double-clicking on the line Distribution keys from
the list. To create a distribution key, enter a short description, then enter a relative factor per
period. This factor is then used for the distribution of the annual plan value.
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Formula Planning
Use
Formula planning supports manual planning. In order to plan costs/revenues, balance sheet
items and statistical key figures, you can use mathematical dependencies. You can set these
mathematical dependencies in Templates [Ext.] as formulas, which are not specific to a profit
center. This means that you can use the same formula again and again for various profit centers.

For the purposes of Formula Planning, you create templates and assign them to one or more
profit centers. You can also define sub-templates, which you can reference from the higher level
templates.

You can use the following data from the SAP system in Formula Planning:

•  all master data information relevant to profit centers, for example to narrow definitions

•  all statistical key figures

You can plan costs/revenues, balance sheet items and statistical key figures. These can be
calculated from existing plan or actual data.

The SAP system calculates costs in the template using only the profit center local
currency.

In addition to profit centers, formula planning is also possible for business processes and cost
centers.

Prerequisites
You must have created a template and assigned the required profit centers to the template in
master data maintenance (see Activities).

Features
Formula planning includes the following functions:

•  Template maintenance

− In template maintenance, you can define one or more formulas for an object
(cost/revenue element, balance sheet account or statistical key figures) on separate lines
or rows to calculate plan values (see Formulas [Ext.]). The SAP System evaluates these
formulas by calculating objects (cost element, statistical key figure or calculation row) a
line at a time. You can use simple formulas to link functions (see Functions in
Environements [Ext.]) which enable the system to read plan or actual values.

− With interim results, which you can depict in calculation rows [Ext.], you can calculate far
more complicated formulas. With activations (see Activation [Ext.]) you can also build in
requirements under which a formula operates

•  Execution of formula planning and evaluation of the template (see: Executing Formula
Planning [Ext.])

− The system evaluates the template for a profit center or profit center group at company
code level.
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− The SAP system applies the formula defined in the template, and calculates the desired
values from them. The system then calculates each line in the template for the
corresponding profit center. It also creates a plan record for the cost/revenue element,
balance sheet item or statistical key figure in the corresponding profit center.

If you execute formula planning more than one, the plan values are not replicated.
The most recent execution always overwrites the previous values. Formula planning
overwrites manually planned values. On the other hand, manually enterd plan values
can also overwrite formula planning values.

Postings from other applications, which already exist in an account because of
planning integration, are not overwritten by formula planning. The only value that is
posted here is the difference between the existing value and the value calculated by
formula planning. As a result, the formula planning value is in the account. Further
postings from other applications are added to this value.

− During execution of formula planning, you can enter all or any profit centers or profit
center groups. The SAP System searches for the corresponding template and evaluates
it. You can start the evaluation as many times as you want for a profit center or profit
center group.

Activities
1. Create a templae in environment PCA.

For further information, see Templates for Profit Center Formula Planning [Page 213]
and Planung → Formula Planning → Define Templates [Ext.] in Customizing for Profit
Center Accounting.

2. Assign a profit center to a template.

For further information, see Templates for Profit Center Formula Planning [Page 215]
and Planung → Formula Planning → Assign Templates to Profit Centers in Customizing
for Profit Center Accounting.

3. Execute formula planning.

For further information, see Executing Formula Planning [Ext.].

Normally, you should be able to execute profit center formula planning adequately using the
standard SAP environments, function trees and functions However, should you have
requirements which are not covered by these standard provisions, you can define your own
environments, function trees and special functions. See the detailed guide to creating templates
in the SAP Library under Activity-Based Costing.
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Templates for Profit Center Formula Planning
Use
You create templates [Ext.] for profit center formula planning in environment PCA.

You can choose between six item categories for each row in the template. Depending on the item
category you choose, you will have the following columns available for data entry:

Item category Columns available

Comment row Description

Subtemplate Object, description, activation condition

Statistical key figure Object, description, planned quantity per period, activation condition

Calculation row [Ext.] Object, description, planned quantity per period, activation condition

P&L account Object, description, plan amount per period, planned quantity per
period, activation condition

Balance sheet account Object, description, plan amount per period, planned quantity per
period, activation condition

You have the following entry and maintenance possibility per column type:

Column type Possible entries/processing

Item category Comment row, subtemplate, statistical key figure, calculation row,
P&L account, balance sheet account

Object Depending on the item category chosen: Statistical key figure,
calculation row, P&L account, balance sheet account

Description Description for the row

Plan amount per period

Planned quantity per period

You can specify these values as constants, or you can have the
system calculate them dynamically at the time of evaluation - the
corresponding Editor is accessible (for procedures on the Editor,
see: Quantity Determination [Ext.]).

Activation condition You can enter Active or Inactive as fixed values, or you can
define a method that allows the R/3 System to activate or
deactivate the item when the valuation occurs (see Activation
[Ext.]) .

If you choose item category calculation row, the editor cannot be called up in the
object columns.
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For further information on working with templates, see Maintaining Templates [Ext.] in the SAP
Library.
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Assigning Templates for Formula Planning
Procedure
1. In the application menu for Profit Center Accounting, choose Master Data → Profit Center →

Individual Processing → Create.

2. On the initial screen, choose the profit center to which you want to assign a template.

3. On the Indicator tab in the Template field, enter the name of the template which you want to
use for planning with the profit center. Here, you can use all templates created for the
environment PCA.

4. Save your entries.

Result
When you execute formula planning for the corresponding profit center, the system will use the
assigned template to find costs/revenues, statistical key figures and/or balance sheet items on
the basis of the stored mathematical dependencies.
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Executing Formula Planning in Profit Center Accounting
Prerequisites
You have

•  created a template in the PCA environment (see: Templates for Profit Center Formula
Planning [Page 213])

•  assigned this template to at least one profit center (see: Assigning Templates for Profit
Center Accounting [Page 215]).

Procedure
1. In the application menu for Profit Center Accounting, choose Planning → Execute Formula

Planning.

2. Enter the company code(s) and the profit center(s) or profit center group for which you want
to calculate plan values according to the template in question.

If you do not enter a company code, the system performs the calculation with all
company codes assigned to the chosen profit center.

3. Enter a plan version, period and fiscal year.

4. Choose Test run if you do not want to post the results yet.

Choose Detail list to check the results of the evaluation.

Where large amounts of data are involved, formula planning should always be
executed in the background in order to avoid bottlenecks in the system.

5. Choose .

Result
The system displays the calculated plan values in the detail list. Double-click on the processing
category Number of Calculated Values. The system now displays cumulated values for the entire
execution period:

•  For P&L accounts and statistical key figures of type agg. value, the corresponding period
values are added.

•  For balance sheet accounts and statistical key figures of type fixed value, the average value
is displayed.
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Profit Planning
Use
By defining a suitable planning layout, you can plan goods movements by entering quantities of
representative materials. The system valuate these quantities with transfer prices from the profit
center view.

This allows you to plan sales quantities instead of revenues. The system uses transfer prices to
calculate the corresponding revenues. The system reads the corresponding material direct costs
from a material cost estimate.

It is also possible to plan stock changes with transfer prices. To do this, the system reads the all
material direct costs with transfer prices from the material cost estimate.

Integration
This planning function is integrated with transfer pricing and the material cost estimate.

Prerequisites
To valuate plan quantities with transfer prices, you need to store transfer prices from the profit
center valuation view in your system (see Transfer Prices in Profit Center Accounting [Page
121]).

To read material direct costs, the standard costs of goods manufactured from the profit center
valuation view must be stored in your system (see Updating Parallel Values in Material Costing
[Page 148]). Since material direct costs can only be determined here for representative materials,
you also need to define and activate the necessary representative materials (see Representative
Materials [Page 68]).

You have made the necessary settings in Profit Center Accounting Customizing for valuating
quantities and deriving material direct costs. For more information, see the Implementation Guide
(IMG), under Profit Planning [Ext.].

Features
Carrying Out Valuation
Enter the plan quantities in a suitable layout (see below). You can define the corresponding
revenues and costs in two ways.

1: Automatic derivation whenever you save the planned quantities
Select the following fields in the costs/revenues row in the planner profile:

•  Valuate with TP if you want the system to valuate the planned sales quantities with transfer
prices when you save your entries in the planning layout.

•  Mat.costs auto if you want to derive the costs for the planned sales quantities using material
direct costs with transfer prices when you save your entries in the planning layout.

•  TP:Valuate Changes in Stock if you want to derive the costs for planned stock changes using
the cost of goods manufactured with transfer prices when you save your entries in the
planning layout.
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2: Manual derivation
Do not select the fields mentioned above in the planner profile. Instead, after entering the plan
quantities in the layout, choose the required rows and then the required buttons.

•  If you choose Valuate with TP, the system will valuate the planned sales quantities with
transfer prices.

•  If you choose Derive Mat. Costs, the system will derive the material direct costs for the
quantities in question with transfer prices.

•  If you choose Valuate Changes in Stock, the system will derive the cost of goods
manufactured for the planned changes in stock with transfer prices.

Planning Layouts for Valuation
You can valuate plan quantities with transfer prices using special planning layouts (see Defining
a Layout [Page 284]). You can copy the standard SAP planning layouts and use these as
templates.

Standard SAP layouts for Profit Planning

•  In layout 8A-106 (8A-116), you can enter plan quantities for certain profit centers (profit
center groups). After you have carried out valuation with transfer prices, the corresponding
revenues are displayed in the same layout.

•  If, in addition to the revenues for a profit center (profit center group), you also want to derive
the corresponding costs, you can display these in layout 8A-107 (8A-117).

•  Layout 8A-108 (8A-118) provides an overview of planned sales and balance quantities, as
well as the corresponding material input, all valuated with transfer prices. The profit is
calculated and displayed from these values.

When you create your own layouts, be sure to include the following information in the header or
in the columns of your layouts:

− Fiscal year

− Account number

− Representative material

− Plant

− Quantity

− Unit of measure

− Value field

You can only valuate quantities and determine costs if this information is defined in the layout. If
transfer prices in your organization are dependent on the partner profit center, you also need to
define a column for the partner profit center in your layout.

Plan reconciliation report
Once you have derived your plan data, you can execute a standard SAP plan reconciliation
report. This provides a comparison at totals record level between the planned revenues of a profit
center and the planned costs of its partner profit center.
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Automatic Planning: Copying to a Plan
This function lets you copy existing transaction data to create a new plan in Profit Center
Accounting. For example, it might be useful to use the actual values of the current year as a
basis for you plan for the coming year.

You can find the function in the Profit Center Accounting application menu by choosing Planning
→ Copy Data to Plan.

1. Enter a planning area.

2. Specify which data you want to copy.

3. Specify where you want to copy the data.

4. If you want to revaluate the selected source data, enter a revaluation key. If the available
fields for currencies and quantities are insufficient, you can use a user exit to revaluate the
data according to your needs. If you do so, you can define any revaluation you like.

5. Decide whether the system should overwrite existing data in the target plan, or whether it
should be added to the data you copy.

6. Choose Goto → Selection criteria. The system displays the selection screen. Here you see
different fields depending on which planning area you chose.

Specify the objects that you want to use as the source data for your plan. Note that an
entry in the Profit center and Account fields is required in the planning areas
"Costs/revenues" and "Balance sheet accounts". In the planning area "Statistical key
figures", entries in the Profit center and Statistical key figure fields are required.

7. To copy the data online, choose . The system copies the data and automatically displays a
log.

To copy the data in the background, choose Background processing. The system
displays a dialog box. Here you can overwrite the default job name "COPYPLAN".

This function only copies the transaction data. The settings for the source data are
not copied over to the target version. You therefore need to maintain the functions
Plan version and Version parameters.

This function does not create any line items.
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Balances Forward
Use
If you want to post material stocks, assets, work in process or Additional Balance Sheet Items to
Profit Center Accounting by transaction, you need to carry balances forward during the course of
year-end closing. Otherwise this step is optional.

When you carry balances forward, the profit and loss accounts are carried forward to the special
account entered for that income statement account type in Customizing (see Customizing for
Profit Center Accounting). Postings are divided according to controlling area, profit center, origin
object type and transaction. Balance sheet accounts are carried forward under the same account
and divided according to controlling area, profit center, partner profit center, partner company,
function area, transaction, depreciation area (for assets) and results analysis version (for work in
process).

Once you have activated the function for carrying balances forward in Profit Center Accounting
(see Customizing), the system performs it automatically in the actual system for all postings
which are transferred from Financial Accounting or entered manually in Profit Center Accounting.

Activities
The function is found in the EC-PCA application menu under

•  Actual postings → Period-end closing → Balance carried forward.

•  Planning → Planning closing → Balance carried forward

On the selection screen, enter the company code and the fiscal year to which you want to
transfer the balances. Enter version 0 for actual data or the desired plan version for plan data.
You also need to specify which you want to carry forward plan values or actual values.

You can also execute this function in test mode. To execute it in the background, choose
Program → Execute in background.
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Assessment and Distribution
Use
Assessment and distribution are described under the umbrella term Allocations.

Assessment and distribution of relevant overhead costs is performed at period closing (actual
data) or plan closing (plan data). This is usually done directly in CO and then reflected in the data
in Profit Center Accounting.

If you have a service profit center or allocation profit center in your profit center hierarchy,
you may need to assess or distribute costs again in Profit Center Accounting.

In Profit Center Accounting, the allocation function allows you to allocate the following plan and
actual data.

•  Costs (assessment and/or distribution)

•  Revenues and sales deductions (assessment and/or distribution)

•  Balance sheet items (distribution)

Assessment is made using a special cost/revenue element.

In distribution, the original cost/revenue element/account number is retained.

You can use other posted values, quantities or statistical key figures as a basis for allocations
(see Statistical Key Figures and Statistical Key Figure Groups [Page 73]).

If you want to use a statistical key figure as the basis for an allocation, you need to
use the field group 04 (actual quantities) and enter the account group SPACE.

From Release 4.6 A, you can allocate data in Profit Center Accounting at controlling
area level. This makes it possible to process all company codes belonging to a
controlling area in one single cycle. You specify the controlling area in the cycle
header data. Note, however, that the actual allocations are made within one
company code only.

Prerequisites
Before performing assessment or distribution in Profit Center Accounting, check whether the
following steps have been carried out:

1. For actual data
a. Period-closing activities have been completed in all applications which supply EC-PCA

with data (FI, CO, SD, MM etc.).

b. Any additional actual data required in Profit Center Accounting has been created.

2. For plan data
a. All relevant plan data has been transferred from the component CO.

b. Direct planning in Profit Center Accounting has been completed.
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If any of these steps have not been carried out, you will need to cancel the assessment or
distribution as soon as the base values and tracing factors which you used change again. You
will then need to restart the assessment or distribution.

Activities
A general description of allocations can be found in the R/3 Library for the component FI Special
Ledger (for an introduction, see Allocation: Introduction [Ext.])

The only difference in Profit Center Accounting is that it is not necessary to enter the
ledger described in the above-mentioned documentation, since the system
automatically uses the profit center ledger 8A.

In Profit Center Accounting, you can find assessment and distribution

•  in the application menu under Planning → Plan Allocations and under Actual Postings.

•  in Customizing under Planning → Allocations and under Actual Postings. In the
Implementation Guide (IMG), you can find further information which applies specifically to
Profit Center Accounting.
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Currencies in Planning
In Profit Center Accounting, three currencies can be stored at once:

Transaction Currency
The transaction currency is the currency used for a specific transaction. You can choose a
different currency from the list of valid currencies for each new transaction. The transaction
currency is stored in the transaction data for Profit Center Accounting as the so-called “first
currency”.

Local Currency (Company Code Currency)
The controlling area currency is stored in Profit Center Accounting as the second currency.

Profit Center Local Currency
You need to set a special currency for Profit Center Accounting in Customizing for each
controlling area. This currency is used in the standard reports, among other things. You can find
more information about this currency in Customizing. The profit center currency is the third
currency updated in the transaction data.

How Do I Plan Currencies in Profit Center Accounting?

You first plan a profit center in USD. Then you later plan the same profit center in
DEM in a second planning session. This may be necessary if:

•  the planned costs for the profit center in a certain cost element consist of
external invoices in the local currency and external invoices from abroad and

•  the external invoice from abroad was billed and paid abroad

The currencies which can be planned manually are defined in the Layout [Page 280].

If the corresponding key figures are defined and ready for input in the planning layout, you can
plan in any permissible transaction currency, the company code currency or the profit center
currency. The planned amount is then immediately and automatically translated into the other
currencies. Note, however, that the system can only translate into a transaction currency if you
have explicitly specified a transaction currency.

If you want to want to plan data using different transaction currencies, you need to use a planning
layout that contains the characteristic “Transaction currency".

Note that data can only be saved in the transaction currency if a transaction currency
has been specified. Otherwise the data will only be saved in the other currencies
without the transaction currency.

If you want to want to summarize data in the transaction currency, you need to use a planning
layout that does not contain the characteristic “Transaction currency". You can then:

•  change the summarized values, in which case the changes are not updated in the
transaction currency, and
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•  add any combinations of objects that have not already been planned.

If you

•  enter one transaction currency, the system only displays the amounts planned in that
currency. You can

- change these amounts

- plan in the currency specified

•  enter a number sign (#) to represent the value “ “ (no value), the system only displays
those values that were planned without the transaction currency. You can

- change these amounts

- plan amounts without a transaction currency

•  specify more than one currency or all currencies (*), the system displays all the planned
values. You can

- change these amounts

- can plan as yet unplanned combinations of your planning objects in any valid
currency.

Planned currency amounts are translated using

•  the value date you entered in the planner profile for your area

•  a translation factor entered in the currency table for the exchange rate type entered in the
planner profile

You will find further information about the currency table and currency translation in the
documentation FI Configuration and Organization.
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Actual Postings
Purpose
All the postings in Financial Accounting, Materials Management, Asset Management and Sales
and Distribution and Controlling which affect profits are reflected in Profit Center Accounting.
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Profit centers cannot receive direct postings in the R/3 System. Instead, the data is posted to
other objects and passed on from there to a profit center in Profit Center Accounting. This makes
it possible to display your company’s results by profit center based on the original postings and
with no additional work.

Features
From a profit center point of view, internal goods movements often represent transfers between
profit centers. Consequently, Profit Center Accounting creates additional lines (e.g. “internal
revenues”) in addition to the original FI postings. These additional lines are necessary for you to
be able to represent all the activities performed by your profit centers.

You can valuate goods movements between profit centers using either external prices, group
costs of goods manufactured, or special transfer prices. Using multiple valuation approaches in
your system, you can reflect the desired valuation method in Controlling and Financial
Accounting as well as in Profit Center Accounting. For general information about transfer prices,
see Multiple Valuation Approaches/Transfer Prices [Page 100]. For detailed information on
transfer prices in Profit Center Accounting and on the posting logic, see Transfer Prices in Profit
Center Accounting [Page 121].
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If you are not using transfer prices from a profit center viewpoint or a group viewpoint, the system
valuates your postings to Profit Center Accounting using the legal prices (external prices).

The sections found under Actual Data Transfer contain examples of how Profit Center
Accounting receives data from the other components of the R/3 System (see Data Origins [Page
228]). The examples profit center postings that are valuated from the legal view. For examples of
valuation using transfer prices, see Posting Logic and Account Determination [Page 130].

You can complement your profit center data by transferring selected balance sheet line items to
profit centers. This makes it possible to evaluate additional key figures, such as return on
investment and cash flow. For more information, see Balance Sheet Items in Profit Center
Accounting [Page 297].

In Preparation for Consolidation [Page 323], you can determine partner relationships which are
needed for elimination of internal business and preliminary results in profit center consolidation.

The system stores the following currencies in Profit Center Accounting:

•  Company code currency

•  Any one Profit Center Accounting currency for each controlling area

•  The currency in which the business transaction was processed (transaction currency)

The data is stored according to the following key fields:

•  Company code

•  Profit center

•  Partner profit center, for elimination purposes or to evaluate sender and receiver profit
centers

•  Account originally posted, or a separate account in case of an additional account assignment

•  Origin object type, in order to recognize the type of object to which the data in Profit Center
Accounting was originally posted (such as cost center, order, project or sales order)

•  Functional area, to represent expenditures according to function (sales, administration,
research and development, and so on) using the cost-of-sales method

•  partner company, to divide sales by affiliated company

•  origin group, as a subdivision of material postings (If material consumption of two materials is
posted under the same account, you can differentiate the postings if an origin group was
assigned to the materials in the master record.)

•  the business transaction (Financial Accounting posting, material consumption, goods
received for order, and so on)

Technically, the data in Profit Center Accounting is stored in ledger 8A of the component FI -
Special Purpose Ledgers.
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Data Origins
Use
Before you can analyze your profits by profit center, the system needs to summarize all the
profit-related postings in profit centers.

The profit-related components of the period accounting method (see also Methods of Calculating
Profits in EC PCA [Page 15]) are

•  revenues, sales deductions

•  change in stock of finished and semi-finished goods

•  change in work in process

•  capitalized internal activities

•  primary costs

•  secondary costs

This data is transferred directly to Profit Center Accounting from the following components of the
R/3 System:

•  Transfer from Financial Accounting [Page 239] (FI)

•  Transfer from Sales and Distribution [Page 242] (SD)

•  Transfer from Materials Management [Page 245] (MM)

•  Transfer from Controlling [Page 260] (CO)

•  Transfer from Investment Management/Asset Management [Page 270] (IM/FI-AA)

The topics listed above explain the transfer of actual data to Profit Center Accounting
using a number of examples. In those examples, the part of the original posting
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which is transferred is shown in bold, or the posting in Profit Center Accounting is
explicitly shown.

Once you have transferred actual data to Profit Center Accounting, you can analyze it
immediately according to the period accounting approach using the Standard Reports in the
information system.

To calculate profits according to the cost-of-sales approach, you need to access the
characteristic Function area, which is derived in FI or CO. If this derivation is active in FI or CO,
the function area is updated for each posting, making it possible to calculate profits according to
the cost-of-sales approach [Page 359] in Profit Center Accounting.

When Profit Center Accounting is active, the system only allows those postings
which can be transferred to a profit center without errors. This automatically ensures
that your data is complete and reconciled with the other components.
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The Systematics of Profit Center Determination
This section is intended as a theoretical supplement to the more practical explanation of profit
center determination (see Data Origin [Page 228]).

It will explain:

•  the order in which the system proceeds when assigning value flows arising in business
processes to various profit centers

•  which objects and characteristics of objects are decisive for determining the profit center

Transaction Data
Step 1: Document-dependent profit center determination
To begin with, the system determines a profit center on the basis of the origin of the document
and any special conditions. It does so by one of the following methods:

•  The system assigns the profit center dynamically, on the basis of certain characteristics in
the document itself. When this method is used, the currently assigned profit center is always
determined.

•  The system assigns the profit center indirectly, on the basis of certain characteristics in a
preceding document. When this method is used, the system does not take into account any
assignment changes occurring after the date of the preceding document.

Example: indirect assignment
When you make a goods receipt posting in Profit Center Accounting, the system
takes over the profit center from the corresponding order. In the order, the system
finds the profit center which is assigned to the material/plant combination it contained
on the order document date.

It could be that another profit center has been assigned to this material/plant
combination in the period between the order document date and the goods receipt
posting document date. If so, when you make the goods receipt posting, the system
still takes over the profit center which was assigned on the order document date.

For detailed illustrations of the criteria used to determine the profit center for each different type
of document, see:

MM-Goods Movement [Page 233]

SD Billing Document [Page 234]

FI Posting and FI-AA Asset Posting [Page 236]

MM Goods Receipt Posting [Page 237]

Step 2: Characteristic-dependent profit center determination
With all types of document, the system checks whether one of the following cases applies: The
profit center assignment which may arise from this step always has priority over the assignment
determined in step 1 on the basis of document type.
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In the order shown below, the system
checks whether:

If so, ...

1) ..substitutions have been set for profit
centers in FI or CO.

...the profit center determined using the
substitutions is always used.

For further information on substitutions, see
Substitutions [Page 363].

2) ...the data to be transferred is a cost or
revenue element.

the profit center will always be determined from
the real (not statistical) assigned CO object
belonging to it.

For further information on the assignment of
profit centers to CO objects see Profit Center
Assignments [Page 76].

3) ...the data is from balance sheet or profit
and loss accounts which have been set for
transfer to Profit Center Accounting

and
no profit center has been set in the
corresponding document

the system takes the profit center directly
assigned to the corresponding accounts (see
Customizing for Profit Center Accounting,
transaction 3KEH)

or
which was assigned to the corresponding
accounts by a derivation rule (see Customizing
for Profit Center Accounting, transaction 3KEI)

4) ...the data is from profit and loss accounts
which affect logistical processes (that is, data
which is taken over as standard)

and
no profit center has been set in the
corresponding document

...the data is posted to the dummy profit center
[Page 66].

5) ...you have changed the Profit Center field
for the corresponding original document, using
the SAP customer enhancement PCA00001.

...the data is posted to the profit center you
require.

For more information about using SAP
customer enhancements, see the
Implementation Guide (IMG) for Profit Center
Accounting, under Tools.

Balance Sheet Items
When you transfer balance sheet items to Profit Center Accounting, the profit center is
determined as follows:

•  For existing payables and receivables, the system reads the profit center from the offsetting
lines of the invoices which were posted (FI documents). This is only possible, however, if you
have already apportioned payables and receivables during the course of month-end closing
in Financial Accounting.
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•  For material stocks, the profit center is derived from the material/plant combination. If the
stock in question is a sales order stock or a project stock, this is determined by the sales
order item or the WBS element.

•  For asset balances, the profit center is determined from the overhead cost order or from the
cost center in the asset master record.

•  For work in process, the profit center is derived from the production order or the WBS
element.

•  You can also use customer enhancement PCA00001 to assign the profit center you require
when transferring balance sheet items.

For more information, see Balance Sheet Items in Profit Center Accounting [Page 297].
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MM Goods Movement
The graphic below illustrates how the system determines the profit center for an MM goods
movement. In Profit Center Accounting, the data in the MM document is posted to the profit
center determined by the system.
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As you can see from the graphic, the profit center for an MM goods movement can be
determined either dynamically (the material/plant combination in the document is decisive here)
or indirectly via the preceding document.
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SD Billing Document
The graphic below illustrates how the system determines the profit center for an SD billing
document. In Profit Center Accounting, the data in the MM document is posted to the profit center
determined by the system.
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For an SD billing document, the profit center is - with one exception - always determined
indirectly via the preceding document.

The exception to this rule is an SD billing document with valuated project stock. With this type of
billing document, the profit center is determined dynamically from the WBS element contained in
the actual SD billing document.

Cross-Company Scenario
With cross-company transactions, the sales order item always contains the supplying
profit center.

This profit center is used both for the internal settlement and the goods issue (see
normal case in the graphic).

The profit center making the sale must be determined using a substitution when the
customer billing document is created (see cross-company transaction in the
graphic).
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FI Posting and FI-AA Asset Posting
The graphic below illustrates how the system determines the profit center for FI and FI-AA
postings. In Profit Center Accounting, the data in the FI or FI-AA document is posted to the profit
center determined by the system.
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The profit center is always determined dynamically from the FI or FI-AA document.
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MM Goods Receipt Posting
The graphic below illustrates how the system determines the profit center for an MM goods
receipt posting. In Profit Center Accounting, the data in the MM document is posted to the profit
center determined by the system.
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When a goods receipt posting is made, the profit center is always determined indirectly via the
preceding document.
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Plan Data Transfer
Use
Data which is posted to CO objects is transferred to Profit Center Accounting in accordance with
the assignments made here.

There are two methods for transferring data:

1. Online transfer

This is the usual method for transferring data. You must activate online transfer in
Customizing for Profit Center Accounting, in the Controlling Area Settings.

2. Transfer by subsequent posting

See Subsequent Posting of Actual Data [Page 273].

Integration
See Data Origins [Page 228] and The Systematics of Profit Center Determination [Page 230].

Prerequisites
You have performed all profit center assignments [Page 76].
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Transfer from Financial Accounting
Use
When you post data directly in Financial Accounting, all primary data requires an additional
assignment to a CO object.

The assignment of this CO object (cost center, order, and so on) to a profit center ensures that
the data is passed on to Profit Center Accounting. The profit center cannot, however, be entered
directly when the FI posting is made.

It is recommended that you define your cost elements so that the profit center field appears on
the account assignment screen in Financial Accounting. This makes it possible for you to verify
the assignment. You can do this in Customizing via the basis parameters for business
transactions.

Features
In addition to primary costs, the change in work in process and production variances from
Product Cost Accounting also reach Profit Center Accounting via Financial Accounting.

Using the document display function in Financial Accounting, you can display the
documents which are created in Profit Center Accounting as a result of the posting
under the menu option Environment → Accounting documents.

The following examples demonstrate the transfer of data from Financial Accounting:

Example: Direct Assignment of External Activities [Page 240]

Example: Direct Posting of Revenues [Page 241]
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Example: Direct Assignment of External Activities
You post an external activity to cost center C100, which is assigned to profit center P100.

FI document

External activity 1000.00 (PrCtr P100) to

Payables 1000.00

Here the system only transfers the line External activity. The posting to the balance sheet
account Payables is not transferred online.
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Example: Direct Posting of Revenues
If you are not using the SD Module, you can post revenues directly in Financial Accounting. To
do so, you need to create the account as a revenue element or a sales deduction.

If you are using account-based Profitability Analysis, you also need to make an assignment to a
profitability segment. In this case, you must specify the profit center of the profitability segment.

Without account-based Profitability Analysis, the system updates the field “Profit center” directly
to a so-called “reconciliation object” in Controlling.

In the latter case, the posting to the reconciliation object is treated as the real posting.
Consequently, the profit center assignment is statistical here as well.
With account-based Profitability Analysis, you get the following

FI document

Receivables 1500.00 to VAT 225.00

Revenues 1275.00 (Profitability segment:

Division: ABCD
Region: North
Customer: 1234
PrCtr: P100)

The characteristic “Profit center” is transferred to Profit Center Accounting.

Without account-based Profitability Analysis, the account “Revenues” is defined such that a direct
assignment of the field “Profit center” is possible.

In CO, the system updates a so-called “reconciliation object” in the background for reconciliation
with Financial Accounting. From the CO point of view, the posting to this object is regarded as
the real posting.

The reconciliation object is a combination of company code, business area and profit center.
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Transfer from Sales and Distribution
Use
As explained in the section Assigning Sales Orders [Page 82], the assignment of a sales order to
a profit center is passed from the sales order to the delivery note and then on to the billing
document. The change in stock if posted to the profit center upon goods issue.

Prerequisites

If account-based Profitability Analysis (CO-PA) is active in your system, the G/L
account for changes in stock must be defined as a cost element.

If account-based CO-PA is not active, you must define this account as a profit and
loss account. The system still ensures that the goods issue posting is passed on to
the profit center. If you define the account as a cost element, you must specify a true
account assignment object in Controlling (such as a cost center or order). In this
case, the data is posted to the profit center to which that CO object is assigned.

Features
The following data is transferred from bills and debit and credit memos to Profit Center
Accounting.

•  Revenues

•  Sales deductions (shipping, discounts etc.)

•  Accruals (e.g. from rebate agreements)

The profit center is assigned at the item level of the sales order.

The Financial Accounting document and the profit center document are supplied from the original
document in SD via the same interface.

For more information, see Example: Transferring Data from Sales and Distribution [Page 243].

You can summarize items in Financial Accounting which have the same account
number, but this data is not summarized if the profit centers differ. This makes it
possible to reconcile the FI document with the profit center document.
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Example: Transfer from Sales and Distribution
A customer buys the materials M1, M2 and M3 from profit centers P100, P200 and P300,
respectively.

Customer: 12345 Profit center

Item  1: material M1 Revenues 1100.00 P100

Discount   100.00 P100

Accruals     10.00 P100

Item  2: material M2 Revenues 2200.00 P200

Discount   200.00 P200

Accruals     20.00 P200

Item  3: material M3 Revenues 3300.00 P300

Discount   300.00 P300

Accruals     30.00 P300

The following document is created in Financial Accounting. The lines marked in bold are
transferred to Profit Center Accounting.

Receivables 1000.00 (PrCtr P100)

2000.00 (PrCtr P200)

3000.00 (PrCtr P300)

Discounts   100.00 (PrCtr P100)

  200.00 (PrCtr P200)

  300.00 (PrCtr P300)

Expense accruals     10.00 (PrCtr P100)

    20.00 (PrCtr P200)

    30.00 (PrCtr P300) to

Revenues 1100.00 (PrCtr P100)

2200.00 (PrCtr P200)

3300.00 (PrCtr P300)

Reserves     10.00 (PrCtr P100)

    20.00 (PrCtr P200)
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    30.00 (PrCtr P300)



 SAP AG Profit Center Accounting (EC-PCA)

Transfer from Materials Management

April 2001 245

Transfer from Materials Management
Use
All the goods movements are created in Materials Management and, where necessary, reflected
from a Profit Center Accounting point of view via a special account determination.

The profit center to which the data should be posted depends on which materials and which CO
objects are involved.

Features
The following MM activities are reflected in EC-PCA.

Example: Goods Receipt for Purchase Orders [Page 246]

Example: Goods Receipt for Production Orders [Page 247]

Example: Invoice Receipt [Page 248]

Example: Goods Issue for Delivery Note [Page 249]

Example: Change in Material Prices/Revaluation [Page 250]

Example: Inventory Differences [Page 251]

Internal goods movements are also reflected in Profit Center Accounting. See Goods Movements
Between Profit Centers [Page 252].
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Example: Goods Receipt for Purchase Orders
When you post a purchase order, the system posts the goods usage immediately upon goods
receipt.

You use 100 units of a material M1. Of these, 70% are allotted to cost center C100, and 30% to
cost center C200.

The profit centers of these cost centers are P100 and P200, respectively.

FI document

Consumption 7000.00 (PrCtr P100)

3000.00 (PrCtr P200) to GR/IR acct 10,000.00

The account GR/IR represents the clearing account for goods receipt/invoice receipt.

This gives you the costs of the material consumption in the corresponding profit centers.
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Example: Goods Receipt for Production Orders
When you deliver a production order to warehouse, the change in stock is created in the profit
center of the production order.

The production order is assigned to profit center P100.

FI document

stock 1500.00 to change in stock 1500.00 (PrCtr P100)

The production costs were already created when the material consumption, activity input, and so
on were posted to the production order.

Variances are settled to the profit center during order settlement.
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Example: Invoice Receipt
If the amount on the invoice is different from the standard price of the material purchased, price
differences arise when you post the invoice receipt. This difference is also reflected in Profit
Center Accounting.

Example
You purchased one unit of material M2 from plant 01 at 1700.00, but the standard price of this
material is 1500.00. The profit center of the material is P200.

FI posting

stock 1500.00

expense from price diff.   200.00 (PrCtr P200) to GR/IR acct 1700.00

The GR/IR account is the clearing account for goods received and invoices received.

The expense from price differences is thus assigned to profit center P200.

If your price difference account is defined as a cost element, the amount is posted to the profit
center of the corresponding CO object. However, this is normally not desired. Thus you can use
automatic account determination to find a profit center based on the valuation area, cost center,
or order.

If the price difference account is not a cost element, the price differences are assigned to the
profit center of the material purchased.
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Example: Goods Issue for Delivery Note
The profit center from the sales order is passed on to the billing document and the goods issue
document. This ensures that both the revenues and the change in stock from the sale are
assigned to the same profit center.

This means that for sales-oriented profit centers, the profit center found using substitution is also
transferred to the goods issue document.

If P100 is the profit center of the sales order, you get the following transfer:

FI document

Change in stock from sale 2,000.00 (PrCtr P100) to

stock of finished products 2,000.00
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Example: Change in Material Prices/Revaluation
Assume the price of a material M1 from the plant 001 rises from 1500.00 to 1600.00. The
“income from revaluation” is assigned to the profit center of the material (here P100). The stock
quantity is 100 units. The result is the following posting:

FI posting

stock 10,000.00 to

income from revaluation 10,000.00 (PrCtr P100)

Revaluation leads to the same posting. Here the price is not changed, but the total value of stock
rises or falls. You still get the same posting.

In this example, the profit and loss accounts do not need to have been created as
cost elements in order to be transferred to Profit Center Accounting. If they are cost
elements and are assigned to a cost center, the amounts would be posted to the
profit center of a cost center.

If your company is divided into profit centers according to products, this is generally
not desirable.
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Example: Inventory Differences
The current quantity in a material master is 100 units. During inventory taking, you determine that
only 90 units are there. The current material price is 500.00. The profit center of the material is
P100.

FI posting

expense from inventory differences 5000.00 (PrCtr P100) to

stock 5000.00

In this example, the profit and loss account Expense from inventory differences
does not need to have been created as cost elements in order to be transferred to
Profit Center Accounting. If they are cost elements and are assigned to a cost center,
the amounts would be posted to the profit center of a cost center.

If your company is divided into profit centers according to products, this is generally
not desirable.
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Goods Movements Between Profit Centers
Use
Internal goods movements can result in a flow of materials between profit centers.

In order to display this material flow in a way suitable for Profit Center Accounting, you need to
think of the profit centers as logical companies. This gives you a sales transaction on the sender
side and a goods receipt on the receiver side. You cannot reflect this in Profit Center Accounting
using the original postings. Consequently, you need to create additional assignments.

Up to and including Release 3.1, all data posted in Profit Center Accounting was valuated from
the standpoint of the legal units (company codes). The valuation method were taken directly from
the original posting. In Release 4.0, you can use transfer prices to valuate material stocks and
goods movements from a group-wide viewpoint or from the viewpoint of the individual profit
centers. For more information on this subject, see Multiple Valuation Approaches/Transfer Prices
[Page 100].

Using account determination rules which you can define in Customizing, the system generates
and updates additional posting lines in Profit Center Accounting based on the original document.
If you are using prices determined from the legal viewpoint, no changes are made to the original
document, which means that Financial Accounting (FI) and Materials Management (MM) are not
affected. However, if your organization uses profit center valuation in FI, these additional posting
lines are updated there as well.

For some goods movements, no additional postings are necessary. You can exempt these
movements from the account assignment logic by defining special handling for them.

For more information, see Customizing for Profit Center Accounting.

Activities:
First you need to decide for which material types you want to reflect a flow of materials between
profit centers. Enter all these material types in the account determination table. Material types
which are not found there are ignored.

It might make sense to leave out material types such as inexpensive raw materials or operating
supplies. For these material types, only the consumption postings on the receiver side are
debited to the profit center.

On the whole, you can make account determination dependent on the following criteria:

•  material type

•  valuation class

•  valuation grouping code

For each table entry, accounts are stored for the following:

•  internal revenues

•  internal changes in stock

•  delivery from profit center

These accounts are profit and loss accounts, though they are not cost elements.
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Account determination for the different goods movements is demonstrated in the following
examples:

Example: Material Consumption for a Production Order [Page 254]

Example: Consumption Posting Without Receiver Records [Page 256]

Example: Goods Issue for Delivery Note [Page 257]

Example: Stock Transfers [Page 258]
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Example: Material Consumption for a Production Order
The semi-finished product H100, which is assigned to profit center PSEMI, is used in a
production order for the finished product F100, which is assigned to profit center PFINP. The
value of the material is 1,300.00.

Different values are posted depending on whether you use transfer prices according to the legal,
group, or profit center viewpoint. The first example shows the postings when both FI and
EC-PCA use the legal viewpoint. The second example shows the postings where the legal
viewpoint is used in FI, but the profit center viewpoint is used in EC-PCA.

Posting Using the Legal View in EC-PCA and FI
FI document:

Change in stock of semi-finished product 1,300.00 (PrCtr PFINP) to

Stock of semi-finished product 1,300.00

This posting only debits the receiver profit center of the production order with the change in
stock.

From the point of view of Profit Center Accounting, the following problems arise:

•  The sales process of the sender profit center is not represented.

•  The consumption is posted to the receiver under “change in stock”, but it is actually a delivery
from another profit center (from another logical company).

Profit-relevant posting from the profit center viewpoint:

Profit center PSEMI

1. Internal revenues -1,300.00

2. Internal change in stock  1,300.00

Profit center PFINP

1. Change in stock of semi-finished product  1,300.00

2. Internal change in stock -1,300.00

3. Delivery from profit center  1,300.00

Consequently, the sender profit center PSEMI reflects the revenues earned with other profit
centers.

In order to correct the change in stock on the receiver side, lines 1 and 2 need to be one below
the other in the information system.

The consumption posting is represented by line 3 of the posting.

Posting Using the Profit Center View (Transfer Prices) in EC-PCA and the
Legal View in FI
In legal valuation, the stock is valuated at 1,300.00.

In profit center valuation, the stock is valuated at 1,400.00.
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The transfer price of the semi-finished product is 1,500.00.

FI posting:

In FI, only legal valuation is used.

Change in stock, semi-finished products 1,300.00 (PrCtr PFINP) to

Stock, semi-finished products 1,300.00

Profit-relevant posting the profit center viewpoint:

EC-PCA uses profit center valuation.

Profit center PSEMI

1. Internal revenues -1,500.00

2. Internal change in stock 1,400.00

Profit center PFINP

1. Change in stock, semi-finished products 1,500.00

2. Internal change in stock -1,500.00

3. Delivery from profit center 1,500.00

Profit center PSEMI thus has earned internal profit of 100.00. For a more detailed example of the
use of transfer prices, see Example for a Withdrawal of a Semifinished Product [Page 133].
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Example: Consumption Posting Without Receiver
Records
In the account control table, you can specify that no separate receiver records should be created.

The receiver records are there to represent the posted change in stock in from the point of view
of Profit Center Accounting. If, for example, you also want to see goods movements for raw
materials, you do not need the additional lines for the receiver.

In this example, the raw material R100 is used for a production order for the semi-finished good
H100. The profit centers involved are PROH and PHALB. The value of the usage is 500.00.

FI document:

Raw materials usage  500.00 (PrCtr PHALB) to

Raw materials  500.00

Profit center posting:

Profit center PROH:

1. Internal revenues -500.00

2. Internal change in stock  500.00

Profit center PHALB:

1. Raw materials usage  500.00
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Example: Goods Issue for Delivery Note
If your profit centers are divided into production and sales, a goods issue will result in a stock
transfer between the production profit center and the sales profit center (from the point of view of
Profit Center Accounting, but not Logistics). Thus additional lines are again created for the goods
issue.

The sales order is assigned to the profit center PSLS, while the material is assigned to P1234.

Profit center PSLS is transferred to the goods issue document. Upon goods issue it is realized
that this profit center is different from the material’s profit center (P1234).

The value of the material is 1,500.00.

FI document:

Change in stock from sale 1,500.00 PrCtr PSLS to

Stock of finished products 1,500.00

Profit center posting:

Profit center P1234:

1. Internal revenues -1,500.00

2. Internal change in stock  1,500.00

Profit center PSLS:

1. Change in stock from sale  1,500.00

2. Internal change in stock -1,500.00

3. Delivery from profit center  1,500.00

The sender profit center, P1234, reflects the sales made with the sales profit center.

If you want to correct the “change in stock” for the receiver, you need to place lines 1 and 2 one
below the other in the information system. The delivery from profit center is represented in line 3
of the posting.

If you do not want this, you do not need the receiver records.
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Example: Stock Transfers
A straight transfer between inventory locations also needs to be represented from a profit center
point of view.

PrCtr P100
Plant 0001

Standard price
1000.00

Semi-finished
product

PrCtr P200
Plant 0002

Standard price
1000.00

Balance                       1000.00                  FI                        Balance                    1000.00

Internal revenue   -1000.00
     Balance            1000.00

                                    0.00

Profit center
      Balance                -1000.00  
Deliv. from PrCtr          1000.00

                                          0.00

Material M1 is transferred from plant 0001 to plant 0002. The profit centers involved are P100
and P200. The external price in both plants is 1,000.00.

Different values are posted depending on whether you use transfer prices according to the legal,
group, or profit center viewpoint. The first example shows the postings when both FI and
EC-PCA use the legal viewpoint. The second example shows the postings where the legal
viewpoint is used in FI, but the profit center viewpoint is used in EC-PCA.

Posting Using the Legal View in EC-PCA and FI
FI document:

Stock 1,000.00 (PrCtr P100) to

Stock 1,000.00

Profit center posting:

Profit center P100:

1. Internal revenues -1,000.00

2. Internal change in stock  1,000.00

Profit center P200:

1. Internal change in stock -1,000.00

2. Delivery from profit center  1,000.00
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The sender profit center P100 shows a sales transaction. On the receiver side, you can see that
the material was delivered from another profit center, while the values on the receiver side
(P200) did not affect profits.

Posting Using the Profit Center View (Transfer Prices) in EC-PCA and the
Legal View in FI
In legal valuation, the stock is valuated at 1,000.00.

In profit center valuation, the stock is valuated at 1,200.00.

The transfer price is 1,500.00.

FI posting:

In FI, only the legal valuation view is stored.

Stock 1,000.00 (PrCtr P100) to

Stock 1,000.00

Profit-relevant postings from the profit center viewpoint:

Profit center P100:

1. Internal revenues -1,500.00

2. Internal change in stock 1,200.00

Profit center P200:

1. Internal change in stock -1,500.00

2. Delivery from profit center 1,500.00

This gives profit center P100 an internal profit of 300.00.
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Transfer from Controlling
Use
All the secondary transfers between CO objects are selected and represented in the assigned
profit centers.

You can represent the data in Profit Center Accounting by reflecting the original document
directly, since only credits and debits arise on the CO objects involved in the transfers.

Features
The system can transfer the following activities from CO:

Example: Order Settlement [Page 261]

Example: Assessment/Distribution [Page 262]

Example: Assessment to Profitability Analysis [Page 263]

Example: Internal Cost Allocation [Page 264]

Example: Transfer Postings [Page 265]

Example: Calculation of Imputed Costs [Page 266]

Example: Transfer Price Allocation Between Partial Projects [Page 267]

Example: Settlement of Work in Process [Page 268]

Example: Production Variances [Page 269]
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Example: Order Settlement
You open an internal order to collect all the costs of a trade fair. At the trade fair, products from
three different product lines are displayed. These product lines are assigned to the profit centers
P100, P200 and P300.

In this case, you can assign the order to a service center. When the order is settled to three cost
centers with reference to the three product lines, the data from the settlement is transferred to the
corresponding profit center.
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Example: Assessment/Distribution
The primary costs of an auxiliary cost center are passed on to Profit Center Accounting. If it is not
possible to assign this auxiliary cost center to a profit center, you should work with a service
center here. The assessment or distribution to CO objects which are assigned to “real” profit
centers can thus be reflected as an assessment or distribution from the service center to a “real”
profit center.

If any over- or underabsorption occurs for the service center, you need to allocate this in Profit
Center Accounting (see Assessment and Distribution [Page 321]).

If you cannot assign the final cost centers to one profit center, you can collect the
data in an allocation center and then assess or distribute it in Profit Center
Accounting.
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Example: Assessment to Profitability Analysis
If period costs (such as sales and administrative costs) or under-/overabsorption are transferred
to Profitability Analysis, this transfer is only reflected in Profit Center Accounting if you specify the
characteristic “Profit center” in Profitability Analysis.

If the characteristic remains blank, the transfer is not reflected.
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Example: Internal Cost Allocation
The exchange of services between profit centers is represented as internal cost allocations in
CO. If elimination of internal business volume is active, Profit Center Accounting only reflects
those services which are provided by one profit center for another one.
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Example: Transfer Postings
Incorrect postings which you correct by transfer are transferred in the same way in Profit Center
Accounting. Naturally, the transfer does not take place if elimination of internal business is active
and you transfer the data between objects which are assigned to the same profit center.
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Example: Calculation of Imputed Costs
Assume that vacation pay is automatically distributed to the cost centers by month using the
cost-element percentage method of calculation of imputed costs. These costs are posted to the
assigned profit centers.

In this case the object credited (e.g. order) is assigned to a “Service center”. The balance which
results for that object after the actual costs are allocated is settled to Profitability Analysis.

You can distribute the data of the “Service center” to profit centers as follows:

1. You specify a profit center when you settle the costs to Profitability Analysis. This allocation
will then be reflected in Profit Center Accounting.

2. You do not specify a profit center when you settle the costs to Profitability Analysis. You can
now distribute the data in Profit Center Accounting.
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Example: Transfer Price Allocation Between Partial
Projects
In the Projects System, it is possible to agree on the allocation of a transfer price between parts
of a project. You need to decide which WBS elements should be involved in the allocation, under
which cost element the receiver should be debited, and under which revenue element the sender
should be credited.

The data is posted under an actual version specially created for this purpose. The allocation is
transferred to the profit centers of the WBS elements in this actual version.
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Example: Settlement of Work in Process
If you calculated the “change in work in process” using results analysis in the component Product
Cost Accounting, this value is transferred to Financial Accounting. The value is posted to the
profit center to which the production order is assigned.

FI document:

Work in process 4,000.00 to to

Change in work in process 4,000.00 (PrCtr: P100)

Although the account “change in work in process” was not created as a cost element, since the
production order does not need to be credited, the value is still transferred to Profit Center
Accounting.
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Example: Production Variances
Production variances are divided into different variance categories and posted in Financial
Accounting under a price difference account. This account is passed on to Profit Center
Accounting. This also holds true for the change in stock posted.

Both assignments to the profit center come from the production order.

FI document:

Price differences 200.00 (PrCtr P100) to

Change in stock 200.00 (PrCtr P100)
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Transfer from Investment Management/Asset
Management
Use
The system selects all the profit-related data from Investment Management and Asset
Management from the creation, use and sale of assets.

Features
When a new asset is constructed, the data of the capital investment measure is transferred to the
profit center of the order or project on which it is based.

Imputed depreciation is transferred to the profit center to which the cost center of the asset is
assigned. Likewise, profits or losses from the sale of assets are also transferred to the profit
center of the cost center.

In Customizing for Asset Management, one depreciation area is assigned to Controlling. The
data of this depreciation area is transferred to Profit Center Accounting.

The following examples demonstrate the transfer of data from Investment Management and from
Asset Management:

Example: Capital Investment Measures [Page 271]

Example: Profits from Sale of Assets [Page 272]
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Example: Capital Investment Measures
The data from a capital investment measure is created in an order or a project. This makes it
possible for the costs to be posted to the appropriate profit center.

Costs which cannot be capitalized (such as the costs of demolition for an old building which is
being replaced) can be allocated to CO receivers before the calculation of imputed costs at the
end of the period. The other costs are credited to the order or project as “capitalized internal
activities”.
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Example: Profits from Sale of Assets
You sell an asset with a book value of 3,000.00 to a customer for 4,000.00. The profit which
results from this (1,000.00) is credited to the profit center of the asset (cost center C100 → profit
center P100).

Posting:

Receivable 4,000.00 to Asset portfolio 3,000.00

Income from sale of asset 1,000.00 (PrCtr P100)



 SAP AG Profit Center Accounting (EC-PCA)

Subsequent Posting of Actual Data

April 2001 273

Subsequent Posting of Actual Data
Use
Generally, actual data is transferred to Profit Center Accounting automatically online when the
original posting is made. However, so that you can activate Profit Center Accounting at any time,
it is also possible to post data manually from any data source

Prerequisites
. For more information, see Prerequisites for Transferring Actual Data [Page 274].

Features
In Customizing for Profit Center Accounting, you can find programs for posting data from the
following applications subsequently to profit centers.

•  Financial Accounting/Asset Accounting

You post primary costs (such as primary postings for labor costs, external activities and
so on), by selecting the data directly from Financial Accounting. You can also transfer
documents from Asset Accounting, such as data from the sale of assets, using this
program.

•  Sales and Distribution

You can post data from billing documents to Profit Center Accounting.

•  Materials Management

You can select all the documents for goods movements (consumption, stock transfers,
inward goods movements for delivery note, goods receipt for purchase order, and so on)
directly from Materials Management.

•  Controlling

This function lets you select any secondary allocations between CO objects.

You can post this data en bloc periodically, or you can select specific data by entering the
document numbers and activities.

If you transfer the data by period, the system only selects secondary allocations. You need to
post all the primary postings from the original sources (Financial Accounting or Materials
Management).

You should only use these posting programs to transfer historic data. Do not use them in place
of the automatic data transfer by transaction.
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Prerequisites for Transferring Actual Data
Before you can transfer data to Profit Center Accounting, you need to assign your CO objects
and your material masters to profit centers. You should check the profit center assignments
carefully before you activate the actual data transfer.

You also need to create your own accounts in Profit Center Accounting in order to be able to
reflect goods movements between profit centers. You do this in Customizing.

It may also be useful to assign a revenue or sales deduction account to a profit center. For more
information, see the section Cash Discount Expenses/Income and Exchange Rate Differences
[Page 319].

The standard R/3 System uses the following posting rules:

•  All the postings made to a cost element are transferred to Profit Center Accounting. If it does
not find a profit center, the system posts the data to a Dummy Profit Center [Page 66] to
ensure that the profit-relevant data is complete in EC-PCA.

•  If an account is a profit and loss account but not a cost element, the system transfers all the
postings where the lines contain a profit center. For profit and loss accounts from logistics
activities, the system determines the profit center based on the logistics objects involved,
such as the production order (for work in process) or material (for price changes or inventory
differences). If no profit center can be found, the system transfers the data to the dummy
profit center.

•  Certain balance sheet items (assets, material stocks, work in process, payables/receivables)
can be transferred to Profit Center Accounting on a periodic basis. Other balance sheet and
profit and loss accounts can be chosen from a Customizing table. The accounts are updated
to the profit center specified or to a default profit center specified in the table.
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Transferring Statistical Key Figures
In addition to the monetary data in accounting, you can also transfer Statistical Key Figures and
Statistical Key Figure Groups [Page 73] from the account assignment objects in Controlling to
Profit Center Accounting.

Statistical key figures can be transferred from the following:

•  cost centers

•  cost center/activity types

•  orders

•  cost objects

•  networks

•  network activities

•  WBS elements

•  sales documents

A control table determines which key figures can be transferred from which objects to Profit
Center Accounting. (See Customizing for Profit Center Accounting.) This means that you can
choose not to transfer certain key figures which are unnecessary in EC-PCA, such as those used
solely in Cost Center Accounting as tracing factors for periodic allocations.

In addition to transferring statistical key figures, you can also create them manually in Profit
Center Accounting under the menu option Actual postings → Stat. key figures → Create. This
lets you create key figures which are needed only in Profit Center Accounting.

You can display the documents which contain statistical key figures under the menu option
Actual postings → Stat. key figures → Display.
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Average Balance Ledger
Use
You can store average balances for actual data by period and profit center using a separate
ledger in Profit Center Accounting.

When fluctuations arise in balance sheet account balances during a period, the average balance
ledger lets you smooth out these fluctuations. In addition, the average balance gives you a more
accurate impression of the fixed capital during the period than analyzing the balance on a
specific date (such as the end of the period).

To analyze average balances, you need to activate the average balance ledger, ledger 8Z. This
ledger is assigned to the normal profit center ledger 8A.

The average balance ledger tells you the average balance per account throughout the entire
month. The transactions that take place during the period are updated by account in summarized
form. Each value is weighted depending on when it occurred in the period. A transaction posted
on the first day of the period is updated with its full value in the average balance ledger. Later
transactions are updated proportionately, depending on when they occurred.

At the beginning of February (28 days), account 100000 has an opening balance of $
10,000.00.
On February 15, an inflow of $10,000.00 is recorded.
On February 22, an inflow of $10,000.00 is recorded.

The average balance can be calculated as follows:

((14 days * 10,000.00) + (7 days * 10,000.00) + (7 days * 30,000.00)) / 28 days =
$17,500.00
Internally, the system initially takes the opening balance of the period as the
average. Each transaction during the period is then recorded as a "change" to the
opening balance and weighted according to how many days are left in the period.

In this example, the system calculates the following:

Opening balance 10,000.00

Inflow on 2/15: (10,000.00 * 14 days) / 28 days 5,000.00

Inflow on 2/22: (10,000.00 * 7 days) / 28 days 2,500.00

Average balance 17,500.00

Features
Calculating the Average Balance
The opening balance is always read from ledger 8A.

When you activate the average balance ledger in Customizing, you can decide how the average
balance should be calculated. Specifically, you can decide whether it should be calculated using
the posting date or using a customer enhancement. The period in which a transaction is posted
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always depends on the posting date. Consequently, it does not make sense to calculate the
average balance based on the value date.

Note that quantities are not weighted in the average balance ledger.

For more information on using customer enhancements to calculate average balances, see the
Implementation Guide (IMG) for Profit Center Accounting.

Information System
You can define reports on average balances using the Report Painter. No reports on average
balances can be defined using drilldown reporting.

Even though the average balances are posted by month, it is still possible to report on annual
average balances in the information system. To do this, you can use the following key figures,
which are predefined in the R/3 System:

Average balance in local currency Calculates the average balance for one month

Average balance in group currency Calculates the average balance for one month

Average balance in transaction currency Calculates the average balance for one month

Aggregated average balance in local currency
(YTD)

Calculates the average balance since the
beginning of the year

Aggregated average balance in group currency
(YTD)

Calculates the average balance since the
beginning of the year

Aggregated average balance in transaction
currency (YTD)

Calculates the average balance since the
beginning of the year

The average balances can also be displayed per profit center or balance sheet account.

The following Standard Reports are structure by accounts or profit centers and show the average
balances either on the aggregate or by period:

8A50 Average Balance, Year to Date / Accounts

8A51 Average Balance, Year to Date / Profit Centers

8A52 Average Balance, Period / Accounts

8A53 Average Balance, Period / Profit Centers

For the key figure "Year-to-date", the system calculates the average of the average
balances for all periods. Example:

Year-to-date through period 3:

((AB January * 31 days) + (AB February * 28 days) + (AB March * 31 days)) / 90
days



Profit Center Accounting (EC-PCA)  SAP AG

Average Balance Ledger

278 April 2001



 SAP AG Profit Center Accounting (EC-PCA)

Entering Actual Data and Statistical Key Figures using a Layout

April 2001 279

Entering Actual Data and Statistical Key Figures using a
Layout
Use
•  In Profit Center Accounting, you can, if required, post actual data which is not transferred

from other applications. A profit center document is then written for each of these postings.
The system enters Profit Center Accounting as the origin object.

•  If you transfer additional line items online to Profit Center Accounting, post the opening
balance with the document entry.

•  If you want to use statistical key figures in Profit Center Accounting, which are not used in
CO, enter the values belonging to these using a layout.

Features
SAP delivers various standard layouts. You can use these as templates for your own layouts.
Alternatively, you can define your own layouts without using the standard layouts.

Once you have entered and saved the corresponding data in one of the layout entry screens, you
can display your postings yourself in the layout.

Activities
You create the layouts in Customizing for Profit Center Accounting, under

Actual postings → Manual entry using a layout → Maintain layout for document entry.

Actual postings → Manual entry using a layout → Maintain layout for entry of statistical key
figures.

You can also maintain the layouts in the application menu, under Actual postings → Current
settings.
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Layout
Definition
A layout is a form that determines the layout of screens for entering data.

Use
In Profit Center Accounting, layouts are required for the following functions:

•  Manual entry of

− actual data

− statistical key figures

•  Manual planning of

− costs and revenues

− balance sheet items

− statistical key figures

Structure
All planning layouts have the following basic structure:

T i t l e

Headings

Lead columns Val.columns

The header (headings) of the layout contains a number of text lines that describe the object(s)
that can be planned using this layout. These contain the characteristics that were specified in the
General data selection of the layout.

The lead columns contain the dimensions that you plan. You can define several lead columns.
You create lead columns using SAP characteristics, such as profit center or account.

The value columns are where you enter your data. In other words, this is where you enter the
actual or plan values.
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A value column can contain any of the following:

•  characteristics

•  attributes

•  formulas

You define the three areas of a layout in Customizing for Profit Center Accounting.

•  Actual Data and statistical key figures: Actual Postings → Manual Entry using a Layout

•  Plan data: Planning → Manual Planning

Once you have defined a layout, you can only change it in Customizing. It is no
longer possible for you to change the layout from the application - that is, when
entering values.
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Standard Layouts for Actual Data
Definition
Layouts which SAP delivers as standard. You can use these standard layouts as templates for
your own layouts, or simply use them as they are.

Do not make changes on the actual samples delivered by SAP. Instead, make a
copy of them and make your changes here.

Structure
Entering actual data
8A-001 Profit center/account
You use this layout to enter data in profit center local currency for a given combination of profit
center and account.

8A-002 Profit center/account/partner profit center
You use this layout to enter data in profit center local currency for a given combination of profit
center, account and partner profit center.

8A-005 Profit center/account/functional area
You use this layout to enter data in profit center local currency for a given combination of profit
center, account and functional area.

8A-006 Profit center/account/representative material
You use this layout to enter data in profit center local currency for a given combination of profit
center, account and representative material. You can specify the representative material further
by entering the plant in the header data. You can also enter a quantity for the representative
material. The unit of measure is determined from the materials master record.

8A-191 Profit center/account
You use this layout to enter data in transaction currency for a given combination of profit center
and account. The transaction currency is a mandatory variable here.

8A-192 Profit center/account/partner profit center
You use this layout to enter data in transaction currency for a given combination of profit center,
account and partner profit center.

8A-195 Profit center/account/functional area/transaction currency
You use this layout to enter data in transaction currency for a given combination of profit center,
account and functional area.

8A-196 Profit center/account/representative material
You use this layout to enter data in transaction currency for a given combination of profit center,
account and representative area. You can specify the representative material further by entering
the plant in the header data. You can also enter a quantity for the representative material. The
unit of measure is determined from the materials master record.
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8A-DOC Profit Center document display
Using line item display, you can go from Reporting to the original document in Profit Center
Accounting. This layout determines how the original document is to be displayed. It is not suitable
for entering data in Profit Center Accounting.

Entering statistical Key Figures
8A-701 Profit-center-group/statistical key figure group: fixed values
If you use this layout, you can enter period-independent data for various profit centers or profit
center groups related to a statistical key figure or key figures group. Statistical key figures of type
1 are fixed values (for example number of employees). If you choose this layout, you can enter
period-independent data for various profit centers or profit center groups related to a statistical
key figure or statistical key figure group of this kind. You can also enter a distribution key.

8A-702 Profit-center-group/statistical key figure group: totals values
Statistical key figures of type 1 are consumption values (for example telephone units). If you
choose this layout, you can enter period-specific data for various profit centers or profit center
groups related to a statistical key figure or statistical key figure group of this kind. Statistical key
figures of this type are ones which occur anew for each period (for example telephone
consumption units). You can also enter a distribution key in this layout.

8A-711 Statistical key figure group type 1/profit center group
If you choose this layout, you can enter period-independent data for a statistical key figure or
statistical key figure group related to various profit centers or profit center groups of this kind.
These statistical key figures are type 1, that is, values which do not arise separately each month,
but ones of a more constant nature (for example number of employees). You can also enter a
distribution key in this layout.

8A-712 Statistical key figure group type 2/profit center group
Statistical key figures of type 2 are consumption values (for example telephone units). If you
choose this layout, you can enter period-independent data for a statistical key figure or statistical
key figure group related to various profit centers or profit center groups of this kind. You can also
enter a distribution key.
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Defining Layouts
Purpose
In Profit Center Accounting, layouts are required for the following functions:

•  Manual entry of

- actual data

- statistical key figures

•  Manual planning of

- costs and revenues

- balances

- statistical key figures

If you do not wish to use a standard SAP layout, you can define your own layout according to
your own requirements.

Process Flow
•  Define the general data selection

•  Define the lead columns

•  Define the value columns

Define General Data Selections
The general data selections determine what data appears in the headings of the layout. The
characteristics specified in the general data selections (such as company code, version, fiscal
year) apply to the whole planning layout. You can define variables for the characteristics in both
the general data selections and the columns. Variables make it possible for the planner to specify
which value(s) of that characteristic he or she wants to plan.

In a layout for creating a document, you choose the characteristics company code
and transaction currency in the general data selections. You use profit center,
account and posting line in the lead column.

In a layout for cost and revenue planning, you choose the characteristics “Version”,
“Period”, “Fiscal year” and “Profit center” in the general data selections. The value
columns contain key figures.

In a layout for a quarterly comparison in the plan version, you choose the
characteristics “Version” and “Fiscal year” in the general data selections, and place
the period and the profit center in the lead column and value columns.

Defining Lead and Value Columns
The structure of the rows and columns depends on which of the EC-PCA standard characteristics
you choose.
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You must specify characteristic values to each characteristic that you choose. For example, you
might choose the characteristic “Profit center” and then specify the values “Profit center 4711”
through “Profit center 4719”.

Defining Lead Columns
There are two ways you can define lead columns:

3. You can define one or more lead columns by double-clicking on the column headers.

This allows you to select one characteristic for each column header.

Cost Planning

1st lead column 2nd lead column 1st value column

Profit center Account Plan costs

4711 - 4719 400 000 - 403 000

420 000 - 429 000

If you define your lead columns like this, the SAP R/3 System proposes all the possible
characteristic value combinations of the defined lead columns.

4. You can define a single lead column by entering individual objects in the rows.

This allows you to choose one characteristic for each row or combine several
characteristics.

Version Planning

Lead column 1st value column

Version/quarter Plan costs

Version 1/quarter 1

Version 2/quarter 1

Version 1/quarter 2

Version 2/quarter 2

When you define a lead column this way, you can select specific characteristic values.

Defining Value Columns
There are three different classes of value columns:

3. You can define a column using a key figure with characteristics or using characteristics only.

In the dialog box for the first value column, you determine whether to use a key figure
with characteristics or only characteristics.
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To define a value column of the element type “Key figure with characteristics”, choose
one key figure from the list of existing key figures. Then you can specify characteristics
and characteristic values.

To define a value column of the element type “Characteristic”, choose characteristics and
then assign characteristic values.

4. You can define an attribute column.

Depending on the attributes used, you have two options for defining attribute columns.

– Attribute columns that directly apply to a value column

The attributes Distribution key, Unit, and Action should be assigned to a value
column. To create an attribute in this way, choose Edit → Columns → Append
add. fields.

– Attribute columns that do not directly apply to a value column

You can define all other attribute columns by double-clicking on the blank space next
to a column.

The Long text indicator shows which data records have long texts defined for them
when plan or actual data are created.

4. You can define a formula column

Formula columns are based on the values of columns already defined. You can see the
available value columns in the dialog box where you define the formula. The system
calculates the formula columns when you enter the values in the corresponding value
columns.

Defining Inverse Formulas
Inverse formulas let you enter values in a formula column and then have the system calculate
values for another column. To read about how to define an inverse formula, see Customizing.

You plan to give your employees a raise in the form of a percentage. You want the
system to calculate the plan value of the current year based on the percentage and
plan value of the previous year.

3. Define the following layout:

Layout

Lead column Value column 1 Value column 2 Formula column

Cost element Plan, current year Plan, previous year % raise
((Plan current -
Plan previous)
/Plan previous) x
100

Lock the column Plan, current year against user input and make the column % raise
as ready for input. Afterwards, create the inverse formula.

4. Plan (example):
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If you copy plan values from the previous year to the current year before beginning
manual planning (Planning → Copy plan template), you can then calculate the new
plan costs by entering the percentage raise.

After Copying the Plan Data

Cost Element Plan, Current Year Plan, Prev. Year % Raise

430000 50,000 50, 000 0

After Entering the Increase Manually

Cost Element Plan, Current Year Plan, Prev. Year % Raise

430000 50,000 50, 000 10

After Calculating the New Planning Costs

Cost Element Plan, Current Year Plan, Prev. Year % Raise

430000 55,000 50,000 10
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Entering and Displaying Actual Values or Statistical Key
Figures
Prerequisites
A suitable planning layout has already been defined for you, or you are using one of the standard
layouts delivered with the R/3 System.

Procedure
To enter actual data, choose Actual postings → Profit center-document → Enter.

To enter statistical key figures, choose Actual postings → Statistical key figures → Change.

Now make the desired entries on the following screens:

4. Entry screen [Page 289]

5. Characteristic screen [Page 290]

6. Entry screen [Page 292] for actual values / overview screen [Page 294] for statistical key
figures

7. Period screen [Page 296]

Result
You can display the actual postings you entered by choosing Actual postings → Profit center
document → Display.

You can display the statistical key figures you entered by choosing Actual postings → Statistical
Key figures → Display.
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Initial Screen
Procedure
1. Enter the name of the layout in which you want to enter/display the data.

2. You also have to make the following entries to enter actual data:

− Value date

For currency translation, the mean rate on the value date is used. If you do not make
an entry here, the system will take the posting date as the value date.

− Document type

You must always specify the document type. Document type FI-GLX actual direct
posting is usually provided as a default here.

− Document number

You only need to enter a document number here if you are using a document type
for which manual number assignment was set during definition.

− Posting date and special period

You must always enter the posting date. The current posting date is normally
provided as a default. If you wish to post on a different date, or in a special period,
you must change the posting date accordingly.

To display actual data which has already been entered, you need only enter the layout in
which you wish to view the data, plus the document number(s), document type and fiscal
year.

3. To enter statistical key figures, you also need to specify the following:

− Document type

You must always specify the document type. Document type FI-GLX actual direct
posting is usually provided as a default here.

− Default value for distribution key

The distribution key you enter here appears as the default value for new entries on
the overview screen. It can, however, still be changed.

To display statistical key figures which have already been entered, you need only enter
the layout in which you wish to view the data.

4. Choose .



Profit Center Accounting (EC-PCA)  SAP AG

Characteristic Screen

290 April 2001

Characteristic Screen
Procedure
Most layouts usually contain variables for certain characteristics (profit center, account, and so
on). By entering individual values for these variables on the characteristic screen, you specify
which characteristics you want to plan/enter in this session.

If default parameters were set for a characteristic when the corresponding layout was defined,
this characteristic appears on the characteristics screen, but cannot be changed. Instead, the
value displayed is a fixed value, corresponding to the value assigned to the characteristic when
the layout was defined.

3. In all fields not containing fixed values, enter the characteristic values and/or groups or
intervals of characteristic values for which you want to plan/enter data.

If you plan costs and revenues in the transaction currency, see Currencies in
Planning [Page 224].

4. If no default parameters have been set here, specify whether you want to perform “free” or
“form-based” planning.

If you select Free, the system displays all the objects (characteristic values) that meet
the selection criteria and already have data entered to be changed. In addition, you can
add further objects and plan these as well.

If you select Form-based, the system displays all those objects that meet the selection
criteria, regardless of whether or not plan data has been planned/entered for them. Each
time you call up a form-based layout, the system displays the same structure of
characteristic values. You cannot add any new characteristic values.

You enter/plan statistical key figures centrally for all profit centers belonging to the
profit center group “ABC”. On the initial screen of the planning transaction, you enter
profit center group “ABC”. This group contains profit centers 4110, 4120, 4130 and
4140. No values have yet been entered/planned for profit center 4110.

If you select Free, the system displays profit centers 4120, 4130, and 4140 along
with the corresponding plan data. The system does not offer you the possibility of
changing profit center 4110. You can add the profit center you still want to enter/plan.

If you select Form-based, the system displays all profit centers from the above-
mentioned group which are to be entered/planned; it is not possible in to add extra
profit centers to these rows.

4. Choose  to display the layout as it was defined in Customizing for Profit Center
Accounting.

You cannot make any changes here, as the purpose of this screen is merely to display
how the data was entered.

In Planning, the following functions are available:

−  Profile
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Displays the current planning profile with the corresponding layouts.

−  or 

Allows you to scroll between characteristic screens of the other layouts in the current
planning profile.

5. Return to the characteristic screen. By choosing  you can go to

− the entry screen [Page 292] for actual document entry

− the overview screen (plan data) [Page 196] for planning

− the overview screen (statistical key figures) [Page 294] for entering statistical key
figures
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Entry Screen (Actual Data)
Procedure
Once you have entered values for the variables, you can enter your data.

Before branching to the entry screen, the system reads existing data in the database for the
relevant characteristics and summarizes this data in accordance with the specified
characteristics.

When new or changed data is posted, non-specified characteristics remain blank. Exceptions to
this rule are the origin object type, which always has the value 01 (origin Profit Center
Accounting).

At the same time, the system locks the objects that appear so that no one else can process them
while you are doing so.

On the entry screen, proceed as follows:

1. Enter values for your selected combinations of characteristics.

2. The following functions are available here:

Format to Print [Ext.]

Cut [Ext.]

Copy [Ext.]

Paste [Ext.]

Change values [Ext.]

Period screen [Ext.]

Insert [Ext.]

Clear row, redo, undo [Ext.]

Overview screen [Ext.]

Next combination, previous combination, other combination [Ext.]

Next layout, previous layout [Ext.]

Number format [Ext.]

Lead columns [Ext.]

All key values on/off [Ext.]

Header display on/off [Ext.]

(The functions are listed here for purposes of entering plan data, though they can also be
used when entering actual data).

3. You can store a long text for a data record. To do so, select the line and choose Edit → Long
text. You can store long texts for data records with one of the following characteristics in the
key:

Ledger, record type, version, fiscal year, controlling area, profit center, account,
statistical key figure, company code, partner profit center, plant, representative material.
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It is not possible to create separate long texts for data records that do not differ in at
least one of these fields. For example, you cannot define two long texts for records
that have different functional areas but are the same in all other characteristics.

4. Save your entries.

The actual data you enter or change is written to the database; the non-specified characteristics
are not affected.
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Overview Screen (Statistical Key Figures)
Procedure
Once you have entered values for the variables, you can enter your data.

Before branching to the overview screen, the system reads existing data in the database for the
relevant characteristics and summarizes this data in accordance with the specified
characteristics.

When you post new or changed statistical key figures are posted, the system leaves any
unspecified characteristics blank. Exceptions to this rule are the origin object type, which always
has the value 01 (origin Profit Center Accounting) the unit of quantity, which automatically
contains the dependent value.

At the same time, the system locks the objects that appear so that no one else can process them
while you are doing so.

On the overview screen, proceed as follows:

3. Enter values for your selected combinations of characteristics.

On the overview screen, the system displays the default distribution key from the initial
screen. You can, however, still change it.

Note that, in contrast to previous Releases, fixed values (statistical key figures of
type 1) can only be entered for previously selected periods. The fixed value is no
longer updated in later periods.

4. The following functions are available here:

Format to Print [Ext.]

Cut [Ext.]

Copy [Ext.]

Paste [Ext.]

Change values [Ext.]

Period screen [Ext.]

Insert [Ext.]

Clear row, redo, undo [Ext.]

Overview screen [Ext.]

Next combination, previous combination, other combination [Ext.]

Next layout, previous layout [Ext.]

Number format [Ext.]

Lead columns [Ext.]

All key values on/off [Ext.]

Header display on/off [Ext.]
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(The functions are listed here for purposes of entering plan data, though they can also be
used when entering statistical key figures).

5. You can store a long text for a data record. To do so, select the line and choose Edit → Long
text. You can store long texts for data records with one of the following characteristics in the
key:

Ledger, record type, version, fiscal year, controlling area, profit center, account,
statistical key figure, company code, partner profit center, plant, representative material.

Note that it is not possible to write separate long texts for records with different
characteristic values. For example, you cannot define two long texts for records that
have different functional areas but are the same in all other characteristics.

6. Save your entries.

The statistical key figures you enter or change are written to the database. All unspecified
characteristics remain blank.
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Period Screen
Procedure
On the period screen, you can display and change the distribution of your statistical key figures
or plan data to periods. To reach the period screen, proceed as follows:

3. On the overview screen, position the cursor on an entry and then choose Period screen.

4. You can either use the default values provided by the system or enter your own period
values.

If desired, you can set a distribution key other than the default one provided by the
system in the overview screen. This allows you to distribute the data to periods
differently.
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Balance Sheet Items in Profit Center Accounting
Use
You can analyze selected balance sheet items by profit center. The persons in charge of the
profit center are therefore responsible not only for the success but also the fixed capital of the
profit center. It is also possible to calculate key figures which compare the success of the profit
center with its fixed capital (return on investment).

Balance sheet items can be transferred periodically or online in realtime. For further information,
see:

Transferring Balance Sheet Items Periodically [Page 299]

Transferring Balance Sheet Items in Realtime [Page 315].

Features
The graphic below illustrates the flow of data from other components to Profit Center Accounting,
as occurs when balance sheet items are transferred online.

A L

PrCtr

MMMM

AMAM

WIP
COCO

General Ledger
Balance sheet

Assets
Receivables
Mat. Stocks
WIP

Payables

Payables/ Receivables

Subs. ledger

Asset

Mat. stock



Profit Center Accounting (EC-PCA)  SAP AG

Balance Sheet Items in Profit Center Accounting

298 April 2001



 SAP AG Profit Center Accounting (EC-PCA)

Transferring Balance Sheet Items Periodically

April 2001 299

Transferring Balance Sheet Items Periodically
Use
You can transfer the following balance sheet items to Profit Center Accounting in the standard
R/3 System at end of period:

•  Payables and receivables

For further information on how the system transfers these balances, see Period Closing
Activities for Payables/Receivables [Page 306].

•  Material stocks

•  Assets

•  Work in process

Work in Process

Prerequisites
Even if you decide to transfer balance sheets in realtime [Page 315], you must first run the
corresponding transfer programs, to create the opening balances.

Features
When you run the transfer program for the first time, the system calculates the opening balance
via the source application, and transfers it to Profit Center Accounting. In subsequent periods, the
system calculates the balance and posts the difference between this and the opening balance of
the period in question to Profit Center Accounting.

If line items are created during the transfer, the accompanying reports do not provide you with
the difference, but the current balance for each object (material, asset, debtor, creditor) and Profit
Center.

All of these programs provide a Management function that allows you to see when what data has
already been transferred.

You can also delete any management information that you no longer need. You cannot delete
current entries, since the system still requires these.
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If you run a manual transfer, the system overwrites any corresponding data that was
already transferred to Profit Center Accounting. For example, if certain material
stocks have already been transferred in realtime and you want to run a periodic
transfer for the same period, the system first deletes the data that was already
transferred. When this happens, you lose the information on the inventory posting
documents for each transaction. The periodic transfer programs only create one
posting per object, which contains the previous balance (the difference in the
balance for work in process).

Activities
You can find details of the different kinds of periodic transfer under:

Period Closing Activities for Payables/Receivables

Period Closing Activities for Payables and Receivables  l [Page 301]

Period Closing Activities for Material Stocks [Page 309]

Period Closing Activities for Work in Process [Page 311]

Period Closing Activities for Assets [Page 313]
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Transferring Payables and Receivables
Use
The system transfers payables and receivables to Profit Center Accounting together. The transfer
can only be made periodically.

The logic behind the assignment of receivables to various profit centers is demonstrated in the
following examples:

Example: Billing Document from SD [Page 302]

Example: Direct Revenue Posting in FI [Page 303]

Meanwhile, the logic behind the assignment of payables to various profit centers is demonstrated
in the following examples:

Example: Purchase Order to Warehouse [Page 304]

Example: Direct Posting of Invoice Receipts in FI [Page 305]

The assignment of payables and receivables to various profit centers is basically derived from
the offsetting entry line of the FI document to which they belong. It is not possible to make
structural changes to them within Profit Center Accounting. If, for example, you assign a new
profit center to a material, or change the derivation rules when creating sales orders, these
actions do not affect the assignments of documents which have already been posted.

Down payments represent a payable or a receivable for a customer. Therefore you can also
assign down payments to profit centers. As postings for down payments do not reference an
invoice, the system cannot assign them automatically to profit centers. However, you can enter
the profit center manually on the corresponding assignment screen. The system then posts the
down payment through to the assigned profit center. If you allocate the down payment, the
system also posts this to Profit Center Accounting.

Note that an account that has been selected as an additional balance sheet or profit and loss
account for transferring to Profit Center Accounting is not transferred when you run the transfer
upon period-end closing. As you are assigning the down payments directly to a profit center, it is
logical to set online transfer for the accounts to which they belong. If you do this, these accounts
will not be transferred when you next run the transfer, thus avoiding double transfer.

Activities
For information on how to transfer payables and receivables periodically, see Period Closing
Activities for Payables/Receivables [Page 306].
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Example: Billing Document from SD
For general information on transferring billing documents from SD, see also Actual Postings
[Page 226].

Billing document:

Item 1 300.00 (Profit center A)

Item 2 700.00 (Profit center B)

This billing document is posted in FI as follows (taxes and other lines have been left out for the
sake of simplicity).

FI document:

Receivables 1,000.00 to

Revenues 300.00 (Profit center A)

Revenues 700.00 (Profit center B)

An index is created which points to the FI document which is to be divided. In period closing, all
the open items are selected and the receivables lines divided proportionally to the revenue lines.

In the standard setup in Release 3.0, the profit centers are updated in the FI
document, while the partner profit centers are summarized. You can change these
settings in Customizing for Financial Accounting. If the partner profit centers are not
updated in the revenue lines of the FI document, how the receivables are divided to
profit centers is stored in the index.

The revenues are posted online in Profit Center Accounting:

Profit center document:

Revenues 300.00 (Profit center A)

Revenues 700.00 (Profit center B)

Partial payments are distributed according to the original receivable. If a partial payment of
500.00, 150.00 is distributed to profit center A and 350.00 to profit center B.
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Example: Direct Revenue Posting in FI
FI-document:

Receivables 1,000.00 to

Revenues 300.00 (Profit center A)

Revenues 700.00 (Profit center B)

An index is created which points to the FI document which is to be divided. In period closing, all
the open items are selected and the receivables lines are divided proportionally to the revenue
lines.

In the standard setup in Release 3.0, the profit centers are updated in the FI
document, while the partner profit centers are summarized. You can change these
settings in Customizing for Financial Accounting. If the partner profit centers are not
updated in the revenue lines of the FI document, how the receivables are divided to
profit centers is stored in the index.

The revenues are updated online in Profit Center Accounting:

Profit center document:

Revenues 300.00 (Profit center A)

Revenues 700.00 (Profit center B)

Partial payments are distributed according to the original receivable. If a partial payment is of
500.00 is made, 150.00 is posted to profit center A and 350.00 to profit center B.
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Example: Purchase Order to Warehouse
Purchase order:

Material 1 300.00 (Profit center A)

Material 2 700.00 (Profit center B)

Here, the profit centers are derived from the material master.

Goods receipt posting:

Stock 1 300.00 (Profit center A)

Stock 2 700.00 (Profit center B) to

GR/IR 300.00 (Profit center A)

GR/IR 700.00 (Profit center B)

GR/IR is the clearing account for goods received/invoice receipts.

Invoice receipt:

GR/IR 300.00 (Profit center A)

GR/IR 700.00 (Profit center B) to

Payables 1,000.00

At receipt of invoice, an index is updated for the documents to be divided. This index points to the
accounting document only, as the division of the payables is contained in the offsetting lines
(GR/IR lines).

Partial payments are distributed according to the original payable. If a partial payment of 500.00
is made, 150.00 is posted to profit center A and 350 to profit center B.
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Example: Direct Posting of Invoice Receipts in FI
FI posting:

Raw materials usage 300.00 (Cost center A → Profit center A)

Raw materials usage 700.00 (Cost center B → Profit center B) to

Payables 1,000.00

The usage lines are transferred directly to Profit Center Accounting.

When the FI posting is made, an index is created for the documents to be divided. This index
points only to the accounting document, as the division is contained in the counter-lines (raw
materials consumption).

If you post payables directly in FI, payables can only be divided to profit centers if
you have entered a counter-line for each participating profit center.

Profit center document:

Raw materials usage 300.00 (Cost center A → Profit center A)

Raw materials usage 700.00 (Cost center B → Profit center B)

Partial payments are distributed according to the original payable. If a partial payment of 500.00
is made, 150.00 is posted to profit center A and 350.00 to profit center B.

s
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Period Closing Activities for Payables/Receivables
Purpose
You transfer payables and receivables [Page 301] to Profit Center Accounting in the course of
normal period-closing activities.

You can transfer payables and receivables as often as you wish, since the system deletes
previously transferred data before each new transfer.

Process Flow
Step 1: Calculation
The payables and receivables to be divided are calculated in FI at the end of the period. This is
done under the menu option Accounting → Financial Accounting → General ledger → Periodic
processing → Closing → Regroup → Balance sheet readjustment → Calculate B/S
readjustment).

Enter the company codes for which you want to perform the calculation. For these company
codes, the payables and receivables are divided according to profit center and business area.
The results are then saved.

Once you have calculated the payables and receivables to be transferred, you can use the
standard report FI document for payables/receivables to access the FI document directly (see
Standard Report Painter Reports in Profit Center Accounting [Page 334]).

You can display the breakdown of payables and receivables for each FI document
under the menu option Environment → Subsqt BA/PA adjstmt.

Step 2: Posting
You can now transfer the data to Profit Center Accounting. Do not choose the next menu
option Post B/S readjustment n Financial Accounting. Instead, transfer the data in the Profit
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Center Accounting application menu under the menu option Actual postings → Period-end
closing → Transfer payables/receivables.

You obtain a list of all the company codes in the active controlling area. Select the desired
company codes and the period and fiscal year which you want to transfer to Profit Center
Accounting.

The system then posts the payables and receivables to Profit Center Accounting under the
reconciliation accounts of the general ledger. No FI documents are created in the process.

Checkboxes on the selection screen let you run the program in the test mode or in the
background. If you check off Line items, the system writes a line item for each customer and
each supplier. You can use this function for purposes of reconciliation.

Result
The payables and receivables from the period in question are transferred to Profit Center
Accounting. They are assigned to the profit centers via the accounting documents.

The program prints an error log. You can display the updated data using standard reports in
Profit Center Accounting. You can display the transferred data in the information system (see
Standard Reports [Page 331]). Provided that line items are available, you can analyze them
using the corresponding line item report and. if desired, compare them with FI document for
payables/receivables.

First the program updates the final balance of open receivables and payables. It also
determines the final balance of the previous period and updates this with a minus
(“-”) sign. As a result, the summary records in each period contain the movements in
the payables and receivables, as is customary in Financial Accounting. This indirect
method has the advantage that you do not need to carry the balance forward in Profit
Center Accounting at the end of the year. The total balance of open payables and
receivables is posted to the period 01 if there is no balance in period 0.

If you want to create your own Report Writer reports, note that you obtain the final balance of a
period by adding up the summary records of the periods 0 through the desired period.
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Period Closing Activities for Material Stocks
Purpose
You transfer material stocks to Profit Center Accounting in the course of closing operations in
Materials Management.

You can transfer material stocks as often as you wish, since the system deletes previously
transferred data before each new transfer.

Should you have already transferred the balance for material stocks online during the
same month, note that the stock postings made here will also be deleted.

If you would like to transfer material stocks online, generate the opening balance in Profit Center
Accounting. You do this by performing the period closing activities once, prior to selecting online
transfer.

Prerequisites
To transfer material stocks to Profit Center Accounting, you must be using the component
Materials Management (MM).

The period in Materials Management should have ended.

Process Flow
You access the function for transferring material stocks by selecting Actual postings →→→→
Transferring selected balance sheet items →→→→ Generate opening balance for material stocks in
Customizing for Profit Center Accounting.

The selection screen provides you with the choice of all company codes within the active
controlling area. Select the period to be transferred. The current period is always based on the
status of Materials Management. Normally, the data from the previous period is transferred.

On 3rd June 1997, the period closing program in Materials Management has already
run. The current period in MM is 06/1997. To transfer data for May, choose the
previous period.

You should run the program in the background, as large amounts of data are normally selected.
The option line item ensures that a document is created for each material number in Profit Center
Accounting. Due to the large volume of data generally processed when operating this option, you
should only use it for test purposes.

Material stocks are posted to Profit Center Accounting under the same reconciliation account as
for Financial Accounting. The system does not create any FI documents when the transfer is
made.

The system assigns material stocks by taking the assignment in the material master record, in
the plant segment (see Assigning Materials [Page 78]). The system assigns valuated sales order
stocks via the sales document item or the WBS element.
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It may not be possible to assign raw material stock to any single profit center. In this
case, they can be assigned to individual profit centers by means of distribution (see
Assessment and Distribution [Page 321]).

Result
The material stocks from the period in question are transferred to Profit Center Accounting. They
are assigned to profit centers via assignments made in the component Materials Management
(MM).

The program prints an error log. You can display the transferred data in the information system
(see Standard Report Painter Reports in Profit Center Accounting [Page 334]). Provided that line
items are available, these can be analyzed with the corresponding line item report.

First, the program updates the final balance of materials. It also determines the final
balance of the previous period and updates this with a minus ("-") sign. As a result,
the summary records for each period contain the movements in material stocks, as is
customary in financial accounting. This indirect method has the advantage that you
do not need to carry the balance forward in Profit Center Accounting at the end of the
year. The total balance of material stocks is posted to the period 01 if there is no
balance in period 0.
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Period Closing Activities for Work in Process
Purpose
You transfer WIP (Work in process) to Profit Center Accounting in the course of normal period
closing, following results analysis in Product Cost Controlling.

You can transfer work in process as often as you wish, since the system deletes previously
transferred data before each transfer.

Should you have already transferred the balance online in the same month, please
note that the stock postings made here will also be deleted.

If you would like to transfer work in process online, generate the opening balance in Profit Center
Accounting. You do this by performing the period-closing activities once, prior to selecting online
transfer.

Prerequisites
To transfer work in process to Profit Center Accounting, you must be using the component
Product Cost Controlling (CO-PC).

As the transfer of work in process is based on data from the results analysis in CO-PC, the data
cannot be transferred until after this analysis has been performed. The transfer of data to Profit
Center Accounting is based on the results analysis, though it does not take account of whether or
not a settlement has been made in Financial Accounting (FI).

Perform the transfer to Profit Center Accounting as soon as possible after settlement
from CO-PC to FI. If you do not do this, discrepancies may arise between Profit
Center-Accounting and FI.

Process Flow
You access the transfer function by choosing Actual postings →→→→ Transferring selected balance
sheet items →→→→ Generate opening balance for work in process.

The selection screen provides you with the choice of all company codes within the active
controlling area. You also enter the period and fiscal year.

You generally work with the standard results analysis version 0. Should you wish to use a
different results analysis version [Ext.], note that this must be set up in CO Customizing for
updating in Financial Accounting, as the corresponding account determination is required.

The program transfers all changes in work in process within a single period. When running this
function for the first time with a given controlling area, please select the field Create opening
balance. The system then posts the opening balance to the start period. You can also post the
opening balance to period 01 at fiscal year change, so avoiding having to carry the balance
forward.
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You only have to select the field Create opening balance in the two cases mentioned
above. Otherwise, inconsistent data will be generated, leading in turn to incorrect
valuations in reporting. Creation of the opening balance also increases the transfer
program's runtime.

You should run the program in the background, as large amounts of data are normally selected.
If you select the field Line item, a line item will be created for each CO object. When handling a
large volume of data, you should only use this option for test purposes. The system does not
create any FI documents.

The system assigns work in process to profit centers by taking the assignment of open
production orders, projects, sales orders etc. (see Profit Center Assignments [Page 76]).

Result
The balance of work in process from the period in question is transferred to Profit Center
Accounting. It is assigned to the profit centers via assigned CO objects.

The program prints an error log. You can display the transferred data in the information system
(see Standard Reports). Provided that line items are available, these can be analyzed with the
corresponding line item report.
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Period Closing Activities for Assets
Purpose
You transfer asset balances to Profit-Center Accounting in the course of normal period closing in
Asset Accounting.

You can transfer asset balances as often as you wish, since the system deletes previously
transferred data before each transfer.

Should you have already transferred the balance online in the same month, please
note that the stock postings made here will also be deleted.

If you would like to transfer asset balances online, generate the opening balance in Profit Center
Accounting. When doing this, perform the period-closing activities once, prior to selecting online
transfer.

Prerequisites
To transfer asset balances to Profit Center Accounting, you must be using the component Asset
Accounting (FI-AA).

As the program only transfers posted depreciations, the data cannot be transferred until after
completion of the posting run for depreciations in Asset Accounting.

Process Flow
You access the transfer program by selecting Actual postings → Transferring selected balance
sheet items → Generate opening balance for assets in Customizing for Profit Center Accounting.

The selection screen provides you with the choice of all company codes within the active
controlling area. The depreciation area book depreciation per trade law (01) is provided as a
default. You also select the posting period and the fiscal year.

You should run the program in the background, as large amounts of data are normally selected.
If you select the field Line item, a line item will be created for each asset in Profit Center
Accounting. When handling a large volume of data, you should only use this option for test
purposes.

The system assigns assets to profit centers indirectly, via assigned internal orders or cost centers
(see Assigning Assets [Page 95]). The program transfers the acquisition and product costs, as
well as cumulated value adjustments. The accounts used for this transfer are taken from account
determination for Asset Accounting.

Note that it is only possible to calculate key figures (such as Return on Investment) in Profit
Center Accounting correctly if an indirect statement of assets and depreciations is made in
Financial Accounting.

Parallel Currencies
In Asset Accounting, parallel currencies are represented in parallel depreciation areas, which
only differ in currency. The areas are transferred automatically when you enter the main area
(e.g. 01). If a parallel area exists with the currency type of the profit center currency, the system
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transfers the corresponding area. If this is not the case, the system translates the data into the
profit center currency.

A company in the USA has a subsidiary in Canada. The Canadian subsidiary uses
the depreciation area book depreciation per trade law in company code currency
Can $. Parallel to this, it uses an area group currency in US $. The profit center
currency for the controlling area is US $. When transferring the area book
depreciation per trade law, the data from this area is saved in the company code
currency (Can $), while the data from the depreciation area group currency is
saved in the profit center currency (US $).

Result
The asset balances from the period in question are transferred to Profit Center Accounting. They
are assigned indirectly to profit centers, via assigned internal orders or cost centers.

The program prints an error log. You can display the transferred data in the information system
(see Standard Report Painter Reports in Profit Center Accounting [Page 334]). Provided that line
items are available, these can be analyzed with the corresponding line item report.

First, the program updates the opening balance of assets. It also determines the final
balance of the previous period and updates this with a minus ("-") sign. As a result,
the totals records in each period contain the movements in assets, as is customary in
Financial Accounting. This indirect method has the advantage that you do not need
to carry the balance forward in Profit Center Accounting at the end of the year. The
total balance of assets is posted to the period 01 if there is no balance in period 0.
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Transferring Balance Sheet Items in Realtime
Use
The following balance sheet items can be transferred online in realtime:

•  Material stocks

•  Assets

•  Work in process

•  Other balance sheet items (transaction-based only)

The system posts balance postings directly to Profit Center Accounting from online postings
which directly affect the balances of assets, materials and work in process. If you have line items
in Profit Center Accounting, the system updates a profit center document for each reference
document (e.g. MM or FI document).

Integration
In order to transfer assets online to Profit Center Accounting, you must be using the component
Assets Accounting (FI-AA).

In order to transfer material stocks online to Profit Center Accounting, you must be using the
component Materials Management (MM).

In order to transfer work in process online to Profit Center Accounting, you must be using results
analysis in the component Product Cost Controlling (CO-PC).

Prerequisites
You first need to enter the accounts you want to transfer to Profit Center Accounting in the
Customizing transaction for balance sheet and profit and loss accounts.

In addition, you need to run each program once to create the opening balance for materials, work
in process and assets from the source application (see Transferring Balance Sheet Items
Periodically). For further information, see:

Period Closing Activities for Material Stocks [Page 309]

Period Closing Activities for Work in Process [Page 311]

Period Closing Activities for Assets [Page 313]

Note that if you have also created asset accounts as statistical cost elements (type 90) to update
investment orders, you must still treat these the same way as normal balance sheet accounts.
Updating in realtime in Profit Center Accounting is only possible if you have entered the accounts
as additional balance sheet accounts and P&L accounts in Customizing.

You must post the opening balance for other balance sheet items to transfer online by creating
the documents manually, as transfer reports cannot be carried out here. You also have to assign
a default profit center to each of the accounts in question in Customizing for Profit Center
Accounting. When posting in FI, however, you can set a different profit center manually. You can
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also define derivation rules for finding the profit center, where no profit center has been set for a
posting. See Derivation Rules for Finding the Profit Center [Ext.] in the Implementation Guide
(IMG) for Profit Center Accounting. You can find further information about derivation in the
documentation for Profitability Analysis (CO-PA) under Characteristic Derivation [Ext.].

When you assign down payments to a work breakdown structure element, the system finds the
profit center to which it is assigned. It can therefore make sense to transfer down payments
online.

Features
After you have created the opening balance, the system always transfers the difference between
the new balance and the previous balance.

At the end of the year, you need to carry forward [Page 318] the balances for the balance sheet
items that were posted in realtime to Profit Center Accounting.

The system assigns work in process to profit centers by taking the assignment of open
production order, projects, sales orders etc. (see Profit-Center-Assignments [Page 76]).

The system assigns assets to profit centers indirectly, via assigned internal orders or cost centers
(see Assigning Assets [Page 95]). The program transfers the acquisition and product costs, as
well as cumulated value adjustments.

The system assigns material stocks by taking the assignment in the material master record, in
the plant segment (see Assigning Materials [Page 78]). The system assigns valuated sales order
stocks via the sales document item or the WBS element.

If you run a manual transfer, the system overwrites any corresponding data that was
already transferred to Profit Center Accounting. For example, if certain material
stocks have already been transferred in realtime and you want to run a periodic
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transfer for the same period, the system first deletes the data that was already
transferred. When this happens, you lose the information on the inventory posting
documents for each transaction. The periodic transfer programs only create one
posting per object that contains the balance from the previous period (or the
difference to this balance for work in process).
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Balances Forward
Use
If you want to post material stocks, assets, work in process or Additional Balance Sheet Items to
Profit Center Accounting by transaction, you need to carry balances forward during the course of
year-end closing. Otherwise this step is optional.

When you carry balances forward, the profit and loss accounts are carried forward to the special
account entered for that income statement account type in Customizing (see Customizing for
Profit Center Accounting). Postings are divided according to controlling area, profit center, origin
object type and transaction. Balance sheet accounts are carried forward under the same account
and divided according to controlling area, profit center, partner profit center, partner company,
function area, transaction, depreciation area (for assets) and results analysis version (for work in
process).

Once you have activated the function for carrying balances forward in Profit Center Accounting
(see Customizing), the system performs it automatically in the actual system for all postings
which are transferred from Financial Accounting or entered manually in Profit Center Accounting.

Activities
The function is found in the EC-PCA application menu under

•  Actual postings → Period-end closing → Balance carried forward.

•  Planning → Planning closing → Balance carried forward

On the selection screen, enter the company code and the fiscal year to which you want to
transfer the balances. Enter version 0 for actual data or the desired plan version for plan data.
You also need to specify which you want to carry forward plan values or actual values.

You can also execute this function in test mode. To execute it in the background, choose
Program → Execute in background.
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Cash Discounts and Exchange Rate Differences
Use
As with payables and receivables, you can also assign cash discounts and exchange rate
differences to the corresponding profit centers at the end of the period.

This is explained in the examples below on the basis of cash discount expenses on the debit
side. The receivables and revenues are handled as described in the sections Transferring
Paybles and Receivables [Page 301] and will therefore not be discussed here. ..

Example: Cash discounts paid
Billing document:

Item 1 800 (Profit center A)

Item 2 200 (Profit center B)

FI posting:

Receivables 1000 to

Revenues 800 (Profit center A)

Revenues 200 (Profit center B)

For simplicity, taxes and other items were left out.

Incoming payments:

Bank 980

Cash disc. exp. 20 to

Receivables 1000

The cash discount expenses are not transferred to Profit Center Accounting online. You can
transfer them at the end of the period using the function Prof.segm.adjstmt. This program also
divides the data according to business areas. You can find the function under Accounting →
Financial Accounting → General ledger → Periodic processing → Closing → Regroup →
P&L adjustment.

The program creates a batch-input session. The system automatically proposes SAPF181 as the
session name. When you process the session, the following FI posting is created:

FI document:

Cash disc. exp. 16 (Profit center A)

Cash disc. exp. 4 (Profit center B) to

Cash disc. exp. 20

The debit lines are posted to Profit Center Accounting:

Profit center document:
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Cash disc. exp. 16 (Profit center A)

Cash disc. exp. 4 (Profit center B)

The credit lines are not posted to Profit Center Accounting, since the profit center is blank and
the account is not a cost element.

Exchange rate differences are treated in accordance with this example.

If the cast discount/exchange rate difference accounts are created as cost
elements...
the postings will be automatically assigned to a CO object, such as a cost center.
This is to avoid inconsistencies which would arise between CO and Profit Center
Accounting in the case of secondary allocations in CO.

 Postings might exists which are not relevant to an invoice, such as...

•  manual postings to the cash discount account

•  resetting cleared items without reversing the payment

•  rounding differences between the splitting program and the payment

•  exchange rate differences when resetting bank payments

The splitting program does not take account of postings of this kind. These postings
should be transferred to Profit Center Accounting, however, so that the balance of
accounts in Financial Accounting agrees with the balance in Profit Center
Accounting.

To do so, enter the corresponding accounts in Customizing for Profit Center
Accounting, under Actual Postings → Choose Additional Balance Sheet and P&L
Accounts [Ext.]  → Choose Accounts [Ext.] and assign a default profit center to them.
When the splitting program has been run, postings which could not automatically be
assigned to another profit center via the billing document remain in this default profit
center. They must then be reassigned manually.

If adjustment accounts exist for the affected accounts, they should be assigned to
the same default profit center.
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Assessment and Distribution
Use
Assessment and distribution are described under the umbrella term Allocations.

Assessment and distribution of relevant overhead costs is performed at period closing (actual
data) or plan closing (plan data). This is usually done directly in CO and then reflected in the data
in Profit Center Accounting.

If you have a service profit center or allocation profit center in your profit center hierarchy,
you may need to assess or distribute costs again in Profit Center Accounting.

In Profit Center Accounting, the allocation function allows you to allocate the following plan and
actual data.

•  Costs (assessment and/or distribution)

•  Revenues and sales deductions (assessment and/or distribution)

•  Balance sheet items (distribution)

Assessment is made using a special cost/revenue element.

In distribution, the original cost/revenue element/account number is retained.

You can use other posted values, quantities or statistical key figures as a basis for allocations
(see Statistical Key Figures and Statistical Key Figure Groups [Page 73]).

If you want to use a statistical key figure as the basis for an allocation, you need to
use the field group 04 (actual quantities) and enter the account group SPACE.

From Release 4.6 A, you can allocate data in Profit Center Accounting at controlling
area level. This makes it possible to process all company codes belonging to a
controlling area in one single cycle. You specify the controlling area in the cycle
header data. Note, however, that the actual allocations are made within one
company code only.

Prerequisites
Before performing assessment or distribution in Profit Center Accounting, check whether the
following steps have been carried out:

1. For actual data
a. Period-closing activities have been completed in all applications which supply EC-PCA

with data (FI, CO, SD, MM etc.).

b. Any additional actual data required in Profit Center Accounting has been created.

2. For plan data
a. All relevant plan data has been transferred from the component CO.

b. Direct planning in Profit Center Accounting has been completed.
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If any of these steps have not been carried out, you will need to cancel the assessment or
distribution as soon as the base values and tracing factors which you used change again. You
will then need to restart the assessment or distribution.

Activities
A general description of allocations can be found in the R/3 Library for the component FI Special
Ledger (for an introduction, see Allocation: Introduction [Ext.])

The only difference in Profit Center Accounting is that it is not necessary to enter the
ledger described in the above-mentioned documentation, since the system
automatically uses the profit center ledger 8A.

In Profit Center Accounting, you can find assessment and distribution

•  in the application menu under Planning → Plan Allocations and under Actual Postings.

•  in Customizing under Planning → Allocations and under Actual Postings. In the
Implementation Guide (IMG), you can find further information which applies specifically to
Profit Center Accounting.
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Preparation for Consolidation
If you want to represent results for profit centers across company codes, it is necessary to
eliminate internal business and profits which result from flows of goods and services within a
group (or a consolidation area) which cross different company codes. For this elimination for
cross-company-code transactions, you also need the partner information at the profit center level.

The system finds the partner company as well as the partner profit center from the customer or
supplier master record and updates this in Profit Center Accounting. This makes this information
available for profit center consolidation.

If you are not using the modules Sales and Distribution (SD) and Materials Management (MM),
you must transfer the partner profit centers from your external system to Financial Accounting in
R/3. If you are using the R/3 Logistics components, you have the following options:

In normal handling via purchase order and sales order, the partner information can be found
automatically if

•  the companies involved are stored in one central R/3 system

•  you are using the modules SD and MM

If these prerequisites are not met, you can still find the partner profit center using derivation rules.
See the Implementation Guide (IMG) for Profit Center Accounting under Derive Partner Profit
Center in Purchasing and Sales [Ext.].

If the prerequisites are met for some or all companies, you need to activate reading of the partner
profit center in Customizing, by identifying affiliated companies which are stored in you R/3
system and which use MM. The system can then find the partner profit centers for these
companies by reading the purchase order (see Customizing).

The partner information is found as follows: When you create the sales order for the purchase
order, you enter the R/3 order number in the order header. Then you enter the corresponding
items in the sales order items (Items → Ordering data). This creates the relationship between the
sales order and the purchase order. The system checks your entries for the ordering data in the
sales order to see whether the customer is a partner company for which it should determine the
partner information. Specifically, the system checks whether

•  the entries were made

•  the order item exists

•  the material numbers agree in the sales order and purchase order items (otherwise the
system displays a warning)

When you post the goods issue and the billing document for the sales order in Accounting, the
system reads the purchase order using the ordering information in the sales order. If the
purchase order item is assigned to more than one profit center, the corresponding revenue line is
split according to partner profit centers and posted accordingly in Profit Center Accounting.

Similarly, the system reads the sales order when you post the goods receipt and invoice receipt
for the purchase order. The sales order item always contains one profit center only, which is then
entered in the documents for the goods receipt and invoice receipt as the partner profit center.

This process is illustrated in the graphic below:
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Purchase order X

Item 1
Profit Center

A

Customer (A)
Sales order

Profit Center B
Purchase order: X
Purch. order item: X1

Supplier (B)

Billing document

Profit Center: B
Partner PrCtr: A

Invoice receipt

Profit Center: A
Partner-PrCtr: B

Delivery
Goods issue

Profit Center: B
Partner-PrCtr: A

Goods receipt

Profit Center: A
Partner-PrCtr: B

Prerequisite for reading
Read partner PrCtr

In stock transfer orders (stock transfer with delivery and billing document), the system
automatically creates a delivery note based on the purchase order. (A sales order is not used.) In
this case the ordering information is passed on by the system and therefore does not need to be
created manually. The partner is then found the same way as described above, except that the
system reads the delivery note instead of the sales order upon goods receipt or invoice receipt.

This case is illustrated in the graphic below:
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Purchase order 

Profit Center
A

Customer 
Delivery

Profit Center B

Supplier

Billing document

Profit Center: B
Partner PrCtr: A

Invoice receipt

Profit Center: A
Partner PrCtr: B

Goods issue

Profit Center: B
Partner PrCtr: A

Goods receipt

Profit Center: A
Partner PrCtr: B

Read  Partner PrCtr

Stock transfers across company codes which are created directly in inventory management are
handled the same way as stock transfers within one company code. Thus they pose no additional
difficulties.

For cost accounting allocations across company codes, the partner profit center can always be
determined automatically based on the CO objects involved (cost centers, orders, and so on).

In warehouse sales which are independent of company code (cross-company scenario) the
system finds the partner profit center for intercompany billing (IB) by reading the customer billing
document (or the customer credit memo in the case of a return delivery). To be able to do this,
the customer billing document (or customer credit memo) must have been created before the IB
document.

When an invoice is received for an internal billing, the partner profit center can be set using a
user exit. If you do this, it will no longer be possible to determine the partner profit center
automatically.

You can carry out profit center consolidation in the R/3 System using Consolidation (EC-CS).
(See also Role of EC PCA in the R/3 System [Page 12].).

For more information, see the Implementation Guide (IMG) for Profit Center Accounting, under
Preparation for Consolidation [Ext.].
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Information System
Purpose
The information system lets you analyze all the Data in Profit Center Accounting [Page 17]
individually as well as in a summarized form according to different criteria.

The reports in the Profit Center Accounting information system can be classified into five groups:

•  Drilldown reports

•  Report Painter reports (and Report Writer reports)

•  Summary record reports

•  Line item reports

•  Master data index

Reporting in Profit Center Accounting is always dependent on a controlling area.
Profit Center Accounting does not support cross-controlling area analyses.

The controlling area can be defined as a user parameter for parameter ID 'CAC‘ and
then be used automatically in future.

Integration
You need this component to analyze your profit center data.

Features
You can analyze all the data stored in the summary record table for Profit Center Accounting
(table GLPCT) using the Standard Reports [Page 331] or your own Report Painter reports or
drilldown reports.

If your system stores line items in Profit Center Accounting, you can call up a line item report and
then access the original documents from these reports using the report/report interface (see
Using the Report/Report Interface [Page 347]).

You can meet many of your reporting requirements using the standard reports. However, if these
are not enough, you can create your own User-Defined Reports [Page 351] quickly and easily
using the drilldown or Report Painter. You can find further information on the features of these
two tool under Drilldown reporting vs Report Painter Reports [Page 329].

You can write your own ABAP/4 programs to access the data. Of course, you must have working
knowledge of ABAP programming in order to do this.

The summary record display function gives you direct access and control of the data stored in the
summary records. You can find further information on this subject under Display Summary
Records [Page 344].

You can carry out a more detailed analysis of the postings to Profit Center Accounting, for both
actual and plan line items, using line item reports. For this purpose, however, line items must be
updated in Profit Center Accounting, as they serve as the basis for line item reports. From the
actual line items, you can also access the original FI, SD, MM or CO document. You can find
further information on this subject under Line Item Reports [Page 336].
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The master data index provides you with an overview of the master data in Profit Center
Accounting. You can find further information on this subject under Master Data [Page 21].
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Drilldown Reporting vs Report Painter Reports
Drilldown Reporting
Drilldown reporting is useful for flexible online analysis of profit center report data.

You can either create a report ad hoc or using a form. In a form, you use a graphical report
structure as the basis for your report. The system displays the rows and columns exactly as they
will appear in the finished report. From a technical viewpoint, the same tool is used for this
purpose as for the definition of Report Painter reports (see below).

In a drilldown report, you can navigate freely within a data cube. This means that you can change
the drilldown characteristics and set individual values for characteristics.

You can find detailed information on how to use this tool in the corresponding documentation in
CA - Cross-Application Components under CA - General Drilldown Reporting Book [Ext.].

For specific information on Profit Center Accounting, see

Standard Drilldown Reports in Profit Center Accounting [Page 332] and

User-defined Reports with Drilldown Reporting [Page 352].

Drilldown reporting is also used in other components, such as CO-PA and PS.

It is possible to use the PC application inSight to present drilldown reports. For
further information, see Link to inSight for SAP R/3 [Ext.].

Report Painter
The Report Painter allows you to create your own reports to meet your specific requirements.

The report is defined on the screen using a graphical report structure. The report can therefore
be divided into column blocks and sections. At the definition stage, you can view the report as it
will appear on the screen when finished.

The Report Painter affords you more flexibility and comfort when creating reports, especially with
more complex data material. In contrast to drilldown reporting, however, it offers limited
possibilities of navigation. This means that you are only able to expand and collapse the
hierarchy in the key column. Only predefined breakdowns are printed, according to one or more
characteristics (e.g. profit center and account).

You can find detailed information on how to use this tool in the corresponding documentation in
the component FI - Special Ledger, under Report Painter Reports [Ext.].

For specific information on Profit Center Accounting, see

Standard Report Painter Reports in Profit Center Accounting [Page 334] and

User-defined Reports with the Report Painter [Page 355].

The technical basis of Report Painter reports is the Report Writer. You can find detailed
information on how to use this tool in the corresponding documentation in the component FI -
Special Ledger, under Report Writer [Ext.].

The Report Painter is also used in other components, such as CO-OM.
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Standard Reports
Definition
Preset reports which are provided in the standard system as examples/templates for the creation
of individual reports.

Use
The standard reports are contained in the standard report tree. They provide you with a basic
information system that you can adapt to meet your own requirements.

The standard reports are delivered with the R/3 System in client 000. To make them available in
other clients, you must import them to these clients and then generate them there. This
procedure is described in detail in Profit Center Accounting Customizing. For drilldown reports,
see Import Drilldown Reports [Ext.]; for Report Painter reports, see Import Report Painter
Reports [Ext.]).

After importing the reports, you should not change the standard reports in the target client.
Instead, you should either use them as templates for your own reports or create a copy of the
standard reports under another name.

After importing a new release or maintenance level, you have to import the standard reports from
client 000 again. Note that when importing the standard reports to your client, you overwrite any
changes you have made to them.

The standard reports were created using the Report Painter and the drilldown reporting tool (for
an explanation of the differences between these tools, see Drilldown Reporting vs Report Painter
Reports [Page 329]). They can therefore serve as examples for creating your own reports with
these tools.

All standard reports use the period accounting method.
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Standard Drilldown Reports in Profit Center Accounting
Use
The standard report tree delivered with the system encompasses a number of drilldown reports.
With the exception of profit center comparisons, you can call up all reports for either a profit
center or a profit center group.

Features
The following reports are delivered as standard:

Interactive Reporting
8A-PCA001 Plan/actual/variance: profit center

8A-PCA001G Plan/actual/variance: profit center group

8A-PCA002 Plan/actual comparison: profit center

8A-PCA002G Plan/actual comparison: profit center group

8A-PCA004 Plan/plan/actual version comparison: profit center

8A-PCA004G Plan/plan/actual version comparison: profit center group

8A-PCA005 Current period, year to date, complete year: profit center

8A-PCA005G Current period, year to date, complete year: profit center group

8A-PCA006 Current period, year to date, complete year: profit center comparison

8A-PCA008 Actual quarterly comparison over 2 years: profit center

8A-PCA008G Actual quarterly comparison over 2 years: profit center group

8A-PCA013 Balance sheet accounts plan/actual: profit center

8A-PCA013G Balance sheet accounts plan/actual: profit center group

Interactive Reporting →→→→ Key figures
8A-PCA010 Key figures: profit center

8A-PCA010G Key figures: profit center group

8A-PCA011 Return on investment: profit center comparison

Special Functions →→→→ Decentralized ALE-Scenario
8C-PCA001 ALE plan/actual/variance: profit center

8C-PCA001G ALE plan/actual/variance: profit center group
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Any changes you make to the reports, report groups, standard layouts, sets or
variables that were delivered with the system represent a customer modification
for which SAP bears no responsibility.

Detailed online documentation is available for each of the individual standard report
groups. This documentation contains information about entry parameters, output
parameters and control parameters.

To display this information, choose Information system → Tools → Drilldown
Reporting → Display Report in the application menu for Profit Center Accounting.
Here, enter the technical name of the report you require - using possible entries (F4)
if necessary - and choose .

Activities
When you upgrade your system, these reports are only imported to delivery client 000 and must
then be transported to the other clients, and generated there, using the corresponding functions.
This procedure is described in the Implementation Guide (IMG) for Profit Center Accounting,
under Importing Reports
[Ext.]/SAPIrExtHelp/IWB_IMG.asp?_LOIO=35A7B50D9AF50D14E10000009B38F9B9 [Ext.].

For information on creating your own reports, see User-defined Reports [Page 351].
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Standard Report Painter Reports in Profit Center
Accounting
Use
The standard report tree delivered with the system encompass a number of Report Painter
reports. These are provided in so-called report groups. A report group usually consists of two
reports of one type (such as plan/actual comparison). One report displays the data with
elimination of intercompany sales (IOC) between profit centers, the other without. When you
display these reports, you can switch between the two versions.

Features
The following reports are delivered with the standard system:

List-oriented reports
8A22 Profit center 2 plan versions

8A26 Profit-center-group: plan/actual comparison

8A2A Profit center list: plan/actual

8A2C Profit-center-group: actual quarterly comparison

8A2F Profit-center-group: plan/actual quarterly comparison (origin)

8A80 Statistical key figures

Line items
Open items
8A98 Profit center: receivables

8A99 Profit center: payables

Periodically transferred balance sheet items
8A90 Line items: periodic transfer of customers

8A91 Line items: periodic transfer of suppliers

8A92 Line items: periodic transfer of assets

8A93 Line items: periodic transfer of materials

Special functions
Average balance ledger
8A50 Average balance ledger: YTD / accounts

8A51 Average balance ledger :YTD / profit centers

8A52 Average balance ledger: period/ accounts

8A53 Average balance ledger :period / profit centers
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Data transfer to EIS
8AE1 Profit center-actual data: transfer to an EIS

8AE2 Profit center-plan data: transfer to an EIS

 
Any changes you make to the reports, report groups, standard layouts, sets or
variables that were delivered with the system represent a customer modification
for which SAP bears no responsibility.

 
Detailed online documentation is available for each of the individual standard report
groups. This documentation contains information about user entries, display or print
options and control parameters.

To call up this documentation, choose  on the selection screen for Report Painter
reports.

Activities
When you upgrade your system, the standard reports are only imported to client 000. You need
to transport them into the other clients and then generate them there. For a detailed description
of how to do this, see Customizing, Import Reports [Ext.].

For more information about creating your own reports, see the section User-Defined Reports
[Page 351].
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Line Item Reports
Actual Line Items
The line item report lets you select individual postings according to various selection criteria
(profit center, revenue/cost element, posting date). It is only available if your system stores actual
line items for the relevant controlling area and fiscal year. The line items are stored in table
GLPCA.

The line item report also functions as a list of actual costs because it displays posting documents.
To do this, all the selected line items are shown in list form. You can decide how much detail you
require in the report as you can analyze the line items with varying degrees of detail.

Plan Line Items
It is possible to display plan line items in Profit Center Accounting, provided that your system
stores plan line items for the desired controlling area and fiscal year (defined in Customizing). If
this is the case, the plan line items are stored in table GLPCP.

Activities
When you call up a line item report, you have two options (see the graphic below).

•  The first option is to call up the report directly in the application menu for Profit Center
Accounting, under Information system → Reports for Profit Center Accounting → Line item
reports.

You can then limit the selection of line items on the initial screen. The report is displayed
and can be analyzed further.

•  The second way to call up a line item report is to use the report/report interface in the Report
Writer or Report Painter. To do so, select a section of the report list displayed on the screen,
and then call up the line item function. This is only possible if the line item report was defined
as a receiver report (see Using the Report/Report Interface [Page 347] ). The system passes
the parameters of the sender report on as selection criteria for the line item report.

The system then displays all line items which correspond to the selection. The system
carries out further analysis of the report just as with the direct report call-up. All the
standard reports are defined to allow you to call up an actual line item report.

Screen sequence for line item reports
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Report Writer Report
Report Painter Report

Selection screen

Controlling area
Company code
Posting period
Fiscal year
Revenue/cost element
Profit center
Document number
Activity
...

Basic list

With a choice of information
from the selected line items

Profit center
document display

Full document

Original document display

FI, CO, SD or MM document
with extra detail screen
-  Document header
- Control data

FI/CO document display

Accounting document
Profit center document
Special ledger
Asset transaction
Controlling document etc.

For further information about line item reports, see:

Executing a Line Item Report [Page 338]

Executing a Plan Line Item Report [Page 340]

Functions in Line Item Reports [Page 342]
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Executing an Actual Line Item Report
This section tells you how to call up an actual line item report directly.

1. Choose Information system → Profit Center Accounting reports → Line item reports → Profit
center actual line items.

2. On the initial screen, enter your selection criteria. The most important parameters here are:

• G/L record type (0 = actual, 2 = actual assessment/distribution within Profit Center
Accounting). Note that plan line items are stored in a separate file.

• Version (usually version 000 for actual data)

• Controlling area or company code

• Posting period and fiscal year

• Account (revenue/cost element)

• Profit center and partner profit center

• Document number or reference document number

3. Specify a display variant.

1SAP Standard display with reference document number
The system displays the document number of the original document transferred
to Profit Center Accounting.

2SAP Standard display with profit center document number
The system displays the document number issued in Profit Center Accounting.

To read about how to create user-specific or standard display variants, see Functions in
Line Item Reporting [Page 342].

4. Execute the program.

Basic list
All records which you selected directly on the initial screen or in the Report Writer report are
displayed in the basic list.

At the top of the list, the system displays the selection criteria for your information. This is
followed by a list of the line items. The columns show the document type, document number,
document item, account, profit center and partner profit center along with the value in the profit
center report currency for your controlling area. Some additional information may also be
displayed depending on the selection parameters.

The document type tells you what application the data came from:

Document type Application

A document number from EC-PCA

B documents from FI up through Release 2.2

K documents from Controlling
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W documents received via the FI/CO interface (FI, SD and MM)

The document number is either the number assigned internally in Profit Center Accounting or the
number copied from the original document (reference document number), depending on which
you chose to see on the selection screen. The default here is the reference document number.

For billing documents, only the profit center document number can be displayed.

From this list which serves as a basis of information for the user, you can display the entire
EC-PCA line item document, the original document or the corresponding FI/CO document. These
functions as well as the various settings for the line item report are described in Functions in Line
Item Reporting [Page 342].

For information on plan line item reporting, see Executing a Plan Line Item Report [Page 340].
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Executing a Plan Line Item Report
This section tells you how to call up a plan line item report directly.

1. Choose Information system → Profit Center Accounting reports → Line item reports → Profit
center: plan line items.

2. On the initial screen, enter the desired selection criteria. The most important parameters are:

• G/L record type (1 = plan, 3 = plan assessment/distribution in Profit Center Accounting)

• plan version

• company code or controlling area

• reporting period

• fiscal year

• profit center or partner profit center

3. Specify a display variant.

1SAP Standard display with reference document number
The system displays the document number of the original document transferred
to Profit Center Accounting.

2SAP Standard display with profit center document number
The system displays the document number issued in Profit Center Accounting.

To read about how to create user-specific or standard display variants, see Functions in
Line Item Reporting [Page 342].

4. Execute the program.

The system displays the basic list.

Basic list
The basic list contains all the data records that met the selection criteria entered on the initial
screen or passed on from the Report Writer or Report Painter.

At the top of the list, the system displays the selection criteria for your information. This is
followed by a list of the selected plan line items. The columns show the document type,
document number, document item, account, profit center and partner profit center along with the
value in the profit center report currency for your controlling area. Some additional information
may also be displayed depending on the selection parameters.

In contrast to the actual line items, plan line items encompass values for more than one period.
The basic list shows the total for all the selected periods in each document line. To break this
total down by periods, choose Extras → Period breakdown.

The document number is either the number assigned internally in Profit Center Accounting or the
number copied from the original document (reference document number), depending on which
you chose to see on the selection screen. The default here is the reference document number.

From this list which serves as a basis of information for the user, you can display the original
document or the period breakdown. These functions as well as the various settings for the line
item report are described in Functions in Line Item Reporting [Page 342].



 SAP AG Profit Center Accounting (EC-PCA)

Executing a Plan Line Item Report

April 2001 341



Profit Center Accounting (EC-PCA)  SAP AG

Functions in Line Item Reports

342 April 2001

Functions in Line Item Reports
For information on how to display line items, see the SAP Library, under Getting Started with R/3
→ The R/3 Window → List → ABAP List Viewer (ALV) Grid Control [Ext.].

In addition, you can use the following functions to display profit center line items:

•  Technical display of the profit center document (actual line items only)

To display the entire actual line item, position the cursor on the desired row and choose
Extras → Detail display. The system displays the entire document with all items. This
display includes additional information such as the user who created the document and
the date it was created, which are not available in the normal line item list due to lack of
importance.

•  Period breakdown (plan line items only)

The basic list shows the total for all the selected periods in each document line. To break
this total down by periods, choose Extras → Period breakdown.

•  Original document display

To display the original document in the application that sent the data to Profit Center
Accounting, choose Extras → Original document or double-click on the desired
document line. For example, if a document line originated with a primary posting to a
cost center in Financial Accounting (FI), the system displays the FI document. (See also
“Display FI/CO document”).

•  Display FI/CO document (actual line items only)

When you choose the function Extras → FI/CO document, the system displays a dialog
box containing all the documents in accounting that were created in connection with the
corresponding profit center document. In the example above (primary posting to a cost
center in FI), these would be the FI document, the CO document, the profit center
document and possibly other documents (such as FI-SL).

This function is not available for documents from Controlling (document type K).

•  Display master records

With this function you can display certain characteristics of the document line. To do so,
position the cursor on the desired characteristic and choose Extras → Master data. At
this time you can display the master data for the following objects:

− Profit centers

− Partner profit centers

− Accounts (FI accounts and CO cost elements)

− Cost centers

− CO orders

− WBS elements

− Assets
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− Materials
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Displaying Totals Records
Use
The totals record display is primarily used to check the values that appear in other reports. The
system displays the records as they are stored in the database.

All the data reflected in Profit Center Accounting is stored in the totals record table GLPCT. This
table contains data which is summarized according to certain characteristics and forms the basis
for all reports defined with the Report Writer or the Report Painter (regardless of whether or not
you choose to store line items). The individual postings are summarized according to the
following characteristics:

•  record type (0=actual, 1=plan, 2=actual assessment/distribution, 3=plan
assessment/distribution)

•  Version

•  Posting period and fiscal year

•  controlling area and company code

•  revenue/cost element or account

•  profit center

•  partner profit center

•  debits/credits

•  function area

•  origin object

Activities
With the function Information system → Reports for Profit Center Accounting → Special functions
→ Profit center: Totals records, you can display selected totals records. On the overview of the
selected totals records, the following functions are available:

Additional Processing Functions - Display Totals Records: Overview Ledger 8A Screen

Select Function

Edit →→→→ Choose Display the document for the current period.

Edit →→→→ Sequence... Select new criteria for displaying documents and to create a user
table.

Edit →→→→ Select block Select a block of documents, for example, to suppress the
documents.

Edit →→→→ Suppress block Suppress a block of selected documents.

Edit →→→→ Display block Display a block of suppressed documents.

Extras →→→→ Field left Move the screen one characteristic to the left.

Extras →→→→ Field right Move the screen one characteristic to the right.
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Extras    →→→→ Page left Move the screen one full page to the left.

Extras → → → → Page right Move the screen one full page to the right.

Displaying periods
From this overview, you can display an individual totals record broken down by periods. To do
so, double-click on the desired line, or position the cursor there and choose Edit → Choose. On
the period screen, the following functions are available:

Additional Processing Functions - Display Totals Records: Periods Current Ledger 8A
Screen

Select Function

Edit →→→→ Choose Display the document lines for the period.

Goto →→→→ Display quantities Display quantities for a period.

Goto    →→→→ Accumulated amount Display the accumulated amount for a period.

Goto →→→→ Disp. previous record Display period information for the previous totals record.

Goto →→→→ Display next record Display period information for the next totals record.

Displaying line items
From the period screen, you can display the line items for a single period by double-clicking or by
positioning the cursor and choosing Edit → Choose.
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Profit Center Master Data Index
Use
The Master data index provides you with an overview of all the existing profit centers in your
system. You can use the name of a profit center or profit center group, the person in charge or a
certain validity date as selection parameters.

Activities
When you have specified the selection parameters a list with the relevant profit centers is
displayed. From there you can go to profit center master data maintenance by double-clicking on
a line.

A further function enables you to create a profit center group from the profit centers displayed. To
do this, select the desired profit centers and choose Create group. You can use these groups in
reporting or for allocations.
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Using the Report/Report Interface
Use
The report/report interface lets you execute other report groups, ABAP/4 programs, report
portfolio reports, drilldown reports and transactions from a displayed report list.

For details about how to use the report/report interface in user-defined reports, see

•  for drilldown reports, the R/3 Library for the component General Drilldown Reporting Book,
under Overview: Report/Report Interface [Ext.].

•  for Report Painter reports, the R/3 Library for the component FI Special Ledger, under
Define Reports for the Report/Report Interface [Ext.].

Report Writer and Report Painter reports, see the section Using the Report/Report Interface
under Report Writer Reports in the documentation Report Writer.

Features
Once you have selected an individual cell, a line, a column or a block, you can branch directly to
another Profit Center Accounting standard report, by choosing Goto → Call up report. The values
you select determine the selection criteria with which you call up the other report.

In Profit Center Accounting standard reports, this is done for:

•  the report group 8A2F (Profit-center-group: plan/actual quarterly comparison (origin))

•  for the drilldown reports if they contain the origin object type

Profit Center Accounting Reporting allows you to access Cost Center Accounting when searching
for the cause of certain profit dimensions. For an example, see Example: Branching to Cost
Center Reports [Page 349].

Note that, when branching from the profit center reports, the selected values will only
be passed on automatically as selection criteria if you call up a different profit center
report or a cost center report. Otherwise, you branch to the selection screen of the
report you called up instead.

You can branch from line item Reporting [Page 336] to the original posting documents via the
individual documents.

Direct access to the corresponding FI documents is made in the line item reports FI Doc.
Breakdown by payb./recv (see Standard Reports [Page 331]).

Activities
To use the report/report interface function, you must determine which receiver reports can be
called from by the sender report. You do this by maintaining the libraries or report groups you are
using.

•  For assignments to Report Painter reports, choose Tools → Report Painter → Report
Writer → Library or report group → Change → Goto → Header.
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•  For assignments to drilldown reports, choose Tools → Drilldown Reporting → Change
report. Choose a sub-object to change. In the next screen, choose Extras → Report
assignment.

If you choose report/report interface, the system calls up a dialog box, in which you can specify
the receiver reports you require.

The following applies for Report Painter reports:

If you define reports for the report/report interface both in the report group and in the
report group library, the system uses the reports which you defined specially for the
report group.
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Example: Branching to Cost Center Reports
The following example shows how the report/report interface is used.

Pay special attention to the final step shown here. The origin object cost center can be broken
down further by going to the original cost center report. The system can provide data for all
cost centers belonging to a profit center. You can only branch to reporting for cost centers.

Report 8A2A Profit Center List

*

**

Total results for profit centers

Profit center

PrCtr 1

PrCtr 2

PrCtr 3

PrCtr 4

PrCtr group A

* PrCtr group B*

PrCtrs total

Plan Actual Abs. var. % var.

. . .

. . .

. . .

. . .

. . .

. . .

. . .

- 100,000

- 200,000

- 300,000

- 400,000

- 500,000

- 900,000

- 1,200,000 . . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

Starting from the total results for a profit center group, you can drill down to a detailed display of
period results for the selected profit center group, broken down by revenue and cost elements.

8A26 Profit Center Group: Plan/Actual Comparison

*

*
**

Profitability report: Profit center group A

Revenue and 
cost elements Plan Actual Abs. var. % var.

800000

801000

Revenues

400000
430000
Cost
Result . . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .-1,000,000

-500,000

-1,500,000

800,000
4000,000
1,200,000
-300,000

You can then analyze the origins for the selected revenue/cost elements.

8A2F Profit Center Group: Plan/Actual Comparison (Origin)
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*

Breakdown according to origins

Revenue/ cost elements
by object of origin

Cost centers

Orders

Projects

400000 . . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .

. . .500,000.00

150,000.00

150,000.00

800,000.00

Plan Actual Abs. var. % var.

Finally, you can branch to the original information system for cost centers for selected report
lines:

1SIP Cost Centers: Plan/Actual Comparison

*

Original report: Cost center for account 400000

Cost ctr/account
C 100

C 500

C 400

C 300

C 200

400000

100,000

200,000

50,000

70,000

80,000

500,000

. . . 

. . . 

. . . 

. . . . . . 

. . . 

. . . 

Plan Actual Abs. var. % var.
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User-Defined Reports
Purpose
The small number of standard reports cannot, of course, cover all your reporting needs in Profit
Center Accounting. They are intended to be a base which you can build upon to create a
complete set of reports using the Report Writer, the Report Painter, and Drilldown Reporting.

Features
The tools for defining reports in Profit Center Accounting are the Report Painter and Drildown
Reporting (for the difference between these two tools, see Drilldown Reporting vs Report Painter
Reports [Page 329]).

For more information, see

Defining your own Reports with the Report Painter [Page 355].

Defining your own Reports with Drilldown Reporting [Page 352].
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Defining your own Reports with Drilldown Reporting
Use
You can now define and analyze reports on profit center data using the drilldown reporting tool in
addition to the Report Writer and Report Painter.

Drilldown reporting allows you to analyze your data according to different characteristics and key
figures.

As with the Report Painter, drilldown reporting is based on the concepts "characteristic" and "key
figure":

•  Characteristics are nonnumeric fields that represent criteria according to which you can
select data records. Examples of characteristics are "Controlling area", "Fiscal year" and
"Profit center". Characteristic values are the instances of these characteristics, such as fiscal
year 1998, 1997, and so on.

•  Key figures are numerical fields that you can analyze in your reports. Examples of key figures
are costs and revenues, balance sheet balances in a certain currency or activity quantities.

Features
General
Drilldown Reporting is described in detail in the General Drilldown Reporting Book [Ext.] (see
component CA - cross-application components).

Drilldown Reporting in Profit Center Reporting
Ledgers
To be able to report on profit center data, you need to specify the ledger from which you want the
system to select the data. You can specify this either in the form or in the report definition. The
ledger for Profit Center Accounting is 8A.

If you are working with the ALE distribution method "Decentralized Profit Center Accounting" in
your installation, use ledger 8C for your reports in the central system.

Controlling Areas

You can use the standard variable 8AKOKRS in your forms and reports so that your users do not
have to enter a controlling manually each time. For this to work, you also need to define a value
for user parameter CAC for each user.

Key Figures
The system handles different key figures differently when it comes to calculating totals in reports.
For example, costs are added together (aggregation "SUM"), whereas the system displays the
last value (aggregation "LAST") for noncumulative values and the average ("AVG") for statistical
key figures (such as "Number of employees"). You can use the following key figures in your
reports:

Key Figure Aggregation
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Costs/revenues in profit center report currency SUM

Costs/revenues in local currency SUM

Costs/revenues in transaction currency SUM

Costs/revenues, quantity SUM

Balance sheet account in profit center report currency LAST

Balance sheet account in local currency LAST

Balance sheet account in transaction currency LAST

Quantity for balance sheet account LAST

Statistical key figure, quantity (agg. value) SUM

Statistical key figure, quantity (fixed value) AVG

The key figures balances in profit center report currency, and balance in local currency (that is, in
the company code currency) provide the current balance for the period. The profit center report
currency is recommended for reporting.

Characteristics
You must specify values for the profit center and the ledger when you execute a report if these
were defined with a variable in the form or report definition.

In the form, you can determine groups (= hierarchy nodes) for the characteristics profit center
and account, or enter the following special group variables:

•  Balance sheet account group: 8ABSITEMS

•  8APLACCT

•  Profit center group: 8APCGRP

When using group variables in the form, you can select the hierarchy representation group from
form while defining the form. This means that the group entered on the selection screen will also
be used for the hierarchical representation in the drilldown list.

Line Items
You can call up a line item report from within a drilldown report. The data in the drilldown report
serve as selection criteria for the line item report.

Elimination of Internal Revenue
You can define drilldown reports with elimination of internal revenue using a user exit. For further
information, see User Exit: Elimination of Internal Revenue [Ext.].

Link to inSight

The PC application inSight can be used for presenting drilldown reports. For further information,
see Link to inSight for SAP R/3 [Ext.].
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Defining your own Reports with the Report Painter
Use
You should be able to meet most of your reporting requirements using the standard reports in
your R/3 application components. However, if these reports do not entirely meet your needs, you
can define your own reports quickly and easily using the Report Painter.

With the Report Painter, you can define reports which allow you to present complex data
analyses in a structure. To do so, you set various characteristics and key figures when defining
the report.

•  Characteristics are non-numeric fields. They represent the criteria according to which you
can select data records. Examples of characteristics are "Controlling area", "Fiscal year" and
"Profit center". Characteristic values are the instances of these characteristics, such as fiscal
year 1998, 1997, and so on.

•  Key figures are numerical fields that you can analyze in your reports. Examples of key figures
are costs and revenues or balance sheet balances in a certain currency or activity quantities.

The technical basis of Report Painter reports is the Report Writer. You can find detailed
information on how to use this tool in the corresponding documentation in the component FI -
Special Ledger, under Report Writer [Ext.].

Features
General Information
For a detailed description of the Report Painter, see Report Painter Reports [Ext.] (FI - Special
Ledger).

Specific Information for Profit Center Accounting
The reporting table for Profit Center Accounting is GLPCT. The following database tables are
hidden behind this logical reporting table:

•  GLPCT (profit center summary records)

•  GLPCA (profit center actual line items)

•  GLPCP (profit center plan line items)

The characteristics and key figures used in the report influence which database table the report
reads from when you run it.

In order to avoid impairing system performance, we urgently recommend that you
only use characteristics from summary records in reports. Use the standard 8A2
Library as a guide.

Reporting table GLPCOP is used for evaluating payables and receivables.

The system provides a large number of key figures and characteristics, which you can choose for
your report definition. The following is a list of all key figures, which can be found in the various
tables. Characteristics are only commented on if there is a special feature, or something similar,
of which you should be aware.
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Database table GLPCT:

Key Figures:

KSL Amount in profit center report currency Should be used in most cases, as this is the
usual currency.

HSL Amount in company code currency Note that the company codes which you
want to report on must have the same
currency. Otherwise, they cannot be
aggregated.

TSL Amount in transaction currency

MSL Quantity This key figure is to be used together with
the characteristic account number.

SSME Statistical key figure quantity This key figure is to be used together with
the characteristic statistical key figure.

The following key figures cause the fields currency, exchange rate type and date to be ready for
input on the selection screen when translating currencies:

CC_KSL Translation from profit center report
currency

Data in profit center currency serves
as the basis for the translation.

CC_HSL Translation from company code
currency

Data in company code currency serves
as the basis for the translation.

CC_TSL Translation from transaction currency Data in transaction currency serves as
the basis for the translation.

If you use average balance ledgers, you can use the following special key figures for evaluation
purposes:

HMB Average balance in company code currency

HYB Aggregated average balance in company code currency (YTD)

KMB Average balance in group currency

KYB Aggregated average balance in group currency (YTD)

TMB Average balance in transaction currency

TYB Average balance in transaction currency (YTD)

Characteristics:
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Ledgers The ledger for Profit Center Accounting is 8A.

Exception: In the decentralized ALE scenario for Profit Center Accounting
for Reporting in the central system, the ledger is 8C.

Plan version For actual columns, enter version 0, for plan columns, enter a plan
version.

Record type 0 and 2 for actual

1 and 3 for plan

Period If you want to select retained earnings accounts from a given period,
enter this period as normal.

If you want to select balance sheet accounts from a given period, enter
the period 0 to n, as the individual periods contain the changes in stock
for each period. Period 0 stands for the opening balance.

Statistical key figure Use this characteristic in combination with the key figure SSME
(statistical key figure quantity) and do not define the characteristic
account number in the same area of validity.

Characteristics such as cost center, order, WBS element or material are not
contained in the summary records. Reports which contain these characteristics
obtain their data from the line item tables. This can impair system performance and
should be avoided.

Database table GLPCA

Key Figures
Accessing line item tables with the Report Painter has a negative effect on performance.
However, if you need to create reports for the actual line item table GLPCA, you must use the
following key figures:

•  BKSL-I Actual profit center report currency document:

•  BHSL-I Actual company code currency document

•  BTSL-I Actual transaction currency document

•  BMSL-I Actual quantity document

Characteristics
Due to the structure of the database table, you should not use the characteristic period (RPMAX).
Instead, you should use the characteristic posting period (POPER).
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Database table GLPCP

Key Figures
Accessing line item tables with the Report Painter has a negative effect on performance.
However, if you need to create reports for the plan line item table GLPCP, you must use the
following key figures:

•  BKSL-P Plan profit center report currency document:

•  BHSL-P Plan company code currency document

•  BTSL-P Plan transaction currency document

•  BMSL-P Plan quantity document

Characteristics

To access the plan line item table GLPCP, use the characteristic period (RPMAX) as you would
when accessing the summary record table GLPCT .

Reporting table GLPCOP:

Key Figures

It is possible to access reporting table GLPCOP with the following characteristics:

•  MBTR-AR Receivables in company code currency

•  MBTR-AP Payables in company code currency

•  MBTR-AR-B Receivables for valuation differences

•  MBTR-AP-B Payables for valuation differences
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Calculating Profits Using the Cost-of-Sales Approach
Use
The Financial Accounting application in the R/3 System lets you represent profits according to
the period accounting approach as well as the cost-of-sales approach. Both of these approaches
are supported in Profit Center Accounting as well in order to ensure that all the data can be
reconciled between the components (see also Methods of Calculating Profits in EC-PCA [Page
15]).

The standard profitability reports in Profit Center Accounting are based on the period accounting
approach, whereby the system breaks down the operating results by revenue and cost element.

To calculate profits according to the cost-of-sales approach, you need to access the
characteristic functional area [Ext.], which is derived in FI or CO. Since you can define your own
functional areas as well as the methods for determining them (substitution), you need to use your
own reports to display results using the cost-of-sales approach.

Integration
It is possible to derive the functional area from the information already available in the document
using substitution [Ext.]. You can also the relevant master data in addition to the information
found in the document. For example, the functional area Administration can be found using the
cost center itself as well as the cost center type assigned to the cost center. Alternatively, you
can enter the functional area manually.

For more information, see the R/3 Library for FI Special Ledger, under � HYPERLINK
"/SAPIrExtHelp/IWB_EXTHLP.asp?_LOIO=2706E23954D9035DE10000000A114084" � [Ext.].

Prerequisites
You can only use the cost-of-sales approach in Profit Center Accounting if it is also active in
Financial Accounting.

The required activities are described in the Implementation Guide (IMG) for Financial Accounting,
under Activate Substitution [Ext.] .

Features
The functional area can be derived automatically for all costs posted in FI and CO based on the
existing posting assignments. It is then stored in the posted documents. It is passed on to Profit
Center Accounting for both plan and actual data.

Activities
The graphic below shows how a report is built in the cost-of-sales approach.
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.
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2
3
3
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1. The revenues and the costs of sales are listed in the report rows by account.

2. Variances in production orders are assigned via the accounts to which the data was posted.
You can assign all debits and credits to the production cost centers using a separate function
area, for example Production, for the variances in the production cost centers. The
difference which arises gives you the desired variances.

3. The rest of the overhead for the period is entered in the corresponding report rows by
function area.

4. The report rows for data from non-operating results are found using the corresponding
accounts.
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Tools

This section contains functions that you perform at certain intervals when you are productive with
your system. In Profit Center Accounting, these functions are the following:

Validation [Page 362]

Substitutions [Page 363]

Archiving [Page 364]

Distribution (ALE) [Page 365]
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Validation
Use
You can use user-defined validations in Financial Accounting or Controlling to represent
company-specific consistency checks which apply for postings to Profit Center Accounting. In FI
or CO, you need to define a validation rule by specifying a time for the validation to take place
and a so-called “key”. (For details see the online documentation on � HYPERLINK
"/SAPIrExtHelp/IWB_EXTHLP.asp?_LOIO=2706E23954D9035DE10000000A114084" � [Ext.].)

Some profit centers are defined as subdivisions of a business area. As a result, they
can only receive postings together with that business area. In this case you can
define a suitable validation rule for your controlling area. Use the option Primary
data with the key 0001. You could also use validations in Financial Accounting for
the option Document item for balance sheet items.

For information about implementing validations, see Customizing for CO and FI.
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Substitutions
Use
It is sometimes not clear to which profit centers data should be posted based on the individual
characteristics. In this case, you can use substitution rules to assign your data more exactly to
profit centers.

In Profit Center Accounting, substitutions are especially useful for assigning sales orders.
Consequently, you have the option of maintain substitutions for sales orders when you set up
Profit Center Accounting in Customizing (see also Activating Substitutions for Sales Orders
[Page 84]).

Substitutions can also be used for determining the function area if you are using the cost-of-sales
method of calculating profits. For more information, see Calculating Profits Using the Cost of
Sales Approach [Page 359].

In exceptional cases you can use additional substitution rules in Financial Accounting or
Controlling to determine profit centers or partner profit centers. For more information, see the
documentation on � HYPERLINK
"/SAPIrExtHelp/IWB_EXTHLP.asp?_LOIO=2706E23954D9035DE10000000A114084" � [Ext.].

For more about implementing substitutions, see CO and FI Customizing.
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Archiving

Use
You can reorganize the transaction data in Profit Center Accounting using an archiving program.

Features
Archiving gives you the following functions:

•  Archive transaction data

•  Delete transaction data

•  Reload transaction data from the archive

•  Archiving management

•  Analysis programs

You can archive summary records and line items separately.

Activities
The archiving functions are found in the application menu under Environment → Archiving.You
must have proper authorization for the functions.

The above functions are described in detail in Archiving EC-PCA Totals Records and Line Items
[Ext.].

You can find information about the various archiving objects [Ext.] by calling up the hints. To view
the hints, click  on the relevant screen.
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Distribution (ALE)
Purpose
The ALE (Application Link Enabling) functions make it possible to link multiple R/3 systems
together. You can enter and maintain transaction data for Profit Center Accounting in each
system separately, and then transfer the data to a central R/3 System on a periodic basis.

Application Link Enabling is explained in detail in the documentation ALE in Profit Center
Accounting [Ext.]. There you will also find a chapter dealing specifically with Profit Center
Accounting. To learn how to set up distribution using ALE, see Customizing for Profit Center
Accounting, under Set Distribution of Profit Center Data [Ext.]


